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The LabVIEW Function and VI Reference Manual contains descriptions
of all virtual instruments (VIs) available for LabVIEW, including the
following:

e G functions and VIs
e VIs that support the devices for data acquisition
e VIs for GPIB, VXIbus, and serial port I/O operation

» digital signal processing, filtering, and numerical and
statistical VIs

e networking and interapplication communications VIs

This manual is a supplement to the LabVIEW User Manual and assumes
that you are familiar with that material. You should also know how to
operate LabVIEW, and your computer and operating system.

This manual provides an overview of each function and VI available in
LabVIEW. However, for more specific information regarding each
function and VI (e.g. for specific parameter information), refer to the
LabVIEW Online Reference, which you can access by selecting
Online Reference from the LabVIEW Help menu, or Help, which you
access by selecting Show Help from the LabVIEW Help menu.

Organization of the Product User Manual

This manual covers five subject areas G Functions, Data Acquisition
VIs, Instrument I/O VIs, Analysis VIs, and Communications VIs.
Chapter 1 introduces the LabVIEW Functions and VIs, which comprise
the sections in this manual.

e Section 1, G Functions and VIs, includes Chapters 2 through 12,
which describe the functions unique to the G programming
language.

e Section 2, Data Acquisition VIs, includes Chapters 13 through 29,
which describe the Data Acquisition (DAQ) VlIs.
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e Section 3, Instrument I/O Functions and VIs, includes Chapters 30
through 37, which describe the Instrument I/O VIs and functions.

*  Section 4, Analysis VIs, includes Chapters 38 through 48, which
describe the Analysis VlIs.

e Section 5, Communications VI and Functions, includes Chapters 49
through 55, which describe the Communication VIs.

In addition, this manual includes the following appendices and index:

* Appendix A, DAQ Hardware Capabilities, includes tables that
summarize the analog and digital I/O capabilities of National
Instruments data acquisition devices.

* Appendix B, Multiline Interface Messages, lists commands that
IEEE 488 defines.

* Appendix C, Operation of the GPIB, describes basic concepts you
need to understand to operate the GPIB.

* Appendix D, References, lists the reference material used to
produce the Analysis VIs described in this manual.

* Appendix E, Customer Communication, contains forms to help you
gather the information necessary to help us solve your technical
problems and a form you can use to comment on the product
documentation.

*  The Index contains an alphabetical list of VIs described in this
manual, including the page where you can find each one.

Conventions Used in This Manual

<>

[]

»

The following conventions are used in this manual:

Angle brackets enclose the name of a key on the keyboard (for example,
<option>). Angle brackets containing numbers separated by an ellipsis
represent a range of values associated with a bit or signal name (for
example, DBIO<3...0>).

Square brackets enclose optional items (for example, [response]).

A hyphen between two or more key names enclosed in angle brackets
denotes that you should simultaneously press the named keys—for
example, <Control-Alt-Delete>.

The » symbol leads you through nested menu items and dialog box
options to a final action. The sequence File»Page Setup»Options»
Substitute Fonts directs you to pull down the File menu, select the
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Page Setup item, select Options, and finally select the Substitute Fonts
options from the last dialog box.

The ¢ symbol indicates that the text following it applies only to a
specific product, a specific operating system, or a specific software
version.

Bold text denotes the names of menus, menu items, parameters, dialog
box, dialog box buttons or options, icons, windows, Windows 95 tabs,
or LEDs.

Bold italic text denotes a note, caution, or warning.

Bold text in this font denotes the messages and responses that the
computer automatically prints to the screen. This font also emphasizes
lines of code that are different from the other examples.

Key names are in all capital letters.

Italic text denotes emphasis, a cross reference, or an introduction to a
key concept. This font also denotes text from which you supply the
appropriate word or value, as in Windows 3.x.

Italic text in this font denotes that you must supply the appropriate
words or values in the place of these items.

Text in this font denotes text or characters that should literally enter
from the keyboard, sections of code, programming examples, and
syntax examples. This font is also used for the proper names of disk
drives, paths, directories, programs, subprograms, subroutines, device
names, functions, operations, variables, filenames and extensions, and
for statements and comments taken from programs.

Paths in this manual are denoted using backslashes (\) to separate drive
names, directories, folders, and files.

The Glossary lists abbreviations, acronyms, metric prefixes,
mnemonics, symbols, and terms.

Related Documentation

You might find the following documents helpful as you read this
manual:

e LabVIEW User Manual

e LabVIEW Error Codes

e LabVIEW Getting Started Card
e LabVIEW QuickStart Guide
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e LabVIEW Release Notes
e LabVIEW Upgrade Notes
* G Quick Reference Card

Related Online Documentation

The following related documents are available through the LabVIEW
Online Reference, which you access by selecting
Help»OnlineReference.

e Communications Common Questions

e LabVIEW Glossary

Customer Communication

National Instruments wants to receive your comments on our products
and manuals. We are interested in the applications you develop with our
products, and we want to help if you have problems with them. To make
it easy for you to contact us, this manual contains comment and
configuration forms for you to complete. These forms are in
Appendix E, Customer Communication, at the end of this manual.
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Introduction to the LabVIEW
Functions and Vis

This chapter contains basic information about the functions and virtual
instruments (VIs) that are available with LabVIEW.

LabVIEW includes collections of VIs that work with your G
programming language, data acquisition (DAQ) hardware devices,
instrument input and output devices, analysis instruments, and
communication devices.

Locating the G Functions and Vis

You can find the G functions and VIs on the Functions palette. To
access the Functions palette, access a block diagram in LabVIEW.
When you put your cursor over each of the icons in the Functions
palette, LabVIEW displays the name of the icon palette.

Functions are elementary nodes in the G programming language. They
are analogous to operators or library functions in conventional
languages. Functions are not VIs and therefore do not have front panels
or block diagrams. When compiled, functions generate inline machine
code.

You select functions from the Functions palette, in the block diagram.
When the block diagram window is active, select
Windows»Show Functions Palette. You also can access the
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Functions palette by popping up on the area in the block diagram
window where you want to place the function.

EdFunctions 4|
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Many Function palette chapters include information about function
examples.

The paths for these examples for LabVIEW begin with examples\.

Function and VI Overviews

The following functions and VIs are available.

Structures

G Structures include While Loop, For Loop, Case and Sequence
structures. This palette also contains the global and local variable
nodes.
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Numeric Functions
Numeric functions perform arithmetic operations, conversions,
trigonometric, logarithmic, and complex mathematical functions. This
palette also contains additional numeric constants, such as Pi.

Boolean Functions

Boolean functions perform Boolean and logical operations.

T13

String Functions
String functions manipulate strings and convert numbers to and from
strings. This palette also includes the subpalettes Additional String To
Number Functions and String Conversion Functions.

k

Array Functions

Array functions assemble, disassemble, and process arrays.

=
—
g
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Cluster Functions

Use Cluster functions to assemble, access, and change elements in a
cluster.

]

=]

Comparison Functions

Comparison functions compare data (greater than, less than, and so on)
and operations that are based on a comparison, such as finding the
minimum and maximum ranges for two values.

" 3
'.':E}"?

Time and Dialog Functions
Time and Dialog functions can be used to manipulate time functions
and display dialog boxes. This palette also includes the functions that
perform error handling.

File 1/0 Functions

File I/O functions manipulate files and directories. This palette also
contains the subpalettes Advanced File Functions, Binary File VIs, and

File Constants.
|i

]

Advanced Functions

Advanced functions are functions that do not fit into any other category.
The Code Interface Node is an example of an advanced function. The
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Advanced Functions palette also contains Help Window functions, VI
Control VIs, Data Manipulation functions, and Occurrences functions.

algl
Tolg

1
0
|
1

DAQ VIs acquire and generate real-time analog and digital data as well
as perform counting operations. See Chapter 13, Introduction to the
LabVIEW Data Acquisition Vls, for more information.

Instrument I/O VIs communicate with instruments using GPIB, VISA,
or serial communication. See Chapter 30, Introduction to LabVIEW
Instrument Driver Vs, for more information.

Communication VIs network to other applications using TCP/IP, DDE,
OLE, Apple Events, PPC, or UDP. See Chapter 49, Introduction to
LabVIEW Communication VIs and Functions, for more information.

s

Analysis VIs perform measurement, signal generation, digital signal
processing, filtering, windowing, probability and statistics, curve
fitting, linear algebra, array operations, and VIs which perform
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additional numerical methods. See Chapter 38, Introduction to Analysis
in LabVIEW, for more information.

4

Select A VI...

When you select Functions»Select a VI..., LabVIEW displays a file
dialog box. From there, you can select any VI and place it on a diagram.

Tutorial

Selecting Functions»Tutorial accesses the Tutorial VIs. You call these
VIs while working through the LabVIEW Tutorial Manual.

k

-

Instrument Driver Library

Instrument drivers are a set of VIs for GPIB, VISA, Serial, and CAMAC
instruments. National Instruments, as well as other vendors, distribute
these instrument drivers. Any drivers you place in the instr.1lib
appear in the palette.

Instr Likk
Fidt:

I+
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User Library

This palette automatically includes any VIs in your user.lib
directory, making it more convenient to gain access to commonly used
sub-VIs you have written.

Ik
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G Function and VI
Reference Overview

This chapter introduces the G Functions and VlIs, descriptions of which
comprise Chapter 3 through Chapter 12.

Functions are elementary nodes in the G programming language. They
are analogous to operators or library functions in conventional
languages. Functions are not VIs and therefore do not have front panels
or block diagrams. When compiled, functions generate inline machine
code.

Vs are “virtual instruments,” so called because they model the
appearance functions of a physical instrument.

You select G Functions from the Functions palette, in the block
diagram. When the block diagram window is active, you can display the
Functions palette by selecting Windows»Show Functions Palette.
You also can access the Functions palette by popping up on the area in
the block diagram window where you want to place the function.

E Functions B3|

3 »
Bl
= [EL1[2] ’
El 5 Funations
5 5 and Vs
>
¥ ) lﬂ

Many Functions palette chapters include information about function
examples. The paths for these examples for LabVIEW begin

examples\.
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G Functions Overview

For brief descriptions of each of the 10 G Function and VI palettes
available refer to Chapter 1, Introduction to LabVIEW Functions and VIs.

Introduction to Polymorphism

Polymorphism

The following sections provide some general information about
Polymorphism in G functions.

Polymorphism is the ability of a function to adjust to input data of
different types or representations. Most functions are polymorphic. VIs
are not polymorphic. All functions that take numeric input can accept
any numeric representation (except some functions that do not accept
complex numbers).

Functions are polymorphic to varying degrees; none, some, or all of
their inputs may be polymorphic. Some function inputs accept numbers
or Boolean values. Some accept numbers or strings. Some accept not
only scalar numbers but also arrays of numbers, clusters of numbers,
arrays of clusters of numbers, and so on. Some accept only
one-dimensional arrays although the array elements may be of any type.
Some functions accept all types of data, including complex numbers.

Unit Polymorphism

If you want to create a VI that computes the root, mean square value of
a waveform, you have to define the unit associated with the waveform.
You would need a separate VI for voltage waveforms, current
waveforms, temperature waveforms, and so on. LabVIEW has
polymorphic unit capability so that one VI can perform the same
calculation, regardless of the units received by the inputs.

You create a polymorphic unit by entering $x, where x is a number (for
example, $1). You can think of this as a placeholder for the actual unit.
When LabVIEW calls the VI, the program substitutes the units you pass
in for all occurrences of $x in that VI.

LabVIEW treats a polymorphic unit as a unique unit. You cannot
convert a polymorphic unit to any other unit, and polymorphic units
propagate throughout the diagram, just as other units do. When the unit
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connects to an indicator that also has the abbreviation $1, the units
match and the VI can then compile.

You can use $1 in combinations just like any other unit. For example,
if the input is multiplied by 3 seconds and then wired to an indicator,
the indicator must be $1 s units. If the indicator has different units, the
block diagram shows a bad wire. If you need to use more than one
polymorphic unit, you can use the abbreviations $2, $3, and so on.

A call to a subVI containing polymorphic units computes output units
based on the units received by its inputs. For example, suppose you
create a VI that has two inputs with the polymorphic units $1 and $2
that creates an output in the form $1 $2 / s.If acall to the VI receives
inputs with the unit m/s to the $1 input and kg to the $2 input, LabVIEW
computes the output unit as kg m / s”2.

Suppose a different VI has two inputs of $1 and $1/s, and computes an
output of $1~2. If a call to this VI receives inputs of m/s to the $1 input
andm/s"2 to the $1/s input, LabVIEW computes the output unit as m*2
/ s~2.If this VI receives inputs of m to the $1 input and kg to the $1/s
input, however, LabVIEW declares one of the inputs as a unit conflict
and computes (if possible) the output from the other input.

A polymorphic VI can have a polymorphic subVI because LabVIEW
keeps the respective units distinct.

Numeric Conversion

You can convert any numeric representation to any other numeric
representation. When you wire two or more numeric inputs of different
representations to a function, the function usually returns output in the
larger or wider format. The functions coerce the smaller representations
to the widest representation before execution.

Some functions, such as Divide, Sine, and Cosine, always produce
floating-point output. If you wire integers to their inputs, these
functions convert the integers to double-precision, floating-point
numbers before performing the calculation.

For floating-point, scalar quantities, it is usually best to use
double-precision, floating-point numbers. Single-precision,
floating-point numbers save little memory, little or no time, and
overflow much more easily. You should only use extended-precision,
floating-point numbers when necessary. The performance and precision
of extended-precision arithmetic varies among the platforms.

© National Instruments Corporation 2-3 LabVIEW Function and VI Reference Manual



Chapter 2 G Function and VI Reference Overview

For integers, it is usually best to use a long integer.

If you wire an output to a destination that has a different numeric
representation from the source, LabVIEW converts the data according
to the following rules:

* Signed or unsigned integer to floating-point number—Conversion
is exact, except for long integers to single-precision, floating-point
numbers. In this case, LabVIEW reduces the precision from 32 bits
to 24 bits.

* Floating-point number to signed or unsigned integer—LabVIEW
moves out-of-range values to the integer's minimum or maximum
value. In most integer objects, such as the iteration terminal of a For
Loop, LabVIEW rounds floating-point numbers. LabVIEW rounds
a fractional part of 0.5 to the nearest even integer—for example,
LabVIEW rounds 6.5 to 6 rather than 7.

* Integer to integer—LabVIEW does not move out-of-range values
to the integer’s minimum or maximum value. If the source is
smaller than the destination, LabVIEW extends the sign of a signed
source and places zeros in the extra bits of an unsigned source. If
the source is larger than the destination, LabVIEW copies only the
low order bits of the value.

On the block diagram, LabVIEW places a coercion dot on the border of
a terminal where the conversion takes place to indicate that automatic
numeric conversion occurred, as in the following example.
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Because VIs and functions can have many terminals, a coercion dot can
appear inside an icon if the wire crosses an internal terminal boundary
before it leaves the icon/connector, as the following illustration shows.

Fiih)

?@;@@

e

Moving a wired icon stretches the wire. Coercion dots can cause a VI to
use more memory and time. You should try to keep data types
consistent in your VIs. For more information on coercion dots, see
Chapter 8, Customizing Your LabVIEW Environment, in the LabVIEW
User Manual.

Overflow and Underflow

LabVIEW does not check for overflow or underflow conditions on
integer values. Overflow and underflow for floating-point numbers is in
accordance with IEEE 488 Standard 754 for binary, floating-point
arithmetic.

Floating-point operations propagate not-a-number (NaN) and +/-Inf
faithfully. When you explicitly or implicitly convert NaN or +/-Inf to
an integer or Boolean value, however, you get a value that looks
reasonable, but is meaningless. For example, dividing by zero produces
+/-Inf, but converting that value to a word integer gives the value
32,768, which is the largest value that can be represented in the
destination format.

Wire Styles

The wire style represents the data type for each terminal, as the
following table shows. Polymorphic functions show the wire style for
the most commonly used data type.

Scalar 10 Aray 20 Amay 30 Arap 4D Aray

MHurmber
Boolean e
String sooocooooc  RRARRARARRI  3GBOG888885 RRRARARAR

GEI"IE[EI' Eluster (o=~ N rrrrrrrrs]
Cluster of Mumbers s
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Structures

This chapter describes the Structures available through LabVIEW.
To access the Structures palette, select Functions»Structures. The

following illustration shows the options that are available on the
Structures palette.
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See examples\general\structs.1llb for examples of how
these structures are used in LabVIEW.
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Structures

Structures Overview

The following Structures are available in LabVIEW.

Case Structure

Has one or more subdiagrams, or cases, exactly one of which executes when the structure
executes. Whether or not it executes depends on the value of the Boolean or numeric
scalar you wire to the external side of the terminal or selector.

For more information on how to use the Case structure in LabVIEW, see Chapter 19,
Structures, in the LabVIEW User Manual.

Sequence Structure

Consists of one or more subdiagrams, or frames, that execute sequentially. As an option,
you can add sequence locals that allow you to pass information from one frame to
subsequent frames by popping up on the edge of the structure.

For more information on how to use the Sequence structure in LabVIEW, see Chapter 19,
Structures, in the LabVIEW User Manual.

For Loop

Executes its subdiagram count times, where the count equals the value contained in the
count terminal. As an option, you can add shift registers so you can pass information from
one iteration to the next by popping up on the edge of the structure.

numbser
of times . .
curment Heration

For more information on how to use For Loop in LabVIEW, see Chapter 19, Structures,
in the LabVIEW User Manual.
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While Loop

Executes its subdiagram until a Boolean value you wire to the conditional terminal is
FALSE. As an option, you can add shift registers so you can pass information from one
iteration to the next by popping up on the edge of the structure.

’g%—%&— cument ieration

condition

For more information on how to use While Loop in LabVIEW, see Chapter 19,
Structures, in the LabVIEW User Manual.

Formula Node

Executes mathematical formulas on the block diagram.

input E output

formulase

For more information on the Formula Node, see Chapter 20, The Formula Node, in the
LabVIEW User Manual.

Global Variable

A built-in LabVIEW object that you define by creating a special kind of VI, with front
panel controls that define the datatype of the global variable.

For more information on the global variable, see Chapter 22, Global and Local Variables,
in the LabVIEW User Manual.

Local Variable

Lets you read or write one of the controls or indicators on the front panel of your VI.
Writing to a local variable has the same result as passing data to a terminal, except that
you can write to it even though it is a control, or read from it even though it is an
indicator.

LOCAL
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For more information on the local variable, see Chapter 22, Global and Local Variables,
in the LabVIEW User Manual.
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Numeric Functions

This chapter describes the functions that perform arithmetic operations,
complex, conversion, logarithmic, and trigonometric operations. It also
describes the commonly used constants like the numeric constant,
enumerated constant, and ring constant as well additional numeric
constants.

To access the Numeric palette, select Functions»Numeric. The
following illustration shows the options that are available on the
Numeric palette.
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The Numeric palette includes the following subpalettes:
e Additional Numeric Constants

e Complex

*  Conversion

e Logarithmic

e Trigonometric
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For examples of some of the arithmetic functions, see
examples\general\structs.1llb.

Polymorphism for Numeric Functions

The arithmetic functions accept numeric input data. With some
exceptions noted in the function descriptions, the output has the same
numeric representation as the input, or if the inputs have different
representations, the output is the wider of the inputs.

The arithmetic functions work on numbers, arrays of numbers, clusters
of numbers, arrays of clusters of numbers, complex numbers, and so on.
A formal and recursive definition of the allowable input type is as
follows:

Numeric type = numeric scalar || array [numeric type] || cluster
[numeric types]

The numeric scalars can be a floating-point, integer or complex,
number. G does not allow you to use arrays of arrays.

Arrays can have any number of dimensions of any size. Clusters can
have any number of elements. For functions with one input, the
functions operate on each element of the structure.

For functions with two inputs, you can use the following input
combinations:

*  Similar—both inputs have the same structure, and the output has
the same structure as the inputs.

*  One scalar—one input is a numeric scalar, the other is an array or
cluster, and the output is an array or cluster.

*  Array of—one input is a numeric array, the other is the numeric
type itself, and the output is an array.

For similar inputs, G performs the function on the respective elements
of the structures. For example, G can add two arrays
element-by-element. Both arrays must have the same dimensionality.
You can add arrays with differing numbers of elements; the output of
such an addition has the same number of elements as the smallest input.
Clusters also must have the same number of elements, and the
respective elements must have the same structure.

Note: You cannot use the multiply function to do matrix multiplication. If you
use the multiply function with two matrices, G takes the first number in the
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first row of the first matrix, multiplies it by the first number in the first row
of the second matrix, and so on.

For operations involving a scalar and an array or cluster, G performs the
function on the scalar and the respective elements of the structure. For
example, G can subtract a number from all elements of an array,
regardless of the dimensionality of the array.

For operations that involve a numeric type and an array of that type, G
performs the function on each array element. For example, a graph is an
array of points, and a point is a cluster of two numeric types, x and y.
To offset a graph by 5 units in the x direction and 8 units in the y
direction, you can add a point, (5, 8), to the graph.

See the Polymorphic Combinations example below illustrates some of
the possible polymorphic combinations of the Add function.

Similar One Scalar

zcalar
scalar :l>_ el seala :l>_ artay
aray :'} artay aray
array gcalar ;[%m cluster
cluster ﬁ>m cluster cluster
cluster

Array of

array of clusters

= array of clusters
chuzter

Polymorphism for Trig Functions

The trigonometric functions accept numeric input data. If the input is an
integer, the output is a double-precision, floating-point number.
Otherwise, the output has the same numeric representation as the input.

These functions work on numbers, arrays of numbers, clusters of
numbers, arrays of clusters of numbers, complex numbers, and so on.

Polymorphism for Logarithmic Functions

The logarithmic functions accept numeric input data. If the input is an
integer, the output is a double-precision, floating-point number.
Otherwise, the output has the same numeric representation as the input.

These functions work on numbers, arrays of numbers, clusters of
numbers, arrays of clusters of numbers, complex numbers, and so on.
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Polymorphism for Conversion Functions

All the conversion functions except Byte Array to String, String to Byte
Array, Convert Unit, and Cast Unit Bases are polymorphic. That is, the
polymorphic functions work on scalar values, arrays of scalars, clusters
of scalars, arrays of clusters of scalars, and so on. The output has the
same numeric representation as the input but with the new type.

Polymorphism for Complex Functions

The complex functions work on scalar values, arrays of scalars, clusters
of scalars, arrays of clusters of scalars, and so on. The output has the
same composition as the input but with the new type.

Arithmetic Function Descriptions

The following functions are available.

Absolute Value

Returns the absolute value of the input.

abs(x]

7

Add

Computes the sum of the inputs.

A
¥

Add Array Elements

Returns the sum of all the elements in numeric array.

numeric array Ii|/> LM
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Compound Arithmetic

Performs arithmetic on two or more numeric, cluster, or Boolean inputs.

wvaluel sum, product,
valuel =1L wnD or OR of
PP R i | values

You select the operation (multiply, AND, or OR) by popping up on the function and
selecting Change Mode.

You can invert the inputs or the output of this function by popping up on the individual
terminals, and selecting Invert. For Add, select Invert to negate an input or the output.
For Multiply, select Invert to use the reciprocal of an input or to produce the reciprocal
of the output. For AND or OR, select Invert to logically negate an input or the output.

Note: You add inputs to this node by popping up on an input and selecting Add
Input or by placing the Positioning tool in the lower left or right corner of
the node and dragging it.

Decrement

Subtracts 1 from the input value.

Divide

Computes the quotient of the inputs.

— Dt
y ?

Increment
Adds 1 to the input value.

H—@—PH-I
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Multiply
Returns the product of the inputs.

p— S
¥
¥

Multiply Array Elements

Returns the product of all the elements in numeric array.

NUMErNc amay {b produict

Negate

Negates the input value.

H] @ X

Quotient & Remainder

Computes the integer quotient and the remainder of the inputs.

X [ R} s floar (=]
y —'_ml_‘— flaar(x/y)

With integer input values for y of zero, the quotient is zero and the remainder is the
dividend x. For floating point inputs, if y is zero, the quotient is infinity and the remainder
defaults to NaN.

Random Number (0-1)

Produces a double-precision floating-point number between 0 and 1 exclusive, or not
including 0 and 1. The distribution is uniform.

Fﬁg nurnber; Ota 1
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Reciprocal
Divides 1 by the input value.

X % 1/

Round To +Infinity

Rounds the input to the next highest integer. For example, if the input is 3.1, the result
is 4. If the input is —3.1, the result is -3.

¥ IB} ceill=] smallest int >= =

Round To —Infinity

Rounds the input to the next lowest integer. For example, if the input is 3.8, the result is
3. If the input is —3.8, the result is —4.

X IUR/ flor(=]: largest int <=«

Round To Nearest

Rounds the input to the nearest integer. If the value of the input is midway between two
integers (for example, 1.5 or 2.5), the function returns the nearest even integer (2).

number lﬂr\/ nearest integer value

Scale By Power 0f 2

Multiplies one input (x) by 2 raised to the power of the other input (n). If n is
floating-point, this function rounds n prior to scaling x (0.5 rounds to 0; 0.51 rounds
to 1). If x is an integer, this function is the equivalent of an arithmetic shift.

— g
X
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Sign
Returns 1 if the input value is greater than O, returns O if the input value is equal to 0, and

returns —1 if the input value is less than 0. Other programming languages typically call
this function the signum or sgn function.

[,
number ek -1.0.1

Square Root

Computes the square root of the input value. If x is negative, the square root is not a
number (NaN) unless x is complex.

¥ L«_l_'r}« it

Subtract

Computes the difference of the inputs.

p— bt
i
¥

User Definahle Arithmetic Constants
You can define the following constants.

Numeric Constant

Use this to supply a constant numeric value to the block diagram. Set this value by
clicking inside the constant with the Operating tool and typing in a value. You can change
the data format and representation.

The value of the numeric constant cannot be changed while the VI executes. You can
assign a label to this constant.

Enumerated Constant

Enumerated values associate unsigned integers to strings. If you display a value from an
enumerated constant the string displays instead of the number associated with it. If you
need a set of strings that will not change, then use this constant. Set the value by clicking
inside the constant with the Operating Tool. Set the string with the Labeling Tool and
enter the string. To add another item, click on the constant and choose Add Item Before
or Add Item After.
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The value of the enumerated constant cannot be changed while the VI executes. You can
assign a label to this constant.

Ring Constant

Rings can be used to associate unsigned integers to strings. If you display a value from a
ring constant the number displays instead of the string associated with it. If you need a
set of strings that will not change, then use this constant. Set the value by clicking inside
the constant with the Operating Tool. Set the string with the Labeling Tool and enter the
string. To add another item, pop up on the constant and choose Add Item Before or Add
Item After.

The value of the ring constant cannot be changed while the VI executes. You can assign
a label to this constant.

Conversion Functions Descriptions

The following illustration shows the options that are available on the Conversion
subpalette.

-—HConversion

11g) J116) J132) Jug) Juiel Ju32)
ISGL) IDBL) JEXT! JGSGl ICDB) IGXT)

The following functions convert a numeric input into a specific representation:
* To Byte Integer

* To Double Precision Complex

¢ To Double Precision Float

¢ To Extended Complex

* To Extended Precision Float

* To Long Integer

¢ To Single Precision Complex

e To Single Precision Float

¢ To Unsigned Byte Integer

© National Instruments Corporation 4-9 LabVIEW Function and VI Reference Manual



Chapter 4

Numeric Functions

e To Unsigned Word Integer
e To Unsigned Long Integer
e To Word Integer

When these functions convert a floating-point number to an integer, they round the output
to the nearest integer, or the nearest even integer if the fractional part is 0.5. If the result
is out of range for the integer, these functions return the minimum or maximum value for
the integer type. When these functions convert an integer to a smaller integer, they copy
the least significant bits without checking for overflow. When they convert an integer to
a larger integer, they extend the sign of a signed integer and pad an unsigned integer with
Zeros.

Use caution when you convert numbers to smaller representations, particularly when
converting integers, because the G conversion routines do not check for overflow.

Boolean Array To Number

Converts Boolean array to an unsigned long integer by interpreting it as the two’s
complement representation of an integer with the Oth element of the array being the least
significant bit.

Boolean array rumbes

Boolean To (0,1)

Converts a Boolean value to a word integer— 0 and 1 for the input values FALSE and
TRUE, respectively.

Boolean 7o:1) 0,1

Boolean can be a scalar, an array, or a cluster of Boolean values, an array of clusters of
Boolean values, and so on. See the Polymorphism for Boolean Functions section in
Chapter 5, Boolean Functions.

Byte Array To String

Converts an array of unsigned bytes into a string.

unszigned byte array ztring
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Cast Unit Bases

Changes the units associated with the input to the units associated with unit and returns
the results at the output terminal. Use this function with extreme care. Because the Cast
Unit Bases function works with bases, you must understand the conversion from an
arbitrary unit to its bases before you can effectively use this function. This function can
change base units, such as changing meters to grams.

unit [none] —‘_|
X ] ot

Convert Unit

Converts a physical number (a number that has a unit) to a pure number (a number with
no units) or a pure number to a physical number.

X —m 7= f—

You can edit the string inside of the unit by highlighting the string with an Operating tool
and then entering the text.

If the input is a pure number, the output receives the specified units. For example, given
an input of 13 and a unit specification of seconds(s), the resulting value is 13 seconds.

If the input is a physical number, and unit is a compatible unit, the output is the input
measured in the specified units. For example, if you specify 37 meters(m), and a unit is
m, the result is 37 with no associated units. If unit is feet (ft), the result is 121.36 with
no associated units.

Number To Boolean Array

Converts an integer number to a Boolean array of 8, 16, or 32 elements, where the Oth
element corresponds to the least significant bit (LSB) of the two’s complement
representation of the integer.

number Boolean array
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String To Byte Array

Converts a string into an array of unsigned bytes.

glring unzigned byte array

To Byte Integer

Converts number to an 8-bit integer in the range —128 to 127.

number 118} Bhit integer

To Double Precision Complex

Converts a number to a double-precision complex number.

numhber 1CDE} double precizion comples

To Double Precision Float
Converts number to a double-precision floating-point number.

number JDEL} double precision float

To Extend Precision Complex

Converts a number to an extended-precision complex number.

number ICHT) extended precizion comples

To Extended Precision Float
Converts number to an extended-precision floating-point number.

numhber JEXT} extended precizion float
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To Long Integer

Converts number to a 32-bit integer in the range 23110 23111

number 1132} 32bit integer

To Single Precision Complex
Coverts a number to a single-precision complex number.

number ICSG} gingle precizion complex

To Single Precision Float

Converts number to a single-precision floating-point number.

number JSGL} zingle precizion float

To Unsigned Byte Integer

Converts number to an 8-bit unsigned integer in the range 0 to 255.

numher 108 } unzigned Bhit integer

To Unsigned Long Integer
Converts number to a 32-bit unsigned integer in the range 0 to 232 —1.

numhber 1U32Z} ungigned 32bit integer

To Unsigned Word Integer

Converts number to a 16-bit unsigned integer in the range 0 to 65,535.

number U1E} unzigned 1Ebit integer
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To Word Integer

Converts number to a 16-bit integer in the range —32,768 to 32,767.

number 1116} 16bit integer

Trigonometric Functions Descriptions

The following illustration shows the options for the Trigonometric subpalette.

I Trigonometric |
..... ~

S="5IN

SINH

. ifecfest, > AN I | AR
I || TN B i H T X H
coc| [y sEC ]| YicdT CO5 ATANzZ] | SINGE)

Cosecant
Computes the cosecant of X, where x is in radians. Cosecant is the reciprocal of sine.

14zin] )

Cosine

Computes the cosine of x, where x is in radians.

® _’I,-'ﬂ"-,\_ oz«

Cotangent

Computes the cotangent of x, where x is in radians. Cotangent is the reciprocal of tangent.

g
X \'. -:-:ir| 1/tanx]
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Hyperbolic Cosine

Computes the hyperbolic cosine of x, where X is in radians.

X H\*“Li | coghix]

Hyperbolic Sine

Computes the hyperbolic sine of x, where X is in radians.

X ismu ginhlx]

Hyperbolic Tangent

Computes the hyperbolic tangent of x, where x is in radians.

X ; tanhlx]

Inverse Cosine

Computes the arccosine of x in radians. If x is not complex and is less than —1 or greater
than +1, the result is NaN.

X N arcoog(x]

Inverse Hyperbolic Cosine

Computes the hyperbolic argcosine of x in radians. If x is not complex and is less than 1,
the result is NaN.

7]

HEI:ZI;'HE

argooshi(=]
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Inverse Hyperbolic Sine

Computes the hyperbolic argsine of x in radians.

- argzinhx)

Inverse Hyperbolic Tangent

Computes the hyperbolic argtangent of x in radians. If X is not complex and is less than
—1 or greater than 1, the result is NaN.

-1; Jlti
X : n‘mi : argtanhix]

Inverse Sine

Computes the arcsine of x in radians. If x is not complex and is less than —1 or greater
than +1, the result is NaN.

arcinx]

Bsing

Inverse Tangent
Computes the arctangent of x in radians (which can be between —n/2 and n/2).

"'{igmu

arctan[x]

Inverse Tangent (2 Input)

Computes the arctangent of y/x in radians. This function can compute the arctangent for
angles in any of the four quadrants of the x,y plane, whereas the Inverse Tangent function
computes the arctangent in only two quadrants.

y— i

ERE
X ATANEZ

atan[x.y]
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Secant

Computes the secant of x, where X is in radians.

1/cosx]

Sinc

Computes the sine of x divided by x, where X is in radians.

X o zin(x)
SINE

Sine

Computes the sine of x, where x is in radians.

% — o zin[R]

Sine & Cosine

Computes both the sine and cosine of x, where x is in radians. Use this function only
when you need both results.

. u%ﬁ gir[)
S cos(x]
Tangent
Computes the tangent of x, where x is in radians.
Difm
X gfte tan(x]
L& iran|
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Logarithmic Functions Descriptions

The following illustration shows the options for the Logarithmic subpalette.

iix! Logarithmic |

o 2, % e

i | | et | e 1.‘. ety

i | U | ST

| | N | | A
Exponential
Computes the value of e raised to the x power.
X enplx]

Exponential (Arg) -1

Computes 1 less than the value of e raised to the x power. When x is very small, this
function is more accurate than using the Exponential function and then subtracting 1 from
the output.

B g

explx] -1

—..i1
ERP -1

Logarithm Base 2

Computes the base 2 logarithm of x. If x is 0, log2(x) is —co. If X is not complex and is
less than 0, log2(x) is NaN.

¥ ! A lag2]z]

Qi
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Logarithm Base 10

Computes the base 10 logarithm of x. If x is 0, log(x) is —co. If X is not complex and is
less than 0, log(x) is NaN.

lagx]

10
LOG

Logarithm Base X

Computes the base x logarithm of y (x>0, y>0). If y is 0, the output is —co. When x and y
are both not complex and x is less than or equal to 0, or y is less than O, the output is NaN.

1
¥
f lags]
X

Natural Logarithm

Computes the natural base e logarithm of x, that is, the logarithm of x. If x is 0, In(x) is
—oo. If x is not complex and is less than 0, In(x) is NaN.

X i & In[x)

Natural Logarithm (Arg +1)

Computes the natural logarithm of (x + 1). When x is near 0, this function is more
accurate than adding 1 to x and then using the Natural Logarithm function. If x is equal
to —1, the result is —oo. If X is not complex and is less than —1, the result is NaN.

x St Il 1]
L)
Power Of 2
Computes 2 raised to the x power.
E e 2
Zx: 1
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Power 0f 10

Computes 10 raised to the x power.

10,
X RIE SR 10™w
ki

Power Of X

Computes x raised to the y power. If x is not complex, it must be greater than zero unless
y is an integer value. Otherwise, the result is NaN. If y is zero, xy is 1 for all values of
X, including zero.

L

Complex Function Descriptions

The following illustration displays the options available on the Complex subpalette.

i Complex

= [k B bl

The functions Polar To Complex and Re/Im To Complex create complex numbers from
two values given in rectangular or polar notation, and the functions Complex To Polar
and Complex To Re/Im break a complex number into its rectangular or polar
components.

Complex Conjugate
Produces the complex conjugate of x + iy.

X4y Lﬁh““__..a Wy
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Complex To Polar

Breaks a complex number into its polar components.

r * e [i"theta] {heta

Complex To Re/lm

Breaks a complex number into its rectangular components.

- e w
X+ Z i v

Polar To Complex

Creates a complex number from two values in polar notation.

theta: i r* e i"theta)

Re/Im To Complex
Creates a complex number from two values in rectangular notation.

P
¥
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Additional Numeric Constants Descriptions

The following illustration displays the options available on the Additional Numeric
Constants subpalette.

> Additional Numeric Constants |

E (2 kd b (k2 E=
HECDERE B

Additional User Definable Constants
You can define the following constants.

i Listhox Symbol Ring Constant

This ring constant assigns symbols to items in a listbox control. Typically, you wire this
constant into the Item Symbols attribute.

Color Box Constant

Use this to supply a constant color value to the block diagram. Set this value by clicking
on the constant with the Operating tool and choosing the desired color.

The value of the color box constant cannot be changed while the VI executes. You can
assign a label to this constant.

Error Ring Constant

This constant is a predefined ring of errors specific to memory usage, networking,

printing, and file I/O. Errors related to DAQ, GPIB, VISA, and Serial VIs and functions
are not options in this ring.

Fixed Constants

The following constants are fixed.
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Avogadro Constant (1/mol)
Returns the value 6.0220e23.

Base 10 Logarithm of e
Returns the value 0.43429448190325183.

Elementary Charge (c)
Returns the value 1.6021892e-19.

Gravitational Constant (Nm%/kg?)
Returns the value 6.6720e-11.

Molar Gas Constant (J/mol K)
Returns the value 8.31441.

e
Returns the value 2.7182818284590452e+0.

Natural Logarithm of Pi
Returns the value 1.14472988584940020.

Natural Logarithm of 2
Returns the value 0.69314718055994531.

Natural Logarithm of 10
Returns the value 2.30234095236904570.

Negative Infinity

Returns the value —oo.

Pi
Returns the value 3.14159265358979320.

Pi divided by 2
Returns the value 1.57079632679489660.

Pi multiplied by 2
Returns the value 6.28318530717958650.

Numeric Functions
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Planck’s Constant (J/Hz)
Returns the value 6.6262e-34.

Positive Infinity

Returns the value +.

Reciprocal of e
Returns the value 0.36787944117144232.

=
13

Reciprocal of Pi
Returns the value 0.31830988618379067.

5

Rydberg Constant (/m)
Returns the value 1.097373177¢7.

E

Speed of Light in Vacuum (m/sec)
Returns the value 299,792,458.
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Boolean Functions

This chapter describes the functions that perform logical operations.
The following illustration shows the Boolean palette, which you access

by selecting Functions»Boolean.

it»! Functions

Boolean

3 w
5
@’ . «—1HBoolean

[ W I 4
(2> Iv» 7 [

V> 1> a3 m e

CrHE+

For examples of some of the Boolean functions, see
examples\general\structs.1llb.

Polymorphism for Boolean Functions

The logical functions take either Boolean or numeric input data. If the
input is numeric, G performs a bit-wise operation. If the input is an
integer, the output has the same representation. If the input is a
floating-point number, G rounds it to a long integer, and the output is
long integer.

The logical functions work on arrays of numbers or Boolean values,
clusters of numbers or Boolean values, arrays of clusters of numbers or
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Boolean values, and so on. A formal and recursive definition of the
allowable input type is as follows.

Logical type = Boolean scalar || numeric scalar || array [logical type] ||
cluster [logical types]

except that complex numbers and arrays of arrays are not allowed.

Logical functions with two inputs can have the same input
combinations as the arithmetic functions. However, the logical
functions have the further restriction that the base operations can only
be between two Boolean values or two numbers. For example, you
cannot have an AND between a Boolean value and a number. See the
example below for an illustration of some combinations of Boolean
values for the AND function.

Boalean scalar

cluster
cluster

_____ - Biailean scalar

Boalean scalar -

Boolean arra
¥ Boolean array
Boolean array

Similar One Scalar

Boalean scalar ...
Boolean arvay
Baalean array

Bonlean scalar

Boolean cluster e o= Boolean cluster

array of clusters
cluster

Boolean Function Descriptions

The following Boolean functions are available.

And

Computes the logical AND of the inputs.

w.and. y?

Note: This function performs bit-wise operations on numeric inputs.
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And Array Elements
Returns TRUE if all the elements in Boolean array are true; otherwise it returns FALSE.

Boolean amray I"ﬂ" logical AMD

Boolean Array To Number

Converts Boolean array to an unsigned long integer by interpreting it as the two’s
complement representation of an integer with the Oth element of the array being the least
significant bit.

Boolean array number

Boolean To (0,1)

Converts a Boolean value to a word integer--0 and 1 for the input values FALSE and
TRUE, respectively.

Boolean 1Zo-1} 01

Compound Arithmetic

Performs arithmetic on two or more numeric, cluster, or Boolean inputs.

wvaluel sum, product,
valel AND or OR of
R R values

You select the operation (multiply, AND, or OR) by popping up on the function and
selecting Change Mode.

You can invert the inputs or the output of this function by popping up on the individual
terminals, and selecting Invert. For Add, select Invert to negate an input or the output.
For Multiply, select Invert to use the reciprocal of an input or to produce the reciprocal
of the output. For AND or OR, select Invert to logically negate an input or the output.

Note: You add inputs to this node by popping up on an input and selecting Add
Input or by placing the Positioning tool in the lower left or right corner of
the node and dragging it.
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Exclusive Or
Computes the logical Exclusive OR of the input

S.

Implies

Computes the logical OR of y and of the logical negation of x. That is, the function
negates x and then computes the logical OR of y and of the negated x.

W .implies. vy

Not

Computes the logical negation of the input.

ik, ®7?

Not And
Computes the logical NAND of the inputs.

.................. hat. [:': .and_ _Irl]?

Not Exclusive Or

Computes the logical negation of the logical exclusive OR of the inputs.

ik, [ war, w)?

Not Or
Computes the logical NOR of the inputs.

itk [ on w]?
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Number To Boolean Array

Converts number to a Boolean array of 8, 16, or 32 elements, where the Oth element
corresponds to the least significant bit (LSB) of the two's complement representation of
the integer.

number Boolean aray

Or

Computes the logical OR of the inputs.

Or Array Elements

Returns FALSE if all the elements in Boolean array are false; otherwise it returns
TRUE.

Boolean amay Iﬁl/\ logical OR

Boolean Constant

Use this to supply a constant true/false value to the block diagram. Set this value by
clicking on the T or F portion of the constant with the Operating tool. This value cannot
be changed while the VI executes.

You can assign a label to this constant.
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String Functions

This chapter describes the string functions, including those that convert
strings to numbers and numbers to strings.

The following illustration shows the String palette, which you access
by selecting Functions»String.

73 i 2 (O 2 574 (R )

Overview of Polymorphism for String Functions

This section provides descriptions of polymorphism for String
functions, Additional String to Number functions, and String
Conversion functions.
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Polymorphism for String Functions

String Length, To Upper Case, To Lower Case, Reverse String, and
Rotate String accept strings, clusters, arrays of strings, and arrays of
clusters. To Upper Case and To Lower Case also accept numbers,
clusters of numbers, and arrays of numbers, interpreting them as ASCII
codes for characters (refer to the Appendix B, Multiline Interface
Messages, later in this manual, for the numbers that correspond to each
character). Width and precision inputs must be scalar.

Polymorphism for Additional String to Number Functions

To Decimal, To Hex, To Octal, To Engineering, To Fractional, and To
Exponential accept clusters and arrays of numbers and produce clusters
and arrays of strings. From Decimal, From Hex, From Octal, and From
Exponential/Fract/Sci accept clusters and arrays of strings and produce
clusters and arrays of numbers. Width and precision inputs must be
scalar.

Polymorphism for String Conversion Functions
The Path To String and String To Path functions are polymorphic. That
is, they work on scalar values, arrays of scalars, clusters of scalars,
arrays of clusters of scalars, and so on. The output has the same
composition as the input but with the new type.

Format Strings Overview

Many G functions accept a format string input, which controls the
behavior of the function. A format string is composed of one or more
format specifiers, which determine what action to take to process a
given parameter. The Format Into String and Scan From String
functions can use multiple format specifiers in the format string, one for
each resizable input or output to the function. Characters in the string
that are not part of the format specifier are copied verbatim to the output
string (in the case of Format Into String) or are matched exactly in the
input string (in the case of Scan From String), with the exception of
special escape codes. You can use these codes to insert nondisplayable
characters, the backslash, and percent characters within any format
string. These codes are similar to those used in the C programming
language.
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Table 6-1 displays the special escape codes. A code does not exist for
the platform-dependent end-of-line (eol) character. If you need to
append one, use the End-of-Line constant from the String palette.

Table 6-1. Special Escape Codes

Code Meaning
\r Carriage Return
\t Tab
\b Backspace
\n Newline
\f Form Feed
\s space
\xx character with hexadecimal ASCII code xx (using 0
through 9 and upper case A through F)
\\ \
%% %

Notice also that for the Scan From String and Format & Strip functions,
a space in the format string matches any amount of whitespace (spaces,
tabs, and form feeds) in the input string.

The Format & Append, Format & Strip, Array To Spreadsheet String,
and Spreadsheet String To Array functions use only one format
specifier in the format string, because these functions have only one
input that can be converted. Any extraneous specifiers inserted into
these functions are treated as literal strings with no special meaning.

For functions that output a string, such as Format Into String, Format &
Append, and Array To Spreadsheet String, a format specifier has the
following syntax. Double brackets ( [] ) enclose optional elements.

S[-1[+]1["1[0] [Width][.Precision] [{unit}]Conversion Code
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For functions that scan a string, such as Scan From String, Format &
Strip, and Spreadsheet String to Array, a format specifier has the
following, simplified syntax:

% [Width]Conversion Code

Table 6-2 displays the string syntax available.

Table 6-2. String Syntax

Syntax Element

Description

%

Begins the formatting specification.

— (optional)

Causes the parameter to be left justified rather
than right justified within its width.

+ (optional)

For numeric parameters, includes the sign even
when the number is positive.

A (optional

When used with the e or g conversion codes,
uses engineering notation (exponent is always a
multiple of 3).

0 (optional)

Pads any excess space to the left of a numeric
parameter with Os rather than spaces.

Width (optional)

When scanning, specifies an exact field width to
use. G scans only the specified number of
characters when processing the parameter.

When formatting, specifies the minimum
character field width of the output. This is not a
maximum width; G uses as many characters as
necessary to format the parameter without
truncating it. G pads the field to the left or right of
the parameter with spaces, depending on
justification. If Width is missing or zero, the
output is only as long as necessary to contain the
converted input parameter.

Separates Width from Precision.
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Table 6-2. String Syntax (Continued)

Syntax Element Description

Precision (optional) | For floating-point parameters, specifies the
number of digits to the right of the decimal point.
If Width is not followed by a period, G inserts a
fractional part of six digits. If Width is followed
by a period, and Precision is missing or 0, G does
not insert a fractional part.

For string parameters, specifies the maximum
width of the field. G truncates strings longer than
this length.

{unit} (optional) Overrides the choice of unit of a VI when
converting a physical quantity (a value with an
associated unit). Must be a valid unit.

Conversion Codes | Single character that specifies how to convert
number, as follows

d to decimal integer

to hex integer

to octal integer

to binary integer

to floating-point number with
fractional format

Hh O O X

e to floating-point number with
scientific notation

g to floating-point number using e
format if the exponential is less
than —4 or greater than Precision,
or £ format otherwise

s to string

The Conversion Codes used in G are similar to those used in the C
programming language. However, G uses conversion codes to
determine the textual format of the parameter, not the datatype of the
parameter.

You can use the 4, x, o, b, £, e and g conversion codes to process any
numeric G data type, including complex numbers and enums.
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For complex numbers, you can use the format specifier to process both
the real and imaginary parts as a single parameter.

You can use the s conversion code to process string or path parameters
or enums.

Notice that you can use either a numeric or string conversion code with
an enum, depending on whether you want the numeric value or
symbolic (string) value of the enum.

For compatibility with C, G treats a u conversion code (unsigned
integer) the same as a d, and ignores an 1 or L preceding the conversion
code. However, in G it is the datatype of the parameter that determines
the size of an integer and whether the integer is signed or unsigned.

For examples of format string usage, see the Format Into String and
Scan From String function descriptions later in this chapter.

String Function Descriptions

The following string functions are available.

Array To Spreadsheet String

Converts an array of any dimension to spreadsheet string. spreadsheet string is a table
in string form, containing delimiter-separated column elements, a platform-dependent
EOL character separating rows, and, for arrays of three or more dimensions, pages are
separated.

delirniter [T ah)
format ztring

spreadshest stin
array F d

Concatenate Strings

Concatenates input strings and one-dimensional arrays of strings into a single, output
string. For array inputs, this function concatenates each element of the array.

ztringld, stringl, ..., string n-1

string O [ concatenation of
string 1 ::| |E
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Converts input arguments into resulting string, whose format is determined by format
string. You increase the number of parameters by popping up on the node and selecting
Add Parameter or by placing the Positioning tool over the lower left or right corner of
the node and then stretching it until you reach the desired number of arguments.

format string
initial string

error in Cno error)

arqurnent 1 (0]

Py
L

%mﬁ resulting string

errar out

Table 6-3 shows the possible errors which may be produced in error out by Format Into

String.
Table 6-3. Possible Format Into String Errors
Error Code Description
Format specifier type 81 The datatype of a format specifier in the format string
mismatch does not match the datatype of the corresponding
input argument.
Unknown format 82 The format string contains an invalid format specifier.
specifier
Too few format 83 There are more arguments than format specifiers.
specifiers
Too many format 84 There are more format specifiers than arguments.
specifiers
Note: If an error occurs, the source component of the error out cluster contains

a string of the form “Format Into String (arg n),” where n is the first
argument for which the error occurred.

If you wire a block diagram constant string to format string, G checks for errors in format
string at compile time. Such errors must be corrected before you can run the VI. In this
case, no errors can occur at run time.
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Format Specifier Examples

In Table 6-4, the underline character (_) represent spaces in the output. The last three
entries are examples of physical quantity inputs.

Table 6-4. Format Specifiers

Format String Argument(s) Resulting String
score= %2d% % 87 score= 87%
level=\n%-7.2e V 0.03642 level= 3.64e-2 V
Name: %s, %s. Smith John Name: Smith, John.

Temp: %05.1f %s

96.793 Fahrenheit

Temp: 096.8 Fahrenheit

String: %10.5s. Hello, World String:______Hello.
%5.3f 5.67N 5.670 N

%5.3{mN }f 5.67N 5670.000 mN
%5.3{kg}t 567N 5.670 ?kg

The last table entry shows the output when the unit in the format specifier is in conflict

with the input unit.

Index & Append

Selects a string specified by index from string array and appends that string to string.

Index & Strip

Compares each string in string array with the beginning of string until there is a match.

shring array
string [ mﬁ@!

index .

output tring
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Searches for regular expression in string beginning at offset, and if it finds a match,
splits string into three substrings.

regular expression

before zubstring
match subsztring
after zubstring
offzet past match

gtrning ~
offzet [0]

Table 6-5. Special Characters for Match Pattern

Special Character

Interpreted by the Match Pattern Function as...

Matches any character.

Matches zero or one instances of the expression preceding ?.

Cancels the interpretation of special characters (for example, \?
matches a question mark). You can also use the following
constructions for the space and nondisplayable characters

\b backspace

\f form feed

\n newline

\s space

\r carriage return

\xx any character, where xx is the hex code
using 0 through 9 and upper case A
through F

\t tab

If A is the first character of regular expression, it anchors the match
to the offset in string. The match fails unless regular expression
matches that portion of string that begins with the character at
offset. If ~ is not the first character, it is treated as a regular
character.
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Table 6-5. Special Characters for Match Pattern (Continued)

Special Character

Interpreted by the Match Pattern Function as...

[]

Encloses alternates. For example, [abc] matches a, b, or c. The
following character has special significance when used within the
brackets in the following manner.

— (dash)Indicates arange when used between digits, or lowercase or
uppercase letters (for example, [0-5],[a—g], or [L-Q])

The following characters have significance only when they are the
first character within the brackets.

~Excludes the set of characters, including nondisplayable
characters. [~0-9] matches any character other than 0 through 9.

A Excludes the set with respect to all the displayable characters (and
the space characters). [*0-9] gives the space characters and all
displayable characters except O through 9.

Matches the longest number of instances of the expression
preceding +; there must be at least one instance to constitute a
match.

Matches the longest number of instances of the expression
preceding * in regular expression, including zero instances.

If $ is the last character of regular expression, it anchors the match
to the last element of string. The match fails unless regular
expression matches up to and including the last character in the
string. If $ is not last, it is treated as a regular character.

Table 6-6 shows examples of the Strings for the Match Pattern functions.

Table 6-6. Strings for the Match Pattern Examples

Characters to Be Matched Regular Expression

VOLTS

VOLTS

on

All uppercase and lowercase versions of [VV][Oo][LI][Tt][Ss]
volts, that is, VOLTS, Volts, volts, and so
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Table 6-6. Strings for the Match Pattern Examples (Continued)

Characters to Be Matched Regular Expression
A space, a plus sign, or a minus sign [+-]
A sequence of one or more digits [0-9]+
Zero or more Spaces \s* or * (that is, a space followed by an
asterisk)
One or more Spaces, Tabs, Newlines, or [\ \r\n \s]+

Carriage Returns

One or more characters other than digits [~0-9]+

The word Level only if it begins at the ALevel
offset position in the string

The word Volts only if it appears at theend | Volts$
of the string

The longest string within parentheses *)

The longest string within parentheses but I~O1"
not containing any parentheses within it

The character, [ [[]

Pick Line & Append

Chooses a line from multi-line string and appends that line to string.

multi-line string
string ] “"""3 E
Hake?

line index . output ztring

Reverse String

Produces a string whose characters are in reverse order of those in string.

string Jub-ba} reversed
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Rotate String

Places the first character of string in the last position of first char last, shifting the other
characters forward one position. For example, the string abcd becomes bcda.

ztring

EE |

first char last

Scan From String

Scans the input string and converts the string according to format string. You increase
the number of parameters by popping up on the node and selecting Add Parameter or
by placing the Positioning tool over the lower left or right corner of the node and then
stretching it until you reach the desired number of parameters.

Use Scan From String when you know the exact format of the input string.

forrnat string
input string

initial search Tocation
errar in [no error)
default 1 (0 db1)

mﬂw«« remaining string

$o., 0t offset past scan
1o errar out
@ I:J output 1

Table 6-7 lists the Scan from String errors.

Table 6-7. Scan From String Errors

Error Code Description

Format specifier type mismatch 81 The datatype of a format specifier
in the format string does not match
the datatype of the corresponding
output.

Unknown format specifier 82 The format string contains an
invalid format specifier.

Too few format specifiers 83 There are more arguments than
format specifiers.
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Table 6-7. Scan From String Errors (Continued)
Error Code Description

Too many format specifiers 84 There are more format specifiers
than arguments.

Scan failed 85 Scan From String was unable to
convert the input string into the
datatype indicated by the format
specifier.

Note: If an error occurs, the source component of the error out cluster contains
a string of the form “Scan From String (arg n),” where n is the first

argument for which the error occurred.

If you wire a block diagram constant string to format string, G checks for errors in format
string at compile time. You must correct these errors before you can run the VI. In this
case, only Scan failed can occur at run time.

Table 6-8 lists Scan From String examples.

Table 6-8. Scan from String Examples

Remaining
Input String Format String Default(s) Output(s) String

abc xyz Y08 abc 00
12.3+56i1 7200 Y05 %0t %2d Xyz

12.3+56i1

72
Q+1.27E-3 tail Q%f t 1.27E-3 ail
0123456789 %3d%3d 12 6789

345
X:9.860 Z:3.450 X:9%fY : %t 100 (I32) 10 Z.: 3450

100.0 (DBL) 100.0
set49.4.2 set%d 49 4.2
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Select & Append

Selects either a false string or true string according to a Boolean selector and appends
that string to string.

falze string
true ztring
gtring [

selector

]rm

autput string

Select & Strip

Examines the beginning of string to see whether it matches true string or false string.
This function returns a Boolean TRUE or FALSE value in selection, depending on
whether string matches true string or false string.

; - -
string PRI B selection

f;:: :::::g o autpLt string

Split String
Splits the string at offset or searches for the first occurrence of search char in the string,
beginning at offset, and splits the string at that point.

subztring before char
char substring
offzet of char

gearch char [-]
string
offzet (0]

Spreadsheet String To Array

Converts the spreadsheet string to a numeric array of the dimension and representation
of array type. This function works for arrays of strings as well as arrays of numbers.

delirmiter [T ab)

format string
spreadzheet string -~

array tppe (20 D)=

array
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String Length

Returns in length the number of characters (bytes) in string.

ztring B e length

String Subset

Returns the substring of the original string beginning at offset and containing length
number of characters.

length —— _
affset [0] = EE B substring
string

To Lower Case

Converts all alphabetic characters in string to lowercase characters. This function does
not affect nonalphabetic characters.

T = L

ztring 1Aa} all lowser caze string

To Upper Case

Converts all alphabetic characters in string to uppercase characters. This function does
not affect nonalphabetic characters.

glring laf} all upper caze sting

Additional String To Number Function Descriptions

For general information about Additional String to Number functions, see Polymorphism
for Additional String to Number Functions, earlier in this chapter.
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The following illustration displays the options available on the Additional String to
Number Functions subpalette.

dditional String to Humber Functions |

“52 |§5m|
p[nnEn]| ™
HH #'

:.#
@
=

Format & Append
Converts number into a regular string according to the format specified in format
string, and appends this to string.

format string
string [ mﬁﬁﬂ

niumber [ # autput string

Note: The Format Into String function has the same functionality as Format &
Append but can use multiple inputs, so that you can convert information
simultaneously. You should consider using Format Into String instead of
this function: in many cases, this can simplify your block diagram.

Format & Strip

Looks for format string at the beginning of string, formats any number in this string
portion according to the conversion codes in format string, and returns the converted
number in number and the remainder of string after the match in output string.

: string E‘.“E’# rumber
E.;Ir:f]:L:lts[tD"dnhgll] o output string
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From Decimal

Converts the numeric characters in string, starting at offset, to a decimal integer and
returns it in number.

string
offzet
default [OL]

niurnber

From Exponential/Fract/Eng

Interprets the characters O through 9, plus, minus, e, E, and the decimal point (usually
period) in string starting at offset as a floating-point number in engineering notation, or
exponential or fractional format and returns it in number.

Shfifngt offzet pazt number

offze

default 0 db) umber

% Note: If you wire the characters Inf or NaN to string, this function returns the G

values Inf and NaN, respectively.

From Hexadecimal

Interprets the characters 0 through 9, A through F, and a through f in string starting at
offset as a hex integer and returns it in number.

ghring
offzet
default [Qul]

offzet past number
rwrnber

From Octal

Interprets the characters 0 through 7 in string starting at offset as an octal integer and
returns it in number. This function also returns the index in string of the first character
following the number.

string
affzet
default [Oul)

offzet past number
nLrmber
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To Decimal

Converts number to a string of decimal digits width characters wide, or wider if
necessary.

b T, . .
":ir;th?] H% decimal integer sting

To Engineering

Converts number to an engineering format, floating-point string width characters wide,
or wider if necessary. Engineering format is similar to E format, except the exponent is
a multiple of three (-3, 0, 3, 6).

number R
width [-) —'_'"‘%
precizion [B] — e

Enaineering string

To Exponential

Converts number to an E-format (exponential notation), floating-point string width
characters wide, or wider if necessary.

number T _
width [-] = nnEn] E -farmat string

precizion [F] —

To Fractional

Converts number to an F-format (fractional notation), floating-point string width
characters wide, or wider if necessary.

number LT _
width [-] =—{*l.onn F-format string
H ...... .

precision [B] — |
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To Hexadecimal

Converts number to a string of hexadecimal digits width characters wide, or wider if
necessary.

number ‘*%
'F NN

width [-] ——{»a he integer string

To Octal

Converts number to a string of octal digits width characters wide, or wider if necessary.

number “%
'? Q00|

width [-] ——w

octal integer sting

String Conversion Function Descriptions

For general information about String Conversion functions, see Overview of
Polymorphism for String Functions earlier in this chapter.

The following illustration shows the String Conversion subpalette.

i» Conversion |

Array Of Strings To Path accepts one-dimensional (1D) arrays of strings, Path To Array
Of Strings accepts paths, Path To String accepts paths, and String To Path accepts strings.

Array Of Strings To Path

Converts an array of strings into a relative or absolute path.
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If you have an empty string in the array the directory location before the empty string is
deleted in the path output. Think of this as moving up a level in directory hierarchy.

TElatjyp e

array of ztrings [ 1) path

Byte Array To String

Converts an array of unsigned bytes into a string.

unsigned byte array shring

Path To Array Of Strings

Converts a path into an array of strings and indicates whether the path is relative.

g relative

path g“‘ﬂ-[“].- array of shrings

Path To String

Converts path into a string describing a path in the standard format of the platform.

path Py abef shring

Refnum To Path

Returns the path associated with the specified refnum.

refrnum 5N path

String To Byte Array

Converts a string into an array of unsigned bytes.

gtring unzigned byte aray
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String To Path

Converts a string, describing a path in the standard format for the current platform, to a
path.

ztring Jab: %} path

String Fixed Constants

The following String Fixed Constants are available.

String Constant
Use this to supply a constant ASCII value to the block diagram. Set this value by clicking
inside the constant with the Operating tool and typing in the value. You can change the
display mode so you can see non-displayable characters or the hex equivalent to the
characters. You can also set the constant in password display mode so “*” are displayed
when you type in characters.

The value of the string constant cannot be changed while the VI executes. You can assign
a label to this constant.

Carriage Return

Consists of a constant string containing the ASCII CR value.

1 Empty String

Consists of a constant string that is empty. Length is zero.

End of Line

Consists of a constant string containing the platform-dependent, end of line value. For
Windows, the value is CRLF; for Macintosh, the value is CR; and on UNIX, the value
is LF.

Line Feed

Consists of a constant string containing the ASCII LF value.

Tab

Consists of a constant string containing the ASCII HT (horizontal tab) value.
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This topic describes the functions for array operations.

The following illustration shows the Array palette which you access by
selecting Functions»Array.

B! Functions
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Some of the array functions are also available from the Array Tools
palette of most terminal or wire pop-up menus. The illustration below
shows the pop-up menu.

| Array Tools p |

[E]E Ey o | [
=4 ] =t et | |ET | [

S = ER
B+ [LE Jj oo

If you select the functions from this palette, they appear with the correct
number of terminals to wire to the object on which you popped up.

For examples of array functions, see
examples\generallarrays.llb.

Array Function Overview

Some of the array functions have a variable number of terminals. When
you drop a new function of this kind, it appears on the block diagram
with only one or two terminals. You can add and remove terminals by
using the pop-up menu Add Element Input or Add Array Input and
Remove Input commands (the actual names depend on the function) or
by resizing the node vertically from any corner. If you want to add
terminals by popping up, you must place your cursor on the input
terminals to access the pop-up menu.

You can shrink the node if doing so does not delete wired terminals. The
Add Element Input or Add Array Input command inserts a terminal
directly after the one on which you popped up. The Remove Input
command removes the terminal on which you popped up, even if it is
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wired. The following illustration shows the two ways to add more
terminals to the Build Array function.

1 2 1 2

CE - =3[ =+
Online Help -+ i ! =+
Description... I . =+ H
Show b o +[=
Replace [

Change to Arra
Add Array Input
Remove Input
Create Constant
Create Control

Create Indicator

Out-of-Range Index Values

Attempting to index an array beyond its bounds results in a default
value determined by the array element type.

Polymorphism for Array Functions

Most of the array functions accept n-dimensional arrays of any type,
however the wiring diagrams in the function descriptions show numeric
arrays as the default data type.

Array Function Descriptions

The following Array functions are available.

Array Max & Min

Searches for the first maximum and minimum values in numeric array. This function
also returns the indices where it finds the maximum and minimum values.

T ) max value

array E' max index [indices]
il R min v alue

min index [indices)
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The function compares each datatype according to the rules referred to in Chapter 9,
Comparison Functions.

Array Size
Returns the number of elements in each dimension of array.
array 1 zizefs]

Array Subset

Returns a portion of array starting at index and containing length elements.

array -Eler zub-array
indexi0) —fu.+

length —fw

i #

irude

Array To Cluster

Converts a 1D array to a cluster of elements of the same type as the array elements. Pop
up on the node to set the number of elements in the cluster. The default is nine. The
maximum cluster size for this function is 256.

array =], cluster

For more information on clusters, see Chapter 8, Cluster Functions.

Build Array

Appends any number of array or element inputs in top-to-bottom order to create array
with appended element.

array

array with appended element(s)

To change an element input to an array input, pop up on the input and select Change to
Array. In general, to build an array of n-dimensions, each array input must be of the
same dimension, n, and each element input must have n—1 dimensions. To create a 1D
array, connect scalar values to the element inputs and 1D arrays to the array inputs. To
build a 2D array, connect 1D arrays to element inputs and 2D arrays to the array inputs.

7-4 © MNational Instruments Corporation



Chapter 7 Array Functions

Cluster To Array
Converts a cluster of identically typed components to a 1D array of elements of the same
type.

cluster =], array

For more information on clusters, see Chapter 8, Cluster Functions.

Decimate 1D Array

Divides the elements of array into the output arrays.

array of elerents 0, n, Zn, ...

array array of elerents 1, n+l1, 2n+l, ..

Index Array

Returns the element of array at index. If array is multidimensional, you must add
additional index terminals for each dimension of the array.

n-dimension array p o elernent ar
index 0 ———m? sub-array

D T e :

In addition to extracting an element of the array, you can slice out a higher dimensional
component by disabling one or more of the index terminals.

Initialize Array

Creates an n-dimensional array in which every element is initialized to the value of

element.
e'lement:‘--b H |= initialized
dirnension size b _ n-dimension artay

imanion oixe |
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Interleave 1D Arrays

Interleaves corresponding elements from the input arrays into a single output array.

arrayd —
arrayl

interleawved array

ar'r"a:; r-i

Interpolate 1D Array

Uses the integer part of the fractional index of x to index the array and the fractional part
of fractional index of x to linearly interpolate between the values of the indexed element
and its adjacent element.

amray of numberz or points ot
- - .
fractional index or x * liters

ywvalue

Replace Array Element
Replaces the element in array at index with the new element.

new elerment
ey —{u-t

arrau | o ith new elernent
ratH |- array wi
o Hp

Reshape Array

Changes the dimension of an array according to the value of dimension size. For
example, you can use this function to change a 1D array into a 2D array or vice versa.
You can also use it to increase and decrease the size of a 1D array.

n—dirn array +\|:|_ r=dirn array
dimension size — w4

Reverse 1D Array

Reverses the order of the elements in array.

array {in.h] [M..5f reversed array
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Rotate 1D Array

Rotates the elements of array by the number of places and in the direction indicated by n.

n [Fooo] aray [lazt n elements first)
array

Search 1D Array

Searches for element in 1D array starting at start index.

1D amray [ooza] _
element — * L—' index of element
o' 1A=

start index (0] —

Sort 1D Array

Returns a sorted version of array with the elements arranged in ascending order. The
rules for comparing each datatype are described in Chapter 9, Comparison Functions.

array nﬁﬁrﬂ zorted aray

Split 1D Array

Divides array at index and returns the two portions.

amray I.'l...|i...N]| firzt zubarray
index T zecond subarray

Threshold 1D Array

Compares threshold y to the values in array of numbers or points starting at start
index until it finds a pair of consecutive elements such that threshold y is greater than
the value of the first element and less than or equal to the value of the second element.

The function then calculates the fractional distance between the first value and threshold
y and returns the fractional index at which threshold y would be placed within array of
numbers or points using linear interpolation.

array of numbers or points 1, ) )
threshold y — oty fractional index ar »
start indesw (0] — e
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For example, suppose array of numbers or points is an array of four numbers [4, 5, 5,
6], start index is 0, and threshold y is 5. The fractional index or x is 1, corresponding
to the index of the first value of 5 the function finds. Suppose the array elements are 6,
5,5,7, 6, 6, the start index is 0, and the threshold y is 6 or less. The output is 0. If
threshold y is greater than 7 for the same set of numbers, the output is 5. If threshold y
is 14.2, start index is 5, and the values in the array starting at index 5 are 9.1, 10.3, 12.9,
and 15.5, threshold y falls between elements 7 and 8 because 14.2 is midway between
12.9 and 15.5. The value for fractional index or x is 7.5, that is, halfway between 7 and
8.

If the array input consists of an array of points where each point is a cluster of x and y
coordinates, the output is the interpolated x value corresponding to the interpolated
position of threshold y rather than the fractional index of the array. If the interpolated
position of threshold y is midway between indices 4 and 5 of the array with x values of
—2.5 and 0 respectively, the output is not an index value of 4.5 as it would be for a
numeric array, but rather an x value of —1.25.

Transpose 2D Array

Rearranges the elements of 2D array such that 2D arrayl[i,j] becomes transposed
array|j,i].

2D amray — transposed aray
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Cluster Functions

This chapter describes the functions for cluster operations.

The following illustration shows the Cluster palette, which you access
by selecting Functions»Cluster.

i+ Functions

=5

| O] = [=AN [mem ey
£ EHE r%_"’:: lmm
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Some of the cluster functions are also available from the Cluster Tools
palette of most terminal or wire pop-up menus. The following
illustration shows the pop-up menu.

[
Cluster Tools P | et

]

— N
EmE] 1] [Tezme]
T dPit
[tem] [| [ [em]

If you select the functions from this palette, they appear with the correct
number of terminals to wire to the object on which you popped up.
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Cluster Function Overview

Some of the cluster functions have a variable number of terminals.
When you drop a new function of this kind, it appears on the block
diagram with only one or two terminals. You can add and remove
terminals by using the pop-up menu Add Input or Remove Input
options or by resizing the node using the Positioning tool. If you want
to add terminals by popping up, you must place your cursor on the input
terminal to access the pop-up menu.

You can shrink the node if doing so does not delete wired terminals. The
Add Input option inserts a terminal directly after the one on which you
popped up. The Remove Input option removes the terminal on which
you popped up, even if it is wired.

The following illustration shows the two ways to add more terminals to
the Bundle function.

o
—

|_:Eli]nline Help :+ ’iﬁ;—’i

Description...
Show [
Replace ]

¥

[T ™

Add Input &

Remove Input
Create Constant
Create Control
Create Indicator

Polymorphism for Cluster Functions

The Bundle and Unbundle functions do not show the datatype for their
individual input or output terminals until you wire objects to these
terminals. When you wire them, these terminals look similar to the
datatypes of the corresponding front panel control or indicator
terminals.
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Setting the Order of Cluster Elements

Cluster elements have a logical order that is unrelated to their positions
within the shell. The first object you insert in the cluster is element 0,
the second is 1, and so on. If you delete an element, the order adjusts
automatically. You can change the current order by selecting the
Cluster Order... option from the cluster pop-up menu.

Clicking on an element with the cluster order cursor sets the elements
place in the cluster order to the number displayed inside the Tools
palette. You change this order by typing a new number into that field.
When the order is as you want it, click on the Enter button to set it and
exit the cluster order edit mode. Click on the X button to revert to the
old order.

The cluster order determines the order in which the elements appear as
terminals on the Bundle and Unbundle functions in the block diagram.

The Bundle By Name and Unbundle By Name functions give you more
flexible access to data in clusters. With these functions, you can access
specific elements in clusters by name and access only the elements you
want to access. Because these functions reference components by name
and not by cluster position, you can change the data structure of a
cluster without breaking wires, as long as you do not change the name
of or remove the component you reference on the block diagram.

Cluster Function Descriptions

The following cluster functions are available.

Array To Cluster

Converts a 1D array to a cluster of elements of the same type as the array elements. Pop
up on the node or resize it to set the number of elements in the cluster. The default is nine.
The maximum cluster size for this function is 256.

array [1E cluzter

Build Cluster Array

Assembles all the component inputs in top-down order into an array of clusters of that
component. If the input is four, single-precision, floating-point components, the output
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is a four-element array of clusters containing one single-precision, floating-point
number. Element O of the array has the value of the top component, and so on.

carnponent

companent At ay of clusters of cormponent

Bundle

Assembles all the individual input components into a single cluster.
cluster
l:nmpnnent%m
cornponernt cluster
Bundle By Name

Replaces components in an existing cluster. After you wire the node to a cluster, you
pop-up on the name terminals to choose from the list of components of the cluster.

cluster
component 1 —ame 1
cluster
component 2 ——name 2

You must always wire the cluster input. If you are creating a cluster for a cluster
indicator, you can wire a local variable of that indicator to the cluster input. If you are
creating a cluster for a cluster control of a subVI, you can place a copy of that control
(possibly hidden) on the front panel of the VI and wire the control to the cluster input.

Cluster To Array
Converts a cluster of identically typed components to a 1D array of elements of the same
type.

cluster =14] array
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Index & Bundle Cluster Array
Indexes a set of arrays and creates a cluster array in which the ith element contains the
ith element of each input array.

array of Zedmy] =2
array of Y=+ @EEms array of cluster of (x,y, 2)
array of ==+

This function is equivalent to the following block diagram and is useful for converting a
cluster of arrays to an array of clusters.

Unbundle

Disassembles a cluster into its individual components.

cornponent
I:]"'Et'E'rI““‘EBZGu:um|:u:unent

Unbundle By Name
Returns the cluster elements whose names you specify. You select the element you want
to access by popping up on the name output terminals and selecting a name from the list
of elements in the cluster.

cornponent 1

. [narme 1

cluster

" |namme 2 cornponent 2
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This chapter describes the functions that perform comparisons or
conditional tests.

The following illustration shows the Comparison palette, which you
access by selecting Functions»Comparison.

if+ Functions |

Comparison
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For examples of comparison functions, see
examples\general\struct.1llb.

Comparison Function Overview

This section introduces the Comparison functions.
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Compare Boolean

Compare Strings

Compare Clusters

Compare Modes

For the Compare Boolean functions, the Boolean value TRUE is greater
than the Boolean value FALSE.

These functions compare strings according to the numerical equivalent
of the ASCII characters. Thus, a (with a decimal value of 97) is greater
than A (65), which is greater than the numeral 0 (48), which is greater
than the space character (32). These functions compare characters one
by one from the beginning of the string until an inequality occurs, at
which time the comparison ends. For example, LabVIEW evaluates the
strings abcd and abef until it finds ¢, which is greater than the value of
e. The presence of a character is greater than the absence of one. Thus,
the string abcd is greater than abc because the first string is longer.
Most of the comparison functions test one input or compare two inputs
and return a Boolean value. The functions convert numbers to the same
representation before comparing them. Comparisons with a value of
NaN (not a number) return a value that indicates inequality.

The functions that test the category of a string character (for example,
the Decimal Digit? and Printable? functions) evaluate only the first
character of the string.

The comparison functions compare clusters the same way they compare
strings, one element at a time starting with the Oth element until an
inequality occurs. Clusters must have the same number of elements, of
the same type, and in the same order if you want to compare them.

Some of the comparison functions have two modes for comparing
arrays or clusters. In the Compare Aggregates mode, if you compare
two arrays or clusters, the function returns a single value. In the
Compare Elements mode, the function compares the elements
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Chapter 9

following illustration shows the two modes.

You change the comparison mode by selecting Compare Elements or
Compare Aggregates in the pop-up menu for the node, as shown in the

E:xt Array 1 e Arragg Eiua]?
ext]] —l%
Ext Artay 2 Elernent By Elernent Equality

=

[TF]

following illustrations.

When you compare two arrays of unequal lengths in the Compare
Elements mode, LabVIEW ignores each element in the larger array
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Ext Array 1 Are .ﬁ.rrags Eaual?
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Description...
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Create Control
Create Indicator
Compare Aggregates .
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L= -l Online Help
Description...
Show 4
Replace 4
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Create Control
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whose index is greater than the index of the last element in the smaller
array.

When you use the Compare Aggregates mode to compare two arrays,
the following occurs: (1) LabVIEW searches for the first set of
corresponding elements in the two inputs that differ, and uses those to
determine the results of the comparison. (2) If all elements are identical
except that one has more elements, LabVIEW considers the longer
array to be greater than the shorter array. (3) If no elements of the two
arrays differ, and the arrays have the same length, the arrays are equal.
Thus, LabVIEW considers the array [1,2,3] to be greater than the array
[1,2] and returns a single Boolean value in the Compare Aggregates
mode.

When comparing clusters using the Compare Aggregates mode,
LabVIEW goes by cluster order instead of array order. The two clusters
LabVIEW compares are always the same length.

In the Compare Elements mode, LabVIEW returns a Boolean for each
of the first two elements and ignores the last element of the larger array,
as in the preceding example.

Arrays must have the same dimension size (for example, both
two-dimensional), and for the comparison between multidimensional
arrays to make sense, each dimension must have the same size.

The comparison functions that do not have the Compare Aggregates or
Compare Elements modes compare arrays in the same manner as
strings—one element at a time starting with the Oth element until an
inequality occurs.

Character Comparison

You can use the functions that compare characters to determine a
character’s type. The following functions are character comparison
functions.

e Decimal Digit?
e Hex Digit?

* Lexical Class

¢ Octal Digit?

e Printable?

e White Space?
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If the input is a string, the functions test the first character. If the input
is an empty string, the result is FALSE. If the input is a number, the
functions interpret it as a code for an ASCII character.

See Appendix B, Multiline Interface Messages, for the numbers that
correspond to each character.

Polymorphism for Comparison Functions

The functions Equal?, Not Equal?, and Select take inputs of any type,
as long as the inputs are the same type.

The functions Greater or Equal?, Less or Equal?, Less?, Greater?,
Max & Min, and In Range? take inputs of any type except complex,
path, or refnum, as long as the inputs are the same type. You can
compare numbers, strings, Booleans, arrays of strings, clusters of
numbers, clusters of strings, and so on. You cannot, however, compare
a number to a string or a string to a Boolean, and so on.

The functions that compare values to zero accept numeric scalars,
clusters, and arrays of numbers. These functions output Boolean values
in the same data structure as the input.

The Not A Number/Path/Refnum function accepts the same input types
as functions that compare values to zero. This function also accepts
paths and refnums. Not A Number/Path/Refnum outputs Boolean
values in corresponding structures. See Chapter 30, Introduction to
LabVIEW Instrument Driver VIs, and Chapter 11, File Functions, for
more information on these functions.

The functions Decimal Digit?, Hex Digit?, Octal Digit?, Printable?, and
White Space? accept a scalar string or number input, clusters of strings
or non-complex numbers, arrays of strings or non-complex numbers,
and so on. The output consists of Boolean values in the same data
structure as the input.

The function Empty String/Path? accepts a path, a scalar string, clusters
of strings, arrays of strings, and so on. The output consists of Boolean
values in the same data structure as the input.

You can use the Equal?, Not Equal?, Not A Number/Path/Refnum?,
Empty String/Path?, and Select functions with paths and refnums, but
no other comparison functions accept paths or refnums as inputs.
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Comparison functions that use arrays and clusters normally produce
Boolean arrays and clusters of the same structure. You can pop-up and
change to compare aggregates, in which case the function outputs a
single Boolean value. The function compares aggregates by comparing
the first set of elements to produce the output, unless the first elements
are equal, in which case the function compares the second set of
elements, and so on.

Comparison Function Descriptions

The following Comparison functions are available.

Decimal Digit?
Returns TRUE if char is a decimal digit ranging from 0 through 9. Otherwise, this
function returns FALSE.

char e digit?
Empty String/Path?
Returns TRUE if string/path is an empty string or path. Otherwise, this function returns
FALSE.
string/path E_’__% empty?
Equal?

Returns TRUE if x is equal to y. Otherwise, this function returns FALSE.

Equal To 0?
Returns TRUE if x is equal to 0. Otherwise, this function returns FALSE.

X I@ w=07
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Greater?
Returns TRUE if x is greater than y. Otherwise, this function returns FALSE.

Greater Or Equal?
Returns TRUE if x is greater than or equal to y. Otherwise, this function returns FALSE.

Greater Or Equal To 0?

Returns TRUE if x is greater than or equal to 0. Otherwise, this function returns FALSE.

Greater Than 0?
Returns TRUE if x is greater than 0. Otherwise, this function returns FALSE.

X @ w07

Hex Digit?
Returns TRUE if char is a hex digit ranging from O through 9, A through F, or a through
f. Otherwise, this function returns FALSE.

char rfl_f? e

n Range?
Returns TRUE if x is greater than or equal to lo and less than hi. Otherwise, this function

returns FALSE.
h-_.: .................. lo<=w < hi?
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Note: This function always operates in the Compare Aggregates mode. To
produce a Boolean array as an output, you must execute this function in a
loop structure.

Less?
Returns TRUE if x is less than y. Otherwise, this function returns FALSE.

Less Or Equal?
Returns TRUE if x is less than or equal to y. Otherwise, this function returns FALSE.

Less Or Equal To 0?

Returns TRUE if x is less than or equal to 0. Otherwise, this function returns FALSE.

X @ we=07

Less Than 0?
Returns TRUE if x is less than 0. Otherwise, this function returns FALSE.
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Lexical Class
Returns the class number for char.

char & class number

Table 9-1. Lexical Class Number Descriptions

Class Number Lexical Class
0 Extended characters with a Command- or Option- key prefix (codes 128
through 255)
1 Nondisplayable ASCII characters (codes 0 to 31 excluding 9 through 13)
2 White space characters: Space, Tab, Carriage Return, Form Feed,

Newline, and Vertical Tab (codes 32, 9, 13, 12, 10, and 11, respectively)

3 Digits 0 through 9

4 Uppercase characters A through Z

5 Lowercase characters a through z

6 All printable ASCII nonalphanumeric characters
Max & Min

Compares x and y and returns the larger value at the top output terminal and the smaller
value at the bottom output terminal.

%} e, 4]

X [EER NERERY!
y

Not A Number/Path/Refnum?

Returns TRUE if number/path/refnum is not a numeric value, path, or refnum.
Otherwise, this function returns FALSE. NaN can be the result of dividing by 0, the
square root of a negative number, and so on.

number/path/frefnum [[2/??} MaM /Path/Refrum?
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Not Equal?
Returns TRUE if x is not equal to y. Otherwise, this function returns FALSE.

Not Equal To 0?

Returns TRUE if x is not equal to 0. Otherwise, this function returns FALSE.

x fe- 4= 07

Octal Digit?
Returns TRUE if char is an octal digit ranging from 0 through 7. Otherwise, this function
returns FALSE.

char % octal?

Printable?

Returns TRUE if char is a printable ASCII character. Otherwise, this function returns
FALSE.

char printable A5CI7

v

Select

Returns the value connected to the t input or f input, depending on the value of s. If s is
TRUE, this function returns the value connected to t. If s is FALSE, this function returns

the value connected to f.
i
g % 7 Ef
F—
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Returns TRUE if char is a white space character, such as space, Tab, Newline, Carriage
Return, Form Feed, or Vertical Tab. Otherwise, the function returns FALSE.

© National Instruments Corporation

char

3

|uis

zpace, hdv tab, cr, IF, ff?
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Time, Dialog, and
Error Functions

This chapter describes the timing functions, which you can use to get
the current time, measure elapsed time, or suspend an operation for a
specific period of time. Error Handling also is covered in this chapter.

The following illustration shows the Time & Dialog palette, which you
access by selecting Functions»Time & Dialog.

i Functions |
Time & Dialog
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For examples of time and dialog functions, see
examples\general\viopts.llb.

Time, Dialog, and Error Functions Overview

This section introduces the Timing, Dialog, and Error Functions.
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Timing Functions

The Date/Time To Seconds and the Seconds To Date/Time functions
have a parameter called date time rec, which is a cluster that consists
of signed 32-bit integers in the following order.

Table 10-1. Order of 32-bit Integers in TIming Functions

Time Value and Range

0 | (second) 0to 59

1 | (minute) 0to 59

2 | (hour) 0to23

3 | (day of month)| 1 to 31 as output from the function;1 to 366 as

input
4 | (month) 1to 12
5| (year) 1904 to 2040

6 | (day of week) 1 to 7 (Sunday to Saturday)

7 | (day of year) 1 to 366

8 | (DST) 0to 1 (O for Standard Time, 1 for Daylight
Savings Time)

The Wait (ms) and Wait Until Next ms Multiple functions make
asynchronous system calls, but the nodes themselves function
synchronously. That is, they do not complete execution until the
specified time has elapsed. The functions use asynchronous calls so that
other nodes can execute while the timing nodes wait.

Note: National Instruments can only guarantee correct time values across all
platforms for the range 2082844800 to 4230328447 seconds or 12:00 a.m.,
Jan. 1, 1970, Universal Time to 3:14 a.m., Jan. 19, 2038, Universal Time.

Error Handling Overview

Every time you design a program, you should consider the possibility
that something can go wrong and, if it does, you should consider how
your program should manage the problem. LabVIEW automatically
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notifies you with a dialog box only when a few run-time errors occur,
mostly for file dialog operations. It does not report all errors. If it were
to report all errors, you would lose the flexibility to determine what to
do when an error occurs and how and when to inform the user of the
error in your program.

Rigorous error checking, especially for I/O operations (file, serial,
GPIB, data acquisition, and communication), is invaluable in all phases
of a project. This section describes three I/O situations in which errors
can occur.

The first error can occur when you have initialized your
communications incorrectly or have written improper data to your
external device. This type of problem usually occurs during program
development and disappears once you finish debugging your program.
However, you can spend a lot of time tracking down a simple
programming mistake because you have not incorporated error checks.
Without error checks, all you know is that your program does not work.
You do not know why the error occurred or where it is.

The second type of error can occur because your external device may be
powered off, broken down, or otherwise unable to do what it normally
does. This type of problem can occur at any time, but if you have
incorporated error checking, your program notifies you immediately
when such operational failures occur.

The third kind of error can occur when you upgrade LabVIEW or your
operating system software, and you notice a bug in either a G program
or a system program. This type of error means you should check errors
that you may have felt safe ignoring, such as those from functions that
close files or clear DAQ operations. The bottom line is, check all I/O
operations for errors.

It may feel easier to ignore error checking when you have to add error
handling code to test and report errors. The VIs described here are
designed to make it easier for you to create programs with error
checking and handling.

G functions and library VIs return errors in one of two ways—with
numeric error codes or with an error state cluster. Typically, functions
output error codes while VIs incorporate the error cluster, usually
within a framework called error input/output or error 1/0.
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Error I/0 and the Error State Cluster

The concept of error I/0 is natural to the G dataflow architecture. If data
information can flow from one node to another, so can error state
information. Each node that needs to know about errors tests the
incoming error state and responds appropriately. If no error exists, the
node executes normally. If an error does exist, the node detects an error,
skips execution, and then passes its error state out to the next node,
which responds in the same way. In this fashion, notice of the first error
that occurs in a sequence of operations is passed through all the nodes,
with each node responding to the error. At the end of the flow, your
program reports the error to the user.

Error I/0 has an additional benefit—you can use it to control the
execution order of independent operations. While you can use the DAQ
taskID to control the order of DAQ operations for one group, you
cannot use it to control the order for multiple groups. The DAQ taskID
does not work with other types of I/O operations such as file operations.

The following diagram from the File Utility VI, Read Characters
From File, shows how error I/O is implemented in a simple VI.

{F==1| [new file path (Not&Path if canceTled)]

w-{ character string

|cc-nt1'nue or stop ressage on an erru:-r|

Read File+ (string).vi General Error Handler i
]
C

refrum i‘abc
=\ R féﬂ '

||:-r-:-mpt|II3h-:u:-59 file to read.

[fite path (dialog if ernpty]]

Ho
srrer Close Filet vi
o5 mode (rel. to begind] ) [mark after read fchars.]|
[start of read affzet (chars.: 0] |22 ] :

filq zize

The operation starts at Open File+.vi. If it opens the file
successfully, Read File+ (string) .vi reads the file and Close
File+.vi closes the file. If you pass in an invalid path, Open
File+.vi detects the error and passes the error state through the other
two VIs to the General Error Handler, which reports it. Notice that the
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only presence of error handling on this block diagram is the error wire
and the General Error Handler. It is neither cumbersome nor distracting.

The error state consists of three pieces of information, which are
combined into the error cluster. The status is a Boolean value—TRUE
if an error exists, FALSE if it does not. The code consists of an unsigned
32-bit integer that identifies the error. In some cases, a non-zero error
code coupled with a FALSE error status signals a warning rather than
a fatal error. For example, a DAQ timeout event (code 10800) is
typically reported as a warning. The source consists of a string that
identifies where the error occurred.

The error in and error out state clusters for the Open File+ VI, where
the error shown in the preceding example originated, are shown in the
following illustration. The error in cluster, whose default value is no

error does not need to be wired if it is the first in the chain.

Errar in [hao errar] error out

ghatus code ghatis code
no errar I ﬂ ] o errar I ]

FOLIGE FOLMCE

] J

You can find the error in and error out clusters by selecting
Controls»Array & Cluster on the front panel.
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The following illustration shows the message you receive from the
General Error Handler if you pass in an invalid path.

Untitled 2.

Possible reasons:
LablMELW: File not found.
GPIB ENEB: Non-existent board.

“
- 3

General Error Handler is one of the three error handling utility VIs. It
contains a database of error codes and descriptions, from which it
creates messages like the previous one. The Simple Error Handler
performs the same basic operation but has fewer options. The third VI,
Find First Error, creates the error I/0 cluster from functions or VIs that
output only scalar error codes.

Time and Dialog Function Descriptions

The following Time and Dialog functions are available.

Date/Time To Seconds

Converts a cluster of nine, signed 32-bit integers assumed to specify the local time
(second, minute, hour, day, month, year, day of the week, day of the year, and Standard
or Daylight Savings Time) in the configured time zone for your computer into a
time-zone-independent number of seconds that have elapsed since 12:00 a.m., Friday,
January 1, 1904, Universal Time.

date time rec secands

If the year and month integers are out of range, the results are unpredictable. G ignores
the day of the week and day of the year integers. The other five integers can be any value.
Thus, you can specify Julian dates by setting the month to January and the current day to
the day of the year. For example, use January 150 for the 150th day of the year.
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Get Date/Time In Seconds

Returns a time-zone-independent number that contains the number of seconds that have
elapsed since 12:00 a.m., Friday, January 1, 1904, Universal Time.

seconds zince 1Jan1304

Get Date/Time String

Converts a time-zone-independent number assumed to be the number of seconds that
have elapsed since 12:00 a.m., Friday, January 1, 1904, Universal Time, to a date and
time string in the configured time zone for your computer.

date format [1) ——+ GEg date shing
H
seconds [how) ———— 2. e time string

want zeconds? [F) -

One Button Dialog Box

Displays a dialog box that contains a message and a single button. The button name is
the name displayed on the dialog box button.

message E=......... _—
buttan name ['OE!") e T2

Seconds To Date/Time

Converts a time-zone-independent number assumed to be the number of seconds that
have elapsed since 12:00 a.m., Friday, January 1, 1904, Universal Time, to a cluster of
nine, signed 32-bit integers that specify (second, minute, hour, day of the month, number
of month (1-12), year, day of the week, day of the year, and Standard or Daylight Savings
Time) in the configured time zone for your computer.

geconds [how] gm date time rec
Tick Count (ms)

Returns the value of the millisecond timer. The base reference time (millisecond zero) is
undefined; that is, you cannot convert millisecond timer value to a real-world time or
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date. Be careful when you use this function in comparisons, because the value of the
millisecond timer wraps from 2321 to 0.

millizecond timer walue

Two Button Dialog Box

Displays a dialog box that contains a message and two buttons. T button name and F
button name are the names displayed on the buttons of the dialog box.

message =
T button name 0K --""""""‘m"' """"""""" T button™?

F button name ["'Cancel =T

Wait (ms)
Waits the specified number of milliseconds and then returns the value of the millisecond
timer.

milhizeconds to wait milizecond timer value

Wait Until Next ms Multiple

Waits until the value of the millisecond timer becomes a multiple of the specified
millisecond multiple. You can use this function to synchronize activities. You can call
this function in a loop to control the loop execution rate. However, it is possible that the
first loop period may be short.

millizecond multiple millizecond timer value

Error Handling VI Descriptions

The following Error Handling VIs are available.
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Find First Error

Tests the error status of one or more low-level functions or subVIs that output a numeric
error code.

Firud 2
Eror codes find EIror
ermar in [ho erar) Errar errar oLt

IOUNCE Mezzages

If this VI finds an error, it sets the parameters in the error out cluster. You can wire this
cluster to the Simple or General Error Handler to identify the error and describe it to the
user.

Find First Error Example

The following illustration shows how you can use Find First Error in the example VI
Write Binary File. Find First Error creates the error cluster from individual error
numbers, and Simple Error Handler reports any errors to the user.

ermit read, deny write|

IEnter Fi]ename}l

Pwiite File|  [Close File
CLOSE
iy e ===

Find First Error vi| [Simple Error Handler wi

Fird
First
Error

-+

1

-+
=0

I

-+

Array of DEL

Write Binary File :Mew File
write Binary File write File
‘write Binary File :Close File
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General Error Handler
Determines whether an error has occurred. If an error occurred, this VI creates a
description of the error and optionally displays a dialog box.

[uzer-defined descriptions] weesessssecag
[uzer-defined codes]
[emar code] (0] T o eror’?
I

[errar zource] [~ 4 L code out
type of dialog [(OF meg:1] fw% FOUMCE out
error in [no ermor| E meszage
[Exwception action] [nome: 0] 2rror oLt
[exception code]
[exception zounze]

Simple Error Handler
Determines whether an error occurred. If it finds an error, this VI creates a description of
the error and optionally displays a dialog box.

ermor code [ho error0) P errar”

eror gource [~ Ky L code out

twpe of dialog _[EIK mzd:1] fl\zf/l% goLrce oLt
&rmar in [ho erar) errar oLk

Message

Simple Error Handler calls General Error Handler and has the same basic functionality
as General Error Handler, but with fewer options.
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File Functions

This topic describes the low-level functions that manipulate files and
directories. This topic also describes file constants and the high-level
file VlIs.

You access these functions, constants, and VIs by selecting
Functions»File 1/0.

B Functions B4 |
File 170

B
k
k

w
w

[=]=]
=
< EE

Instr Likp

3
i [—]
'.':E}'? Y= .
lﬁi «—{HFile 1/0
BENE MEa
di i 2
S fabety
it Mm-S g
==
o

o B P Al
[ N
%.ltl]

The File I/O palette includes the following subpalettes:

¢ Advanced File Functions
e Binary File VIs

¢ File Constants

For examples of File functions and VlIs, see examples\file.

© National Instruments Corporation 11-1 LabVIEW Function and VI Reference Manual



Chapter 11 File Functions

File /0 VI and Function Overview

This section introduces the high-level and low-level File VIs, and the
File functions.

High-Level Vis

You can use the high-level File VIs to write or read the following types
of data:

e Strings to text files

*  One-dimensional (1D) or two-dimensional (2D) arrays of
single-precision numbers to spreadsheet text files.

* 1D or 2D arrays of single-precision or signed word integers to byte
stream files.

The high-level File VIs described here call the low-level functions to
perform complete, easy-to-use file operations. These VIs open or create
a file, write or read to it, and close it. If an error occurs, these VIs
display a dialog box that describes the problem and gives you the option
to halt execution or to continue.

The high-level File VIs are located on the top row of the palette and
consist of the following VIs:

*  Write Characters to File

*  Write to Spreadsheet File

* Read Characters from File
* Read from Spreadsheet File
¢ Read Lines from File

* Binary File VIs—Ilocated in the subpalette.

Low-Level File Vis and File Functions

The low-level File functions perform one file operation at a time. These
VIs and functions perform error detection in addition to their other
functions. The most commonly used low-level file functions and VIs
are located on the second row of the palette. The remaining low-level
functions are located in the Advanced File Functions subpalette.

The principal low-level file operations involve a three-step process.
First, you create or open a file. Then you write data to the file or read
data from the file. Finally, you close the file. Other file operations
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include creating directories; moving, copying, or deleting files; flushing
files; listing directory contents; changing file characteristics; and
manipulating paths.

When creating or opening a file, you must specify its location. Different
computers describe the location of files in different ways, but most
computer systems use a hierarchical system to specify the location of
files. In a hierarchical file system, the computer system superimposes a
hierarchy on the storage media. You can store files inside directories,
which can contain other directories.

When you specify a file or directory in a hierarchical file system, you
must indicate the name of the file or directory, as well as its location in
the hierarchy. In addition, some file systems support the connection of
multiple discrete media, called volumes. For example, Windows
systems support multiple drives connected to a system; for most of
these systems, you must include the name of the volume to create a
complete specification for the location of a file. On other systems, such
as UNIX, you do not need to specify the storage media locations for
files because the operating system hides the physical implementation of
the file system from you.

The method of identifying the target of a file function varies depending
on whether the target is an open file. If the target is not an open file, or
if it is a directory, you specify a target using the path of the target. The
path describes the volume containing the target, the directories between
the top-level and the target, and the name of the target. If the target is
an open file, you use a file refnum to identify the file that G is supposed
to manipulate. The file refnum is an identifier that G associates with the
file when you open it. When you close the file, the file manager
dissociates the file refnum from the file. In other words, the refnum is
obsolete once the file is closed.

See, Strings and File I/0, Chapter 6 of the Tutorial Manual, and Path
Controls and Refnum in that section for more information on path
specification in G and for file function examples.

Byte Stream and Datalog Files

G can make and access two types of files—byte stream and
datalog files.

A byte stream file, as the name implies, is a file whose fundamental unit
is a byte. A byte stream file can contain anything from a homogeneous
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set of one G datatype to an arbitrary collection of datatypes—
characters, numbers, Booleans, arrays, strings, clusters, and so on. An
ASCII text file, a file containing this paragraph, for example, is perhaps
the simplest byte stream file. A similar byte stream file is a basic
spreadsheet text file, which consists of rows of ASCII numbers, with
the numbers separated by tabs and the rows separated by

carriage returns.

Another simple byte stream file is an array of binary 16-bit integers or
single-precision, floating point numbers, which you acquire from a data
acquisition (DAQ) program. A more complicated byte stream file is one
in which an array of binary 16-bit integers or single-precision, floating
point numbers is preceded by a header of ASCII text that describes how
and when you acquired the data. That header could alternatively be a
cluster of acquisition parameters, such as arrays of channels and scale
factors, the scan rate, and so forth.

An Excel worksheet file, as opposed to an Excel text file, is also a more
complicated form of byte stream file because it contains text
interspersed with Excel-specific formatting data that does not make
sense when you read it as text. In summary, you can make a byte stream
file that consists of one each of all of G datatypes. Byte stream files can
be created using high-level VIs and low-level functions.

A datalog file, on the other hand, consists of a sequence of
identically-structured records. Like byte stream files, the components
of a datalog record can be any G datatype. The difference is that all the
datalog records must be the same type. Datalog files can only be created
using low-level file functions.

You write a byte stream file typically by appending new strings,
numbers, or arrays of numbers of any length to the file. You can also
overwrite data anywhere within the file. You write a datalog file by
appending one record at a time. You cannot overwrite the record.

You read a byte stream file by specifying the byte offset or index and
the number of instances of the specified byte stream type you want to
read. Youread a datalog file by specifying the record offset or index and
the number of records you want to read.

You use byte stream files typically for text or spreadsheet data that
other applications may need to read. You can use byte stream files to
record continuously acquired data that you need to read sequentially or
randomly in arbitrary amounts. You use datalog files typically to record
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multiple test results or waveforms that you read one at a time and treat
individually. Datalog files are difficult to read from non-G applications.

Flow-Through Parameters

Many file functions contain flow-through parameters, which return the
same value as an input parameter. You can use these parameters to
control the execution order of the functions. By wiring the flow-through
output of the first node you want to execute to the corresponding input
of the next node you want to execute, you create artificial data
dependency. Without these flow-through parameters, you would often
have to use Sequence structures to ensure that file I/O operations take
place in the correct order.

Error 1/0 in File 1/0 Functions

G uses error I/O clusters, consisting of error in and error out, in all of
its file I/O functions. With error I/O clusters you can string together
several functions. When an error occurs in a function, that function
passes the error along to the next function. When the error passes to
subsequent functions, the subsequent function does not execute and
passes the error along to the following function, and so on. The
following illustration displays an example of the error in and error out
clusters.

[pattern]

prompt

file path

start path (Mot A Path)
function (open:0)
error in (not an error)
default name

advisory dialog? [display :T)

refnum

new file path
file size (bytes)
error out

Although the error I/0O clusters specify whether an error has occurred,
you may want to use error handlers to report the error to the user. For
more information on error I/O, see Chapter 10, Time, Dialog, and
Error Functions, in this manual.

Permissions
Some of the File Functions have a 32-bit integer parameter called
permissions or new permissions. G uses only the least significant nine
bits of the 32-bit integer to determine file and directory access
permissions.
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(Windows) G ignores the permissions for directories. For files, only bit 7
(the UNIX user write permission bit) is used. If this bit is clear, the file
is read-only. Otherwise, you can write to the file.

(Macintosh) G uses all 9 bits of permissions for directories. The bits
which control read, write, and execute permissions, respectively, on a
UNIX system are used to control See Files, Make Changes, and See
Folders access rights, respectively, on the Macintosh. For files, only bit
7 (the UNIX user write permission bit) is used. If this bit is clear, the
file is locked. Otherwise, the file is not locked.

(UNIX) The nine bits of permissions correspond exactly to nine UNIX
permission bits governing read, write, and execute permissions for
users, groups, and others. The following illustration shows the
permission bits on a UNIX system.

user group others

pekFmission FWwREWRE WY

bit 31 BFEI4 3210

t - read permission
W - write permission
¥ - erecUte permission

File /0 Function and VI Descriptions

Build Path

Creates a new path by appending a name (or relative path) to an existing path.

Close File

Writes all buffers of the file identified by refnum to disk, updates the directory entry of
the file, closes the file, and voids refnum for subsequent file operations.

The following functions and VIs are available from the File I/O palette.

baze path m:c
name or relative path

appended path

refnum path
errar in o error aut
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Note: Error 1/0 functions uniquely in the Close File function, which closes
regardless of whether an error occurred in a preceding operation, insuring
that files are closed correctly.

Open/Create/Replace File

Opens an existing file, creates a new file, or replaces an existing file, programmatically
or interactively using a file dialog box. You can optionally specify a dialog prompt,
default file name, start path, or filter pattern. Use this VI with the intermediate Write
File or Read File functions.

[pattern]

prompt

file path

start path (Mot & Fath)
function (open:0)
error in (not an error)
default narne

adwvisory dialog? (display :T)

refnum

new file path
file zize (bytes)
error out

Read Characters From File

Reads a specified number of characters from a byte stream file beginning at a specified
character offset. The VI opens the file before reading from it and closes it afterwards.

file path (dialog if empty) { fabe.. new file path (Mot &Path if ...
number of characters (all:-1) """"""hcharacter string

ztart of read offzet (chars... I —rark after read (chars.)

Read File

Reads data from the file specified by refnum and returns it in data. Reading begins at a
location specified by pos mode and pos offset and depends on the format of the specified
file.

corvert el [F]
lire miode [F]
refnum

pos made [0:2] =
poz offset [0] f

21101 I

caunt
bwte stream tvpe

dup refrum
data

offzet

errar ouk
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Reading Byte Stream Files

If refnum is a byte stream file refnum, the Read File function reads data from the byte
stream file specified by refnum. You can wire either line mode or byte stream type
when you read byte stream files, but you cannot wire both. If you do not wire byte stream
type, Read File assumes the data that begins at the designated byte offset is a string of
characters. If you wire byte stream type, the function interprets data starting at the
designated byte offset to be count instances of that type. Following the read operation,
the function sets the file mark to the byte following the last byte read. If the function
encounters end of file before reading all of the requested data, it returns as many whole
instances of the designated byte stream type as it finds.

Reading Characters

To read characters from a byte stream file (typically a text file) do not wire the byte
stream type. The following paragraphs describe the manner in which the line mode,
count, convert eol, and data parameters function when reading from a byte stream file.

line mode, in conjunction with count, determines when the read stops.

If line mode is TRUE, and if you do not wire count or count equals 0, Read File reads
until it encounters an end of line marker—a carriage return, a line feed, or a carriage
return followed by a line feed, or it encounters end of file. If line mode is TRUE, and
count is greater than 0, Read File reads until it encounters an end of line marker, it
encounters end of file, or it reads count characters.

If line mode is FALSE, Read File reads count characters. In this case, if you do not wire
count, it defaults to 0. line mode defaults to FALSE.

convert eol (F) determines whether the function converts the end of line markers it reads
into G end of line markers. The system-specific end of line marker is a carriage return
followed by a line feed on Windows, a carriage return on Macintosh, and a line feed on
UNIX. The G end of line marker is a line feed.

If convert eol is TRUE, the function converts all end of line markers it encounters into
line feeds. If convert eol is FALSE, the function does not convert the end of line markers
it reads. convert eol defaults to FALSE.

data is the string of characters read from the file.

Reading Binary Data

To read binary data from a byte stream file, wire the type of the data to byte stream type.
In this case, count, and data function in the manner described in the following
paragraphs, and you do not have to wire line mode or convert eol.
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byte stream type can be any datatype. Read File interprets the data starting at the
designated byte offset to be count instances of that type. If the type is variable-length,
that is, an array, a string, or a cluster containing an array or string, the function assumes
that each instance of the type contains the length or dimensions of that instance. If they
do not, the function misinterprets the data. If G determines that the data does not match
the type, it sets the value of data to the default value for its type and returns an error.

count is the number of instances of the byte stream type to read. If count is unwired,
the function returns a single instance of the byte stream type.

If you wire count, it can be a scalar number, in which case the function returns a 1-D
array of instances of the byte stream type. Or it can be a cluster of N scalar numbers, in
which case the function returns an N-dimension array of instances of the byte stream

type.

If the wired count is a scalar number and the byte stream type is something other than
an array, the function returns that number of instances in a 1D array. For example, if the
type is a single-precision, floating point number, the function returns an array of three,
single-precision, floating point numbers. However, if the type is an array, the function
returns the instances in a cluster array, because G does not have arrays of arrays.
Therefore, if the type is an array of single-precision, floating point numbers and count
is 3, the function returns a cluster array of three, single-precision, floating point number
arrays.

If the wired count is a cluster of N numbers, the function returns an N-dimension array
of instances of the type. The size of each dimension is the value of the corresponding
number according to its cluster order. The number of instances returned in this manner is
the product of the N numbers. Thus, you can return 20, single-precision, floating point
numbers as a 2D array of two columns and ten rows by wiring a two-element cluster with
element 0 = 2 and element 1 = 10 to count.

data contains the data read from the file. Refer to the previous description of count for
an explanation of the structures data can have.

Reading Datalog Files

If refnum is a datalog file refnum, the Read File function reads records from the datalog
file specified by refnum. If the data in the file does not match the datatype associated
with the datalog file, this function returns an error.

The number of records read can be less than specified by count if this function encounters
the end of the file. The function sets the file mark to the record following the last record
read. (You should never encounter a partial record; if you do, the file is corrupt.)
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Do not wire convert eol, line mode, and byte stream type. They do not pertain to
datalog files. The count and data parameters function in the following manner.

count is the number of records to read and may be wired or unwired. If you do not wire
count, the function returns a single record of the datalog type specified when the file is
created or opened. For example, if the type is a 16-bit integer, the function returns one
16-bit integer. If the type is an array of 16-bit integers, the functions returns one array of
16-bit integers. (Your records typically consist of clusters of diverse elements, but the
rules for simple types used in these examples apply to those as well.)

If you wire count, it can be a scalar number, in which case the function returns a 1D array
of records. Or it can be a cluster of N scalar numbers, in which case the function returns
an N-dimension array of records.

If the wired count is a scalar number, and the datalog type is something other than an
array, the function returns that number of records in a 1D array. For example, if the type
is a single-precision, floating-point number and count is 3, the array contains three,
single-precision, floating-point numbers. However, if the type is an array, the function
returns the records in a cluster array (because G does not have arrays of arrays).
Therefore, if the datalog type is an array of single-precision, floating-point numbers and
count is 3, the function returns a cluster array of three, single-precision, floating-point
number arrays.

If the wired count is a cluster of N numbers, the function returns an N-dimension array
of records. The size of each dimension is the value of the corresponding number
according to its cluster order. The number of records returned in this manner is the
product of the N numbers. Therefore, you can return 20 records as a 2D array of two
columns and ten rows by wiring a two-element cluster with element 0 = 2 and element
1 =10 to count.

Read From Spreadsheet File

Reads a specified number of lines or rows from a numeric text file beginning at a
specified character offset and converts the data to a 2D, single-precision array of
numbers. Optionally, you can transpose the array. The VI opens the file before reading
from it and closes it afterwards. You can use this VI to read a spreadsheet file saved in
text format. This VI calls the Spreadsheet String to Array function to convert the data.

farmat (%36 rew file path [Maok & Path...
file path [dialog if empty] Bz all rows
nurmber af raves (all-1] E]_f firzt row
ztart of read offzet [chars.. TAT]-.... mark, after read [chars. ]
max charactersdow [no lim... e EOFY
brarEpaEe [fgeF] e
delimiter [Tah]
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Read Lines From File

Reads a specified number of lines from a byte stream file beginning at a specified
character offset. The VI opens the file before reading from it and closes it afterwards.

file path (dialog if empty) new file path (Mot & Path i...
number of lines (all:-1) = Tine string
start of read offzet (chars... — —lgl™ |- s rark after read (chars.)
[max characters per line] ... Lo EOF 7

Strip Path

Returns the name of the last component of a path and the stripped path that leads to that

component.
EQ:; stripped path
hame

path

Write Characters To File

Writes a character string to a new byte stream file or appends the string to an existing file.
The VI opens or creates the file before writing to it and closes it afterwards.

file path (dialeg if empty) new file path (Mot & Path if cancelled)
character string

append to file? (new file:F)

Write File

Writes data to the file specified by refnum. Writing begins at a location specified by pos
mode and pos offset for byte stream file and at the end of file for datalog files. data,
header, and the format of the specified file determine the amount of data written.

corvert eol [F]

header [F)
____refnum FILE dup refrum
pos rnode [1:2) = offset
pos offzet [0] —I_E“" = T grror out
27107 i
datg s
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Writing Byte Stream Files

If refnum is a byte stream file refnum, the Write File function writes to a location
specified by pos mode and pos offset in the byte stream file specified by refnum. If the
top-level datatype of data is of variable length (that is, a string or an array), Write File
can write a header to the file that specifies the size of the data. G sets the file mark to the
byte following the last byte written. convert eol determines whether the function
converts the end-of-line markers it writes into system-specific end-of-line markers. You
can wire convert eol only if data is a string. The system-specific end-of-line marker is a
carriage return followed by a line feed on Windows, a line feed on UNIX, and a carriage
return on Macintosh. If header is true, G ignores convert eol.

Writing Datalog Files

If refnum is a datalog file refnum, the Write File function writes data as records to the
datalog file specified by refnum. Writing always starts at the end of the datalog file
(datalog files are append-only). G sets the file mark to the record following the last record
written. The convert eol, header, pos mode, and pos offset parameters do not apply with
datalog files, and you cannot wire them. The data parameter functions in the following
manner for datalog files.

data must be either a datatype that matches the datatype specified when you open or
create the file, or an array of such datatypes. In the former case, this function writes data
as a single record in the datalog file. Representation of numeric data is coerced to the
representation of the datatype if necessary. In the latter case, this function writes each
element of data as a separate record in the datalog file in row-major order.

Write To Spreadsheet File

Converts a 2D or 1D array of single-precision (SGL) numbers to a text string and writes
the string to a new byte stream file or appends the string to an existing file. You can
optionally transpose the data. This VI opens or creates the file before writing to it and
closes it afterwards. You can use this VI to create a text file readable by most spreadsheet
applications. This VI calls the Array to Spreadsheet String function to convert the data.

format [7. 3F] wennnnnnnnnny

file path [dialog if ermpty] [ } hew file path [Mak & Path ...
2D data _I—"—'r HE
1D data — {12

append to fila? [new fileF] - E
delirmiter [T ab]
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Binary File VI Descriptions

The following VIs are available on the Binary File VIs subpalette.

[t Binary File Vls

2 kel | ST

st st =]

Read From 116 File

Reads a 2D or 1D array of data from a byte stream file of signed, word integers (I116). The
VI opens the file before reading from it and closes it afterwards. You can use this VI to
read unscaled or binary data acquired from data acquisition VIs and written to a file with
Write To 116 File.

20 number of rows

refnum

pos mode (rel. to mark:2)

pos offset (bytes:0)

error in (no error)

20 number of columnsF10 count

dup refhum

2D data

1D data

mark after read (bytes)
error out

EOF %

Read From SGL File

Reads a 2D or 1D array of data from a byte stream file of single-precision numbers
(SGL). The VI opens the file before reading from it and closes it afterwards. You can use
this VI to read scaled data acquired from data acquisition VIs and written to a file with
Write To SGL File.

news file path (Mot & Pathi...
=20 aray

10 array

i mark, after read [bytes]
B EQOF?

file path [dialog if empty]

20 nurnber af rows

number of columns 1D cou...
ghart of read offset [bptes:0]

Hiza
A

Write To 116 File

Writes a 2D or 1D array of signed word integers (116) to a new byte stream file or appends
the data to an existing file. The VI opens or creates the file before writing to it and closes
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it afterwards. You can use this VI to write unscaled or binary data from data acquisition

VlIs.
file path [dialog if empt ] ) _
P! * 20 c—.ﬁéﬂ _— f new file path Mot & Pathi..
10 argy — 111810
append ta file? [hew file:F] -
Write To SGL File

Writes a 2D or 1D array of single-precision numbers (SGL) to a new byte stream file or
appends the data to an existing file. The VI opens or creates the file before writing to it
and closes it afterwards. You can use this VI to write scaled data from data acquisition
VIs without changing the representation.

file path (dialeg l;;rzlrl:g; ] new file path (Mot & Path if cancelled])

1D array —|_3,3|_

append to file? (new file:F) - /

Advanced File Function Descriptions

The following functions are available on the Advanced File Functions subpalette.

i+ Advanced File Functions |

m OFEH|"| |[HEJ|" FILE FILE
Lo | [ L' - EI:IF EEEH
FLEH' FILE (]| [FILE ()
) |5 5|5 =
FILE gg]| [FLE [eg]] [voc
én | |
L@‘@ )| 51 :‘“:—1
P 6] A%
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Access Rights

Sets and returns the owner, group, and permissions of the file or directory specified by
path. If you do not specify new owner, new group, or new permissions, this function
returns the current settings unchanged.

path dup path
FIEW OWNEr FILE Qe
hew graup = qroLp
el ACC] L.
new permissions —I_E‘“ permizzions
&Il ir errar out

(Windows) The Access Rights function ignores new owner and new group and returns
empty strings for owner and group because Windows does not support owners and
groups.

(Macintosh) If path refers to a file, the Access Rights function ignores new owner and
new group and returns empty strings for owner and group because Macintosh does not
support owners or groups for files.

Array Of Strings To Path

Converts an array of strings into a relative or absolute path.

relative ........................

array of strings i T path

Copy

Copies the file or directory specified by source path to the location specified by target
path. If you copy a directory, this function copies all its contents recursively.

zource path [copyf new path

target path - T — enmar out
BrTOr in

Delete

Deletes the file or directory specified by path. If path specifies a directory that is not
empty or if you do not have write permission for both the file or directory specified by
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path and its parent directory, this function does not remove the directory and returns an
error.

path [DEL [ dup path
BITO if H error out

EOF

Sets and returns the logical EOF (end-of-file) of the file identified by refnum. pos mode
and pos offset specify the new location of the EOF. If you do not specify pos mode or
pos offset, this function returns the current unchanged EOF. This function always returns
the location of the EOF relative to the beginning of the file.

refnum FILE dup refrium
pos rode [0:1] - ==

= offzet
pog affeet [0] f i

efrar out
error In

You cannot set the EOF of a datalog file. If refnum identifies a datalog file, you cannot
wire pos mode and pos offset. However, you still can get the EOF of a datalog file, which
tells you how many records exist in the file.

File Dialog

Displays a dialog box with which you can specify the path to a file or directory. You can
use this dialog box to select existing files or directories or to select a location and name
for a new file or directory.

promph seeeeeeaeeog
gtart path path
select mode [2) - % e eists

cancelled

default name
pattern “"'“Ew

datalog ype s

File/Directory Info

Returns information about the file or directory specified by path, including its size, its
last modification date, and whether it is a directory.

,. ..................... dirECtDr_'rl
path FILE u:I_up path
A s ke Slas

lazt riod
errar out
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Flush File

Writes all buffers of the file identified by refnum to disk and updates the directory entry
of the file associated with refnum. The file remains open, and refnum remains valid.

refnum ) dup refrium

10T in 1, error out

Data written to a file often resides in a buffer until the buffer fills up or until you close
the file. This function forces the operating system to write any buffer data to the file.

List Directory

Returns two arrays of strings listing the names of all files and directories found in
directory path, filtering both arrays based upon pattern and filtering the file names
array based upon the specified datalog type.

directory pt?th - ilISTi - ?Ilup directary path
pattern ile names
datalog type f@% directon names
1o in error oLt

Lock Range

Locks or unlocks a range of a file specified by refnum. Locking a range of a file prevents
both reading and writing by other users, overriding permissions for the file, and the deny
mode associated with refnum. See File I/O VI and Function Overview earlier in this
manual for a full discussion of permissions. Unlocking a range of a file removes the
override caused by locking a range, so that the file's permissions and the deny mode
associated with refnum determine whether other users can read from or write to that
range of the file.

SE!t ||:":k [F] ......................
refnum FILE dup refrum
) = B
pos mods [U:2] e errar ot

pos offzet (0] f

20T N
count

You cannot lock a range of a datalog file.
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Move
Moves the file or directory specified by source path to the location specified by target
path.
source path riew path
target path - -

20 ity =

New Directory

Programmatically creates the directory specified by directory path. If a file or directory
already exists at the specified location, this function returns an error instead of
overwriting the existing file or directory.

directory path - WEm| dup directary path
group
PEMIEE0nE f‘ﬂ Error out
rmor in
New File
Creates the file specified by file path and opens it for reading and writing (regardless of
permissions).
datalog bype e
pefmizsions ————
hile path HER] refrum
group
deny mode (2] e gprior ot
&1l i
DVErWritE [F] ......................
Open File
Opens the file specified by file path for reading and/or writing.
datalog type semmm—
file path OFEN[ refrLm
open mode (] _I_ﬁm error out
deny mode [2] mE“"‘—
ermor in
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Path To Array Of Strings

Converts a path into an array of strings and indicates whether the path is relative.

........................ rE|atiVE
path 1% [} array of ghings

Path To String

Converts path into a string describing a path in the standard format of the platform.

path 1% at<} ghring

Path Type

Returns the type of the specified path, indicating whether it is an absolute, relative, or
invalid path. This function checks only the format of the path, not whether the path refers
to an existing file or directory. Therefore, this function only indicates an invalid path for
Not A Path.

&

path s lype

Refnum To Path

Returns the path associated with the specified refnum.

refnum 101 % } path

Seek

Moves the current file mark of the file identified by refnum to the position indicated by
pos offset according to the mode chosen by pos mode.

refnum FLE dup refrium
pos made [0:2] - off et
pos offget [I_:I] f (Elsien errar out
efrar i
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String To Path

Converts a string, describing a path in the standard format for the current platform, to a
path.

string Tats "} path

Type and Creator

Reads and sets the type and creator of the file specified by path. File type and creator are
four-character strings. If you do not specify new type or new creator, this function
returns the current settings unchanged.

path dup path
new type ype

creator
efrar out

new creator
Error In

Windows and UNIX do not support file types and creators. Trying to set the type or
creator of a file in these platforms results in an error; however, you can get the file type
and creator in these platforms. If the specified file has a name ending with characters that
LabVIEW recognizes as specifying a file type (such as .vi for the LVIN file type and
.11b for the LVAR file type), this function returns that type in type and LBVW in creator.
Otherwise, the function returns ??? ? in both type and creator.

Volume Info

Returns information about the volume containing the file or directory specified by path,
including the total storage space provided by the volume, the amount used, and the
amount free in bytes.

volume path
zize

uzed

free

errar out

vl

path
EIT0r j ===
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File Constants Descriptions

The following constants are the options available on the File Constants subpalette.

iix! File Constants |

B B B (@

Current VI's Path Constant

Returns the path to the file containing the VI in which this function appears. If the VI is
incorporated into an application (using the Application Builder libraries), the function
returns the path to the VI in the application file, and treats the application file as a VI
library.

path

Default Directory Constant

Returns the path to your default directory. The default directory is the directory which
the file dialog displays initially. The G Preferences dialog box, under Paths, defines this
directory.

path

Empty Path

Returns an empty path.
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Not A Path

Returns a path whose value is Not A Path. You can use this path as an output from
structures and subVIs when an error occurs.

Not A Refnum

Returns a refnum whose value is Not A Refnum. You can use this refnum as an output
from structures and subVIs when an error occurs.

Path Constant

Use this to supply a constant directory or file path to the block diagram. Set this value by
clicking inside the constant with the Operating tool and typing in the value. Use the
standard file path syntax for a given platform.

The value of the path constant cannot be changed while the VI executes. You can assign
a label to this constant.

Temporary Directory Constant

Returns the path to your temporary directory. The temporary directory is the directory in
which you store temporary information that you expect the user or the operating system
to delete periodically. The Preferences dialog box, under Paths, defines this directory.

path

VI Library Constant

Returns the path to the VI library directory for the current G on the current computer. The
G Preferences dialog box (Edit»Preferences) defines this directory. If you build an
application using the Application Builder libraries, this path is the path of the directory
containing the application.

[z path
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This chapter describes the functions that perform advanced operations.
This chapter also describes the Help, Data Manipulation, and
Occurrence Functions, and the VI Control and Memory VISA.

To access the Advanced palette, shown in the following illustration,
select Functions»Advanced.

s Functions |

123

B
-
&
m
el

o
o
fi

[=]=]

B | ]
| ==

g
=i
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{1
=
e, 1D
IT'
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4 H —F 4 4

= e

The Advanced Functions include the following subpalettes:
e Data Manipulation
e Help

*  Memory

© National Instruments Corporation 12-1 LabVIEW Function and VI Reference Manual



Chapter 12 Advanced Functions

¢ Occurrences
¢ VI Controls

Advanced Function Descriptions

The following Advanced Functions are available.

Beep

Causes the system to issue an audible tone. You can specify the tone frequency in Hertz,
the duration in milliseconds, and the intensity as a value from 0 to 255, with 255 being
the loudest. Although this VI appears on all platforms, the frequency, duration, and
intensity parameters work only on the Macintosh.

frequency [Hz] - ignared 3
duration [mzec] - ignored —'_'P
interzity [0-255] - ignored — —

error - ignored

Call Chain

Returns the chain of callers from this VI to the top-level VI as an array of strings.

% poacasoas: -5l chain

Code Interface Node

With a Code Interface Node (CIN), you can call code written in a conventional
programming language, such as C, directly from a block diagram. CINs make it possible
for you to use algorithms written in another language or to access platform-specific
features or hardware that G does not directly support.

Code Interface Nodes are resizable and show datatypes for the connected inputs and
outputs, similar to the Bundle function. The following illustration shows the CIN
function.

[Eode Interface Mode]

LabVIEW Function and VI Reference Manual 12-2 © MNational Instruments Corporation



Chapter 12 Advanced Functions

LabVIEW’s interface to external code is very powerful. You can pass any number of
parameters to or from external code, and each parameter can be of any arbitrary G
datatype. LabVIEW provides several libraries of routines that make working with G
datatypes easier. These routines support memory allocation, file manipulation, and
datatype conversion.

If you convert a VI that contains a CIN to another platform, you need to recompile the
code for the new platform, because CINs use code compiled in another programming
language. You can write source code for a CIN so that it is machine-independent,
requiring only a recompile to convert it to another platform.

For examples of CINs, see examples\cins.

For more information on the Code Interface Node see the Code Interface Reference
Manual.

Call Library Function

With the Call Library Function node, you can call standard libraries without writing a
Code Interface Node (CIN). Under Windows, you can call a dynamic link library (DLL)
function directly. In Macintosh and UNIX, you can call a shared library function directly.
On the Macintosh 68K, you must have the CFM-68K system extension installed for the
Call Library Function node to operate.

This node supports a large number of datatypes and calling conventions. You should be
able to use it to call functions from most standard and custom-made libraries.

The Call Library Function node, shown in the following illustration, looks similar to a
Code Interface Node.

ﬂj:ﬂ [EL]
old
— return walue
pararm 1 — — new wvalue of param 1
parar 2 —1 — new wvalue of param 2

The Call Library Function consists of paired input/output terminals with input on the left
and output on the right. You can use one or both. The return value for the function is
returned in the right terminal of the top pair of terminals of the node. If there is no return
value, then this pair of terminals is unused. Each additional pair of terminals corresponds
to a parameter in the functions parameter list. You pass a value to the function by wiring
to the left terminal of a terminal pair. You read the value of a parameter after the function
call by wiring from the right terminal of a terminal pair.

If you select Configure... from the pop-up menu of the node, you see a Call Library
Function dialog box from which you can specify the library name or path, function name,
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calling conventions, parameters, and return value for the node. When you click on OK,
the node automatically increases in size to have the correct number of terminals. It then
sets the terminals to the correct datatypes. For more information on Call Library Function
refer to Chapter 24, Calling Code From Other Languages, in the LabVIEW User Manual.

Quit

Stops all executing VIs and ends the current session of LabVIEW. This function shuts
down only LabVIEW; the function does not power down the system or affect other
applications. The function stops running VIs the same way the Stop function does.

quit’? [T]

Stop

Stops the VI in which it executes, just as if you clicked the stop button in the toolbar. If
you wired the input, stop occurs only if the input value is TRUE. If you leave the input
unwired, the stop occurs as soon as the node that is currently executing finishes.

—

If you need to abort execution of all VIs in a hierarchy from the block diagram, you can
use this function, but you must use it with caution. Before you call the Stop function with
a TRUE input, be sure to complete all final tasks for the VI first, such as closing files,
setting save values for devices being controlled, and so on. If you put the Stop function
in a subVI, you should make its behavior clear to other users of the VI, because this
function causes their VI hierarchies to abort execution.

In general, you should avoid using the Stop function when you have a built-in terminator
protocol in your VI. For example, I/O operations should be performed in While Loops so
that the VI can terminate the loop on an I/O error. You should also consider using a front
panel Stop Boolean control to terminate the loop at the request of the user rather than
using the Stop function.
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The following illustration displays the options available on the Data Manipulation

subpalette.

EXF

E@E @g ;3@| #ﬂl"#?%
=

— —
s | | s——
— [—
s F 15 1

Flatten To String

Converts anything to a string of binary values. type string is a type descriptor that
describes the datatype of anything. data string is the flattened form of anything. For more
information on type descriptors and flattened data, see Flattened Data, in Appendix A,
Data Storage Formats, of the LabVIEW User Manual.

anything ===

[o]

B

type string
data ztring

Join Numbers

Creates a number from the component bytes or words.

lo

hi— T jhila)

Logical Shift

Shifts x the number of bits specified by y.

¥ T ey
X
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Mantissa & Exponent

Returns the mantissa and exponent of the input numeric value such that number =
mantissa * 2 ©XP"ent 1f pumber is 0, both mantissa and exponent are 0. Otherwise, the
value of mantissa is greater than or equal to 1 and less than 2, and the value of exponent
is an integer.

TR mantizza

EXF exponent

#

number

Rotate

Rotates x the number of bits specified by y.

¥ # ratated left by v

Rotate Left With Carry

Rotates each bit in the input value to the left (from least significant to most significant
bit), inserts carry in the low-order bit, and returns the most significant bit.

cary = msh carmy out

yvalue value

Rotate Right With Carry

Rotates each bit in value to the right (from most significant to least significant), inserts
carry in the high-order bit, and returns the least significant bit.

CAFEYY e TR ]5tl carr l:lth
va]u% walue 4

Split Number

Breaks a number into its component bytes or words.

hif]
¥ —@:I_ |,::[:]
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The following illustration shows an example of how to use the Split Number function.

The function splits the signed 32-bit number 100,000 into the high word component, 1,
and the low word component, 34,464.

g

v 100,000 |

f=]
—_
Em

=
=
o

2

Swap Bytes

Swaps the high-order 8 bits and the low-order 8 bits for every word in anything.

anything —= byte swapped

Swap Words
Swaps the high-order 16 bits and the low-order 16 bits for every long integer in anything.
anything : word swapped
[

Type Cast

Casts x to the datatype, type.

type
X QE *[type *]
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Casting data to a string converts it into machine-independent, big endian form. That is,
the function puts the most significant byte or word first and the least significant byte or
word last, removes alignment, and converts extended-precision numbers to 16 bytes.
Casting a string to a 1D array converts the string from machine-independent form to the
native form for that platform.

Unflatten From String

Converts binary string to the type wired to type. This function performs the inverse of
Flatten To String. binary string should contain flattened data of the type wired to type.
For more information on type descriptors and flattened data, see Flattened Data, in
Appendix A, Data Storage Formats, of the LabVIEW User Manual.

binary string ﬁ?@i =)
type @ | walle

Help Function Descriptions

The following illustration displays the options available on the Help subpalette.

-—1HHelp
el |

eel||=s+17

=)

ek

Control Help Window

Modifies the Help window by showing, hiding, or repositioning the window.

T — ﬁ?@

Top Left Corng wmmmmmms (.- =

Control Online Help

Controls the online help system by displaying the table of contents of a help file, jumping
to a specific point in a help file, or closing the online help system.

Operation i)
Shing to search for N.FHMJE ‘? === E 1o Qliabpit

Path to the help file
Errar Input I
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Get Help Window Status

Returns the status and the position information for the Help window.

:@..{,?} ................. Show

# = [ fpmmmmmn T op Left Corner

Occurrence Function Descriptions

You can use the occurrence functions to control separate, synchronous activities. In
particular, you use these functions when you want one VI or part of a block diagram to
wait until another VI or part of a block diagram finishes a task without forcing LabVIEW
to poll.

You can perform the same task using global variables, with one loop polling the value of
the global until its value changes. However, global variables add overhead, because the
loop that waits uses execution time. With occurrences, the polling loop is replaced with
a Wait on Occurrence function and does not use processor time. When some diagram sets
the occurrence, LabVIEW activates all Wait on Occurrence functions in any block
diagrams that are waiting for the specified occurrence.

The following illustration displays the options available on the Occurrences subpalette.

Occurrences |

&[> [D

Generate Occurrence
Creates an occurrence that you can pass to the Wait on Occurrence and Set Occurrence
functions.

@7 DCCUTENCE

Ordinarily, only one Generate Occurrence node is connected to any set of Wait on
Occurrence and Set Occurrence functions. You can connect a Generate Occurrence
function to any number of Wait on Occurrence and Set Occurrence functions. You do not
have to have the same number of Wait on Occurrence and Set Occurrence functions.
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Each Generate Occurrence function on a block diagram represents a single, unique
occurrence. In this way, you can think of the Generate Occurrence function as a constant.
When a VI is running, every time a Generate Occurrence function executes, the node
produces the same value. For example, if you place a Generate Occurrence function
inside of a loop, the value produced by Generate Occurrence is the same for every
iteration of the loop. If you place a Generate Occurrence function on the block diagram
of a reentrant VI, Generate Occurrence produces a different value for each caller.

Set Occurrence

Triggers the specified occurrence. All block diagrams that are waiting for this
occurrence stop waiting.

OCCUITENCE —D

Wait On Occurrence

Waits for the Set Occurrence function to set or trigger the given occurrence.

s tirneaut [-1)
OCCUITENCE —
ignore presious [T] -

tirmed out

Memory VI Descriptions

The following illustration displays the options available on the Memory subpalette.

- M emory

In Port (Windows 3.1 and Windows 95)

Reads a byte or word integer from a specific register address. Because this VI is not
available on all platforms, VIs using this subVI are not portable.

register addreszs In
read a bpte ar a ward [Fbpte] -] Part

walue
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Out Port (Windows 3.1 and Windows 95)

Writes a byte or word integer to a specific register address. Because this VI is not
available on all platforms, VIs using this subVI are not portable.

regizter address Out
write & byte or a word [F:b.. ] Pt

value — !

VI Control VI Descriptions

You can use the VI Control VIs to dynamically load, call, and close other VIs. When you
call a VI dynamically, you specify whether or not the called VI opens its front panel and
then closes the front panel when it finishes executing. You can also pass parameters to
and from the dynamically called VI.

All of these VIs use error cluster inputs and outputs to make error handling easier. If an
incoming error is set, the VI does not do anything. The Release Instrument VI, however,
releases the specified VI from memory regardless of incoming errors.

The following illustration displays the options available on the VI Control subpalette.

| ,=IF0¥I Control

O, E D1
CAHLL]| LOAD

[wr]
7
+
]
@
[wr]
T
-

+

=
Hi
=

BOR
0. 5|0, |0, 5
oPEN| | cLosE| [ cLosE
0+, 5|04

H
Yo
H

a

kd
=
M

'l

rﬁﬁj

|
o
=
m

Abort Instrument

Aborts the execution of the specified VI, just as if you clicked the stop button in the
specified VI’s toolbar.

¥l name O, @

erar in [ho erar] AEORT errar oLt
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Call Instrument

Loads and then calls another VI as long as the VI you are calling is not currently in the
VI hierarchy of any running VI, including your main VI. For example, if you have the
Serial Port Read VI on your block diagram, you cannot use Call Instrument to call Serial
Port Read directly, because it is already in the main VI’s hierarchy. However, you can
call the Serial Port Read VI if you create a VI that is not part of the main VI’s hierarchy.
If the called VI has not already been loaded, LabVIEW loads it before the call, and
unloads the VI when the call is finished. If you do not want to incur the speed penalty of
loading the VI at the time of the call, use the Preload Instrument VI to preload the VI,
and then use the Release Instrument VI when you are finished with it. If error in contains
an error, LabVIEW does not call the VI.

Y| pathy ey

¥l name ?E—
inputs rrrrrrn Dutputs
desired Dutputsf L Tor rpar at
error in [no error)
call mode [open.call cloze: 1]
retrieve El” DUtDUtS [F:l:lr'll... ..........................

Note: You can pass data to any control (excluding indicators) on the front panel
of the called VI; the controls do not have to be on the connector pane of the
called VI.

Close Panel
Closes the front panel of a specified VI. If the VI is running it will be aborted.

[, i

ol in [ho erar] CLOSE 2ror oLt

¥l name

Close Panel No Abort

Closes the front panel of the specified VI. If the VI is running and was loaded using
Preload Instrument VI, it will not be aborted. If the VI is running, but it has not been
preloaded, it will be aborted.

¥l name

2Irar in [ho erar] CLOSE errar oLt
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Get Instrument State

Returns the VI execution state (Broken, Idle, or Running) and the panel window state
(Closed, Open, or Open and Active). If the VI is not in memory, the error out will be
File Not Found.

[ wi tate

O,
ozl L window state
FVATEleoesaeen gy ot

¥l name

EIrar in [ho error] s

Get Panel Size

Read the size of the panel of a VI that is already in memory. The VI must be in memory
but its panel does not need to be open.

¥l name 0. &

panelwindow bounds? (F:panel] -
Ermar in (o emar) =

P e location and size
SIZE? errar out

Open Panel
Opens the front panel of the specified VI. The specified VI must already be in memory,
either because it was loaded using the Preload Instrument VI, or because it is the subVI
of another VI.

¥l name - [
uze ¥l Setup settings? (T)] -
enmar in [ho enor] === OFEN errar out

Preload Instrument

You can use this VI to load another VI into memory. The front panel of the specified VI
is not visible when it is loaded. If you want the front panel to be visible, call either Open
Panel VI or use the appropriate call mode for the Call Instrument VI.

¥l path —-ry
¥l name O—
e
Errar in (o erar) LOAD errar oLk

If you execute a Preload Instrument VI, and it does not return an error, make sure you
call the Release Instrument VI when you are finished to remove the loaded VI from
memory. If you call the Preload Instrument VI multiple times, you need to balance the
calls with Release Instrument VI calls.
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Release Instrument

Use this VI to unload a VI that was loaded using the Preload Instrument VI. If you call
Preload Instrument more than once; the specified VI is not unloaded until you call
Release Instrument an equal number of times.

¥l name

N]

il

error in [no ermor) RE error out

Resize Panel

Resizes and/or moves the front panel of a VI that is already in memory. The VI must be
in memory, but its front panel does not have to be open. Consequently, you can size or
position a front panel before opening it.

¥l name
panel location and size ﬂﬂ:, ........
panelwindow bounds [F:panel] - pr-BESIEE oo grror oLt

&rrar in [hio ermar]

C—

Run Instrument

You can use this VI to run another VI that is in memory with the front panel of the VI in
memory open. Run Instrument is different from Call Instrument in that Run Instrument
returns immediately after starting the specified VI running, whereas Call Instrument
waits for the called VI to complete execution and can pass parameters to and from the
called VI. Run Instrument works just as if you selected Operate»Run, while Call
Instrument functions more like a subVI call.

¥l name 0=
errar in [no ermor) RUN error aut
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Introduction to the LabVIEW
Data Acquisition Vis

This chapter contains basic information about the data acquisition
(DAQ) VIs and shows where you can find them in LabVIEW.
Descriptions of these VIs comprise Chapter 14 through Chapter 29.

LabVIEW includes a collection of VIs that work with your DAQ
hardware devices. With LabVIEW’s DAQ VIs you can develop
acquisition and control applications.

You can find the DAQ VIs in the Functions palette from your block
diagram in LabVIEW. The DAQ VIs are located near the bottom of the
Functions palette.

To access the Data Acquisition palette, choose Functions»Data
Acquisition, as shown in the following illustration.

IE Functions |
D ata Acquisition

4
= [
3
.

v

»
[ET1]=]
=]
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N =IH -—1HD ata Acquizition
N [
m»m Iﬁl
O (e 2 a_rE=
MIEE [
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Analog Input Vis —mr =

Calibration and
Configuration VIs gl

Introduction to the LabVIEW Data Acquisition VIs

The Data Acquisition palette contains six subpalette icons that take you
to the different classes of DAQ VIs. The following illustration shows
what each of the icons in the Data Acquisition palette means.

Analog Output VIs Digital /0 VIs
B pata Acquisition &
';"H l"gtu k g!! F |<@—|— Counter Vis
=1 L
AIEC |IEI""-}%

Signal Conditioning Vls

This section of the manual is organized in the order that the DAQ VI
icons appear in the Data Acquisition palette from left to right. For
example, in this section, the Analog Input VI chapters are followed by
the Analog Output VI chapters, which are followed by the Digital I/O
VI chapters, and so on. Most often, there are several chapters devoted
to one class of DAQ VI in the palette, because many of the VI palettes
also contain several subpalettes.

Finding Help Online for the DAQ Vls

You can find helpful information about individual VIs online by using
the LabVIEW Help window (Help»Show Help). When you place the
cursor on a VI icon, the wiring diagram and parameter names for that
VI appear in the Help window. You can also find information for front
panel controls or indicators by placing the cursor over the control or
indicator with the Help window open. For more information on the
LabVIEW Help window, refer to the Getting Help section in Chapter 2,
Creating Vls, of the LabVIEW User Manual.

In addition to the Help window, LabVIEW has more extensive online
information available. To access this information, select Help»Online
Reference. For most block diagram objects, you can select Online
Reference from the object’s pop-up menu to access the online
description. You can also access this information by pressing the button
shown to the left, which is located at the bottom of LabVIEW’s Help
window. For information on creating your own online reference files,
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see the Creating Your Own Help Files section in Chapter 25, Managing
Your Applications of the LabVIEW User Manual.

Note: Use only the inputs that you need on each VI. LabVIEW sets all unwired
inputs to their default values. Many of the DAQ function inputs are
optional and do not appear in the Simple Diagram Help window. These
inputs typically specify rarely-used options. If an input is required, your VI
wiring remains “broken” until a value is wired to the input. Required
inputs appear in bold in the Help window, recommended inputs appear in
plain text, and optional inputs are in gray text. The default values for
inputs appear in parentheses beside the input name in the Help window.

Note: Some DAQ VIs use an enumerated data type as a control or indicator
terminal. If you connect a numeric value to an enumerated indicator,
LabVIEW converts the number to the closest enumeration item. If you
connect an enumerated control to a number value, the value is the
enumeration index. To wire an enumerated control to an enumerated
indicator, the enumerated items must match exactly, or you will get a
broken wire.

The Analog Input Vis

These VIs perform analog input operations.

The Analog Input VIs can be found by choosing
Functions»Data Acquisition»Analog Input. When you click on the
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Analog Input icon in the Data Acquisition palette, the Analog Input
palette pops up, as shown in the following illustration.

El:l Data Acquisition i

Analog Input
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There are four classes of Analog Input VIs found in the Analog Input
palette. The Easy Analog Input VIs, Intermediate Analog Input VIs,

Analog Input Utility VIs, and Advanced Analog Input VIs. The
following illustrates these VI classes.

Hl 1
tuet e7 | | vt et || oME FT || omE pT [——]— Easy Analog Input Vls
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uTIL * AOL b Advanced
E" < Analog Input Vis

Analog Input Utility Vis

Easy Analog Input Vs

The Easy Analog Input VIs perform simple analog input operations.

You can run these VIs from the front panel or use them as subVIs in
basic applications.
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You can use each VI alone to perform a basic analog operation. Unlike
intermediate- and advanced-level VIs, Easy Analog Input VIs
automatically alert you to errors with a dialog box that asks you to stop
the execution of the VI or to ignore the error.

The Easy Analog Input VIs are actually composed of Intermediate
Analog Input VIs, which are in turn composed of Advanced Analog
Input VIs. The Easy Analog Input VIs provide a basic, convenient
interface with only the most commonly used inputs and outputs. For
more complex applications, you should use the intermediate- or
advanced-level VIs for more functionality and performance.

Refer to Chapter 14, Easy Analog Input Vls, for specific VI information.

Intermediate Analog Input Vis

You can find intermediate-level Analog Input VIs in two different
places in the Analog Input palette. You can find the Intermediate
Analog Input VIs in the second row of the Analog Input palette. The
other intermediate-level VIs are in the Analog Input Utilities palette,
which will be discussed later. The Intermediate Analog Input VIs—AI
Config, AI Start, Al Read, AI Single Scan, and AI Clear—are in turn
built from the fundamental building block layer, called the Advanced
Analog Input VIs. These VIs offer almost as much power as the
advanced-level VIs, and they conveniently group the advanced-level
Vs into a tidy, logical sequence.

Refer to Chapter 15, Intermediate Analog Input VlIs, for specific VI
information.

Analog Input Utility Vis

uTIL b
& F.

Analog Input
Utility Icon

You can access the Analog Input Utilities palette by choosing the
Analog Input Utility icon from the Analog Input palette. The Analog
Input Utility VIs—AI Read One Scan, Al Waveform Scan, and Al
Continuous Scan—are single-VI solutions to common analog input
problems. These VIs are convenient, but they lack flexibility. These
three VIs are built from the Intermediate Analog Input VIs in the
Analog Input palette.

Refer to Chapter 16, Analog Input Utility Vls, for specific VI
information.
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Advanced Analog Input Vis

EIEIH

Advanced Analog
Input Icon

You can access the Advanced Analog Input palette by choosing the
Advanced Analog Input icon from the Analog Input palette. These VIs
are the interface to the NI-DAQ data acquisition software and are the
foundation of the Easy, Utility, and Intermediate Analog Input VIs.

Refer to Chapter 17, Advanced Analog Input Vs, for specific VI
information.

Locating Analog Input VI Examples

For examples of how to use the analog input VIs, see
examples\dag\anlogin\anlogin.1llb

Analog Output Vis

These VIs perform analog output operations.

The Analog Output VIs can be found by choosing Functions»Data
Acquisition»Analog Output. When you click on the Analog Output
icon in the Data Acquisition palette, the Analog Output palette pops up,
as shown in the following illustration.
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There are four classes of Analog Output VIs found in the Analog
Output palette: the Easy Analog Output VIs, Intermediate Analog
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Output VIs, Analog Output Utility VIs, and the Advanced Analog
Output VIs. The following illustrates these VI classes.

EEQ Analog Dutput §
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Analog Output Utility VIs

Easy Analog Output Vis

The Easy Analog Output VIs perform simple analog output operations.
You can run these VIs from the front panel or use them as subVlIs in
basic applications.

You can use each VI by itself to perform a basic analog output
operation. Unlike intermediate- and advanced-level VIs, Easy Analog
Output VIs automatically alert you to errors with a dialog box that asks
you to stop the execution of the VI or to ignore the error.

The Easy Analog Output VIs are actually composed of Intermediate
Analog Output VIs, which are in turn composed of Advanced Analog
Output VIs. The Easy Analog Output VIs provide a basic, convenient
interface with only the most commonly used inputs and outputs. For
more complex applications, you should use the intermediate- or
advanced-level VIs for more functionality and performance.

Refer to Chapter 18, Easy Analog Output VIs, for specific VI
information.

Intermediate Analog Output Vis
You can find intermediate-level Analog Output VIs in two different
places in the Analog Output palette. You can find the Intermediate
Analog Output VIs in the second row of the Analog Output palette. The
other intermediate-level VIs are in the Analog Output Ultilities palette,

© National Instruments Corporation 13-7 LabVIEW Function and VI Reference Manual



Chapter 13 Introduction to the LabVIEW Data Acquisition VIs

which will be discussed later. The Intermediate Analog Output VIs—
AO Config, AO Write, AO Start, AO Wait, and AO Clear—are in turn
built from the fundamental building block layer, called the Advanced
Analog Output VIs. These VIs offer almost as much power as the
advanced-level VIs, and they conveniently group the advanced-level
VIs into a tidy, logical sequence.

Refer to Chapter 19, Intermediate Analog Output VIs, for specific VI
information.

Analog Output Utility Vs

uTIL b
E"‘:a

Analog Output
Utility Icon

You can access the Analog Output Utilities palette by choosing the
Analog Output Utility icon from the Analog Output palette. The
Analog Output Utility VIs—AI Read One Scan, Al Waveform Scan,
and AI Continuous Scan—are single-VI solutions to common analog
output problems. These VIs are convenient, but they lack flexibility.
These three VIs are built from the Intermediate Analog Output VIs in
the Analog Output palette.

Refer to Chapter 20, Analog Output Utility Vls, for specific VI
information.

Advanced Analog Output Vs

Efi::l.l I

Advanced Analog
Output Icon

You can access the Advanced Analog Output palette by choosing the

Advanced Analog Output icon from the Analog Output palette. These
VIs are the interface to the NI-DAQ software and are the foundation of
the Easy, Utility, and Intermediate Analog Output VIs.

Because all these VIs rely on the advanced-level VIs, you can refer to
Chapter 21, Advanced Analog Output Vls, for additional information on
the inputs and outputs and how they work.

Locating Analog Output VI Examples

For examples of how to use the analog output VIs, see the examples in
examples\dag\anlogout\anlogout.llb.
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Digital Function Vis

These VIs perform digital operations.

The Digital I/O VIs can be found by choosing Functions»Data
Acquisition»Digital I/O. When you click on the Digital I/O icon in the
Data Acquisition palette, the Digital I/O palette pops up, as shown in
the following illustration.
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There are three classes of Digital I/O VIs found in the Digital I/O
palette. The Easy Digital I/O VIs, Intermediate Digital I/O VlIs, and
Advanced Digital I/O VIs. The following illustrates these VI classes.
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Easy Digital 1/0 Vis
The Easy Digital I/O VIs perform simple digital operations. You can
run these VIs from the front panel or use them as subVlIs in basic

applications.
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You can use each VI by itself to perform a basic digital operation.
Unlike intermediate- and advanced-level VIs, Easy Digital I/O VIs
automatically alert you to errors with a dialog box that asks you to stop
the execution of the VI or to ignore the error.

The Easy Digital I/O Vs are actually composed of Intermediate Digital
I/0 VIs, which are in turn composed of Advanced Digital I/O VIs. The
Easy Digital I/O VIs provide a basic, convenient interface with only the
most commonly used inputs and outputs. For more complex
applications, you should use the intermediate- or advanced-level VIs for
more functionality and performance.

Refer to Chapter 22, Easy Digital I/0O VlIs, for specific VI information.

Intermediate Digital 1/0 Vis

You can find intermediate-level Digital I/O VIs in the second and third
rows of the Digital I/O palette. The Intermediate Digital I/O VIs are in
turn built from the fundamental building block layer, called the
Advanced Digital I/O VIs. These VIs offer almost as much power as the
advanced-level VIs, and they conveniently group the advanced-level
VIs into a tidy, logical sequence.

Refer to Chapter 23, Intermediate Digital I/0 Vs, for specific VI
information.

Advanced Digital 1/0 Vis
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You can access the Advanced Digital I/O palette by choosing the
Advanced Digital I/0 icon from the Digital I/O palette. These VIs are
the interface to the NI-DAQ software and are the foundation of the
Easy, Utility, and Intermediate Digital I/O VIs.

Because all these VIs rely on the advanced-level VIs, you can refer to
Chapter 24, Advanced Digital I/O Vs, for additional information on the
inputs and outputs and how they work.

Locating Digital 1/0 VI Examples

For examples of how to use the Digital I/O VlIs, see the examples in
examples\dag\digital\digital.llb.
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Counter Vs

These VIs perform counting operations.

The Counter VIs can be found by choosing Functions»Data
Acquisition»Counter. When you click on the Counter icon in the Data
Acquisition palette, the Counter palette pops up, as shown in the
following illustration.
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There are three classes of Counter VIs found in the Counter palette: the
Easy, Intermediate, and Advanced Counter VIs. The following
illustrates these VI classes.

i1 Counter
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Intermediate Counter Vis

Easy Counter Vis

The Easy Counter VIs perform simple counting operations. You can run
these VIs from the front panel or use them as subVlIs in basic
applications.

© National Instruments Corporation 13-11 LabVIEW Function and VI Reference Manual



Chapter 13 Introduction to the LabVIEW Data Acquisition VIs

Note:

You can use each VI by itself to perform a basic counting operation.
Unlike intermediate- and advanced-level VIs, Easy Counter VIs
automatically alert you to errors with a dialog box that asks you to stop
the execution of the VI or to ignore the error.

The Easy Counter VIs are actually composed of Intermediate Counter
VIs, which are in turn composed of Advanced Counter VIs. The Easy
Counter VIs provide a basic, convenient interface with only the most
commonly used inputs and outputs. For more complex applications, you
should use the intermediate- or advanced-level VIs for more
functionality and performance.

An important basic data acquisition concept is to use only the inputs that
you need on each VI. Leave the rest of the inputs unwired, and LabVIEW
sets them to their default values. In the Help window, the most important
terminals are labeled in bold, and the least commonly used are in brackets.
Values given in parentheses are default values.

Refer to Chapter 25, Easy Counter Vls, for specific VI information.

Intermediate Counter Input Vs

INT |
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Intermediate
Counter VI Icon

You can find the Intermediate Counter VIs in the second row of the
Counter palette. The Intermediate Counter VIs are in turn built from the
fundamental building block layer, called the Advanced Counter Vls.
These VIs offer almost as much power as the advanced-level VIs, and
they conveniently group the advanced-level VIs into a tidy, logical
sequence.

Refer to Chapter 26, Intermediate Counter Vls, for specific VI
information.

Advanced Counter Vis

ARl |
S

You can access the Advanced Counter palette by choosing the
Advanced Counter icon from the Counter palette. These VIs are the
interface to the NI-DAQ software and are the foundation of the Easy
and Intermediate Counter VIs.

Because all these VIs rely on the advanced-level VIs, you can refer to
Chapter 27, Advanced Counter Vs, for additional information on the
inputs and outputs and how they work.

LabVIEW Function and VI Reference Manual 13-12 © MNational Instruments Corporation



Chapter 13 Introduction to the LabVIEW Data Acquisition VIs

Locating Counter VI Examples

For examples of how to use the Counter VIs, open the example library
by opening examples\dag\counter\counter.1lb.

Calibration and Configuration Vls

These VIs calibrate specific devices and set and return configuration
information.

See Chapter 28, Calibration and Configuration VlIs, for information on
locating these VIs and examples.

Signal Conditioning Vis

These VIs convert analog input voltages read from resistance
temperature detectors (RTDs), strain gauges, or thermocouples into
units of strain or temperature.

See Chapter 29, Signal Conditioning Vls, for information on locating
these VIs and examples.

© National Instruments Corporation 13-13 LabVIEW Function and VI Reference Manual



Easy Analog Input Vis

This chapter describes the Easy Analog Input VIs, which perform
simple analog input operations. You can run these VIs from the front
panel or use them as subVIs in basic applications.

You can access the Easy Analog Input VIs by choosing Functions»Data
Acquisition»Analog Input. The Easy Analog Input VIs are the VIs on
the top row of the Analog Input palette, as shown below.

EL] Analeg Input
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Easy Analog Input VI Descriptions

The following Easy Analog Input VIs are available.

Al Acquire Waveform

Acquires a specified number of samples at a specified sample rate from a single input
channel and returns the acquired data.

b dqlv(iﬁt)a— HUS_IPT - waveform
channe Y actual sample
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sample rate (1000 samplesfsec)— |
high limit (0.0
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The Al Acquire Waveform VI performs a hardware-timed measurement of a waveform
(multiple voltage readings at a specified sampling rate) on a single analog input channel.
If an error occurs, a dialog box appears, giving you the option to stop the VI or continue.

Refer to Appendix A, DAQ Hardware Capabilities, for the channel numbers and input
limits available with your DAQ device.

Al Acquire Waveforms

Acquires data from the specified channels and samples the channels at the specified scan
rate.

device — i bwareforms

channels (0) ) BUFT L 20441 sean
number of samples/Seh 18| " period (zec)
scan rate (1000 scansfsec) |
high Timit (0.0
Taw Tirnit (0,00

The AI Acquire Waveforms VI performs a timed measurement of multiple waveforms on
the specified analog input channels. If an error occurs, a dialog box appear, giving you
the option to abort the operation or continue execution.

Refer to Appendix A, DAQ Hardware Capabilities, for the channel numbers and input
limits available with your DAQ device.

Al Sample Channel

Measures the signal attached to the specified channel and returns the measured voltage.

device fl
channel {0} ~a~---{?HE FT

CT1 AN =
high Tmnit (0.0) —T %7
W Nt (00—

sample

The AI Sample Channel VI performs a single, untimed measurement of a channel. If an
error occurs, a dialog box appears giving you the option to stop the VI or continue.

Refer to Appendix A, DAQ Hardware Capabilities, for the channel numbers and input
limits available with your DAQ device.
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Al Sample Channels

Performs a single voltage reading from each of the specified channels.

derice

channels (D) "'*"""""“.-[:N,E F samples
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The AI Sample Channels VI measures a single voltage from each of the specified analog
input channels. If an error occurs, a dialog box appears, giving you the option to stop the
VI or continue.

Refer to Appendix A, DAQ Hardware Capabilities, for the channel numbers and input
limits available with your DAQ device.
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Analog Input Vis

This chapter describes the Intermediate Analog Input VIs. These VIs
are convenient, but they lack flexibility.

You can access the Intermediate Analog Input VIs by choosing
Functions»Data Acquisition»Analog Input. The Intermediate Analog

Input VIs are the VIs on the second row of the Analog Input palette, as
shown below.
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Handling Errors

LabVIEW makes error handling easy with the Intermediate Analog
Input VIs. Each intermediate-level VI has an error in input cluster and
an error out output cluster. The clusters contain a Boolean that
indicates whether an error occurred, the error code for the error, and the
name of the VI that returned the error. If error in indicates an error, the
VI returns the error information in error out and does not continue to

run.
Note: The AI Clear VI is an exception to this rule—this VI always clears the
acquisition regardless of whether error in indicates an error.
When you use any of the Intermediate Analog Input VIs in a While
Loop, you should stop the loop if the status in the error out cluster
© National Instruments Corporation 15-1
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reads TRUE. If you wire the error cluster to the General Error Handler
VI, the VI deciphers the error information and describes the error to
you.

The General Error Handler VI is in Functions»Time and Dialog in
LabVIEW.

Intermediate Analog Input VI Descriptions

The following Intermediate Analog Input VIs are available.

Al Clear

Clears the analog input task associated with taskID in.

taskID in ke taskID out
error in (ne error) —ocom S Bl grrgr out

The AI Clear VI stops an acquisition associated with taskID in and release associated
internal resources, including buffers. Before beginning a new acquisition, you must call
the AI Config VI. Refer to Chapter 17, Advanced Analog Input Vls, for description of the
AT Control VI.

Note: The Al Clear VI always clears the acquisition regardless of whether error
in indicates that an error occurred.

When you use any of the Intermediate Analog Input VIs in a While Loop, you should stop
the loop if the status in the error out cluster reads TRUE. If you wire the error cluster to
the General Error Handler VI, the VI deciphers the error information and describes the
error to you.

The General Error Handler VI is in Functions»Time and Dialog in LabVIEW. For more
information on this VI, refer to your LabVIEW User Manual.
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Al Config

Configures an analog input operation for a specified set of channels. This VI configures
the hardware and allocates a buffer for a buffered analog input operation.

[nterchannel Delay [zecs) (board default]
F handle structure s,

coupling & input config (ho change:0
ifiput lirmitz [no change

device il taskiD
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[arowp] [ E error out
error in [no error
~ [rrnber of buffers] (1
allocation made [no change: 0
[nurmber of A= boards] [no change:-1

You can allocate more than one buffer only with the following devices.
e (Macintosh) NB-A2000, NB-A2100, and NB-A2150
*  (Windows) EISA-A2000, AT-A2150, and AT-DSP2200

Refer to Appendix A, DAQ Hardware Capabilities, for the channel ranges, input limits,
and scanning order you can use with your National Instruments DAQ device.

Al Read

Reads data from a buffered data acquisition.

acan backlog
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errsr in Enu errnrg error out
read feearch position (frorn mark) =
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The AI Read VI calls the AI Buffer Read VI to read data from a buffered analog input
acquisition.
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Al Single Scan

Returns one scan of data from a previously configured group of channels.

data remaining
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opcode 5-5CAN L scaled data
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If you have already started an acquisition with the AI Start VI, this VI reads one scan
from the acquisition buffer data, or the onboard FIFO if the acquisition is not buffered.
If you have not started an acquisition, this VI starts an acquisition, retrieves a scan of
data, and then terminates the acquisition. The group configuration determines the
channels the VI samples.

If you do not call the AI Start VI, this VI initiates a single scan using the fastest safe
channel clock rate. You can alter the channel clock rate with the Al Config VI.

If you run the AI Start VI, a clock signal initiates the scans.

You must use the AI Start VI to set the clock source to external, for externally-clocked
conversions.

If clock sources are internal and you do not allocate memory, a timed nonbuffered
acquisition begins when you run the AI Start VI. You use this type of acquisition for
synchronizing analog inputs and outputs in a point-to-point control application. The
following devices do not support timed, nonbuffered acquisitions.

e (Macintosh) NB-A2000, NB-A2100, and NB-A2150
e  (Windows) AT-DSP2200, EISA-A2000, and AT-A2150

Note: LabVIEW restarts the device in the event of a FIFO overflow during a
timed, nonbuffered acquisition.

When you set opcode to 1 for a nonbuffered acquisition, the VI reads one scan from the
FIFO and returns the data. If opcode is 2, the VI reads the FIFO until it is empty and
returns the last scan read.
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Al Start

Starts a buffered analog input operation. This VI sets the scan rate, the number of scans
to acquire, and the trigger conditions. The VI then starts an acquisition.
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Refer to Appendix A, DAQ Hardware Capabilities, for the channel ranges, input limits,
scanning order, triggers, clocks and you can use with your National Instruments DAQ
device.
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This chapter describes the Analog Input Utility VIs. These VIs—AI
Read One Scan, AI Waveform Scan, and AI Continuous Scan—are
single-VI solutions to common analog input problems. The Analog
Input Utility VIs are intermediate-level VIs, so they rely on the
advanced-level VIs. You can refer to Chapter 17, Advanced Analog
Input VIs, for additional information on the inputs and outputs and how
they work.

You can access the Analog Input Utilities palette by choosing
Functions»Data Acquisition»Analog Input» Analog Input Utilities.
The icon that you must select to access the Analog Input Utility VIs is
on the bottom row of the Analog Input palette, as shown below.

EEQ] Analog Input
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Analog Input Utility Vis

Handling Errors

LabVIEW makes error handling easy with the intermediate-level
Analog Input Utility VIs. Each intermediate-level VI has an error in
input cluster and an error out output cluster. The clusters contain a
Boolean that indicates whether an error occurred, the error code for the
error, and the name of the VI that returned the error. If error in
indicates an error, the VI returns the error information in error out and
does not continue to run.
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When you use any of the Analog Input Utility VIs in a While Loop, you
should stop the loop if the status in the error out cluster reads TRUE. If
you wire the error cluster to the General Error Handler VI, the VI
deciphers the error information and describes the error to you.

The General Error Handler VI is in Functions» Time and Dialog in
LabVIEW. For more information on this VI, refer to your LabVIEW
User Manual.

Analog Input Utility VI Descriptions

The following VIs are available through the Analog Input Utility subpalette.

Al Continuous Scan

Makes continuous, time-sampled measurements of a group of channels, stores the data in
a circular buffer, and returns a specified number of scan measurements on each call.

buffe zice (1000 scans]
coupling & irput condig (no... @
input limit= (no change ) o
device ] scaled data
channels (0} = ""S‘i“” L rurnber read
mumber of zoans to read (S00] —l_ 'g =aan backlog
scan rate {1000 scans Fsed] E- i actual scan perlod (sec)

—’_I"_[

error in [no error]) error ont
iteratien (init:0] i
olear asquisition [y R T— 4
[rumber of AU beads| na..
m The AI Continuous Scan VI scans a group of channels indefinitely, as
) - you might do in data logging applications. Place the VI in a While Loop
Itteerrnaqtilr?eﬂ and wire the loop’s iteration terminal to the VI iteration input.

Also wire the condition that terminates the loop to the clear acquisition input, inverting
the signal if necessary so that it reads TRUE on the last iteration. On iteration 0, the VI
calls the AI Config VI to configure the channel group and hardware and allocates a data
buffer; the VI calls the AI Start VI to set the scan rate and start the acquisition. On each
iteration, the VI calls the Al Read VI to retrieve the number of measurements specified
by number of scans to read, scales them, and returns the data as an array of voltages.
On the last iteration (when clear acquisition is TRUE) or if an error occurs, the VI calls
the AI Clear VI to clear any acquisition in progress. You should not need to call the Al
Continuous Scan VI outside of a loop, but if you do, you can leave the iteration and clear
acquisition inputs unwired.

When calling the AI Continuous Scan VI in a loop to read portions of the data from the
ongoing acquisition, you must read the data fast enough so that newly acquired data does
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not overwrite it. The scan backlog output tells you how much data acquired by the VI,
but remains unread. If the backlog increases steadily, your new data may eventually
overwrite old data. Retrieve data more often, or adjust the buffer size, the scan rate, or
the number of scans to read to fix this problem

Refer to Appendix A, DAQ Hardware Capabilities, for the channel ranges, input limits,
and scanning order you can use with your National Instruments DAQ device.

Al Read One Scan

Measures the signals on the specified channels and returns the measurements in an array
of voltages or binary values.

coupling & input config (no change |0 ey
input limits (no change)

N qle\rt_iﬁ.); '1 LFIH‘ sealkeddata
channels -

; . 5 |k binary data
output units Csoaled:1) . F-errnr aut

error 1 Lhe error) :
iteration Cinit:0)
[nurnber of &MUK boards] (00

m The AI Read One Scan VI performs an immediate measurement of a

group of one or more channels. If you place the VI in a loop to take
multiple measurements from a group of channels, wire the loop iteration
terminal to the VI iteration parameter.

iteration
terminal

On iteration 0, this VI calls the AI Config VI to configure the channel group and
hardware, then calls the Al Single Scan VI to measure and report the results. On
subsequent iterations, the VI avoids unnecessary configuration and calls only the Al
Single Scan VI. If you call the AI Read One Scan VI once to take a single measurement
from the group of channels, the iteration parameter can remain unwired.

Refer to Appendix A, DAQ Hardware Capabilities, for the channel ranges, input limits,
and scanning order available with your DAQ device.
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Al Waveform Scan

Acquires the specified number of scans at the specified scan rate and returns all the data
acquired. You can trigger the acquisition.

time Hrnit in zec (compute...
trigger and clack (no trig, ... seccceeemoo
coupling & nput config (no. .. oy
input Timils (no change)
derice

chasnels (0}

| |E
wWHVE scabed data

ad N .
pumber of Scans J_ s artual szan period (sec)
scan rate (1000 scans fsec) ﬂ error out
error in (a0 error)

iteration init:0)

tlear acquisition (Yes: T} -
[rurrbet of &MU boards ] (o

m The AI Waveform Scan VI acquires a specified number of scans from a

channel group at a specified scan rate. If you place this VI in a loop to
take multiple acquisitions from the same group of channels, wire the
iteration terminal of the loop to the VI iteration input.

iteration
terminal

Also wire the condition that terminates the loop to the VI clear acquisition input,
inverting the signal if necessary so that it reads TRUE on the last iteration. On iteration
zero, this VI calls the AI Config VI to configure the channel group and hardware and
allocate a data buffer. On each iteration, this VI calls the AI Start and AI Read VIs. The
Al Start VI sets the scan rate and trigger conditions and starts the acquisition. The VI
stores the measurements in the buffer as they are acquired, and the Al Read VI retrieves
them from the buffer, scales them, and returns all the data as an array of voltages. On the
last iteration (when clear acquisition is TRUE) or if an error occurs, the VI also calls the
Al Clear VI to clear the acquisition in progress. If you call the AI Waveform Scan VI
only once, you can leave iteration and clear acquisition unwired.

Refer to Appendix A, DAQ Hardware Capabilities, for the channel ranges, input limits,
scanning order, triggers, and clocks you can use with your National Instruments DAQ
device.

Note: These VIs use an uninitialized shift register as local memory to remember
the taskID for the group of channels between VI calls. You normally use
one VI in one place on your diagram, but if you use it more than once, the
multiple instances of the VI share the same taskID. All calls to one of these
VIs configure, read data from, or clear the same acquisition. Occasionally
you may want to use each VI in multiple places and have each instance
refer to a different taskID (for example, when you measure two devices
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simultaneously). Save a copy of the VI with a new name (for example,
Al Waveform Scan R) and make your new VI reentrant.

Note: For all Analog Input Utility VIs, if your program iterates more than 23! - |
times, do not wire the iteration input to the loop iteration terminal. Instead,
set iteration fo 0 on the first loop, then to any positive value on all other
iterations. The VI reconfigures and restarts if iteration <0.
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This chapter contains reference descriptions of the Advanced Analog
Input VIs. These VIs are the interface to the NI-DAQ software and are
the foundation of the Easy, Utility and Intermediate Analog Input VIs.

You can access the Advanced Analog Input palette by choosing
Functions»Data Acquisition»Analog Input»Advanced Analog Input.
The icon that you must select to access the Advanced Analog Input VIs
is on the bottom row of the Analog Input palette, as shown below.

EI:I Analog Input &

Al Al L] Al
HULT FT || HWLTFT || @ME FT || OMEFT

E,IL:JL ] = ADu k Advanced

Analog Input VIs

Advanced Analog Input VI Descriptions

The following Advanced Analog Input VIs are available.

Al Buffer Config

Allocates memory for LabVIEW to store analog input data until the AI Buffer Read VI
can deliver it to you. LabVIEW refers to the buffer(s) allocated by the AI Buffer Config
VI as internal buffers because you do not have direct access to them.

task ID [Contigl

scans per buffer (-1: no ch_.. —'_"\.f,
[ nurnber of buffers 1 (-1:... e =
error in {no error)

allacation made (0 no change)

DSF mermory handle (00

task ID out

DSP rermory handle oot
error out
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Note: (Macintosh) If you are using an NB-A2000 with an NB-DMA2800, buffer
size and total scans to acquire are both multiples of 32, and your computer
has block-mode memory, the driver will automatically use block-mode
DMA transfers.

Note: When you run the AI Control VI with control code set to 4 (clear), the VI
performs the equivalent of running the Al Buffer Config VI with allocation
mode set to 1. That is, both VIs deallocate the internal analog input data
buffers. However, acquisitions that use DSP or expansion card memory are
an exception. The AI Control VI does not deallocate DSP memory when
clearing an acquisition. You must explicitly call the AI Buffer Config VI to
deallocate DSP acquisition buffers.

Table 17-1 lists default settings and ranges for the AI Buffer Config VI. The first row
gives the values for most devices, and the other rows give the values for devices that are
exceptions to the rule.

Table 17-1. Al Buffer Config VI Device-Specific Settings and Ranges

Scans per Buffer | Number of Buffers | Allocation Mode
Device
Default Default Default
Setting | Range | Setting | Range | Setting | Range
Most devices 100 0, n=3 1 0,1 2 1,2
Lab-NB 100 n=3 1 0,1 2 1,2
Lab-LC
AT-DSP2200 100 n=0 1 n=0 2 1<n<4
NB-A2000 100 n=0 1 n=0 2 1,2
EISA-A2000
NB-A2100
NB-A2150
AT-A2150
5102 devices 100 n=3 1 1 2 1,2

LabVIEW Function and VI Reference Manual 17-2 © MNational Instruments Corporation



Chapter 17 Advanced Analog Input Vis

Al Buffer Read

Returns analog input data from the internal data buffer(s).

rnark locations

conditional retrieval specification Coff) acquisition state
task ID Fead task ID out
number to read ] nurnber Fead
read/search location (no change) MFﬂ.{ scakd data
output type ( scaled :1) r binary data
error in (no error) | | error out

tirne Tirmit (no change)

=can backlog
read specification (no change) sooeeomconod

Note: When the VI reads from the trigger mark, it does not return data until the
acquisition completes for the buffer containing the trigger.

Al Clock Config

Sets the channel and scan clock rates.

[ configuration made |
[ retrigger mode ]

tazk ID task ID out
which clogk ———|5ent iy B actual clock rate specification
clock frequency — 1™/ &=
error in (no error) ==X 1 error out
clock Soupce oo H
[ alternate clock rate specification | e :

Refer to Appendix A, DAQ Hardware Capabilities, for the clocks available with your
DAQ device.

For devices that have only a channel clock (Lab-LC, Lab-NB, NB-MIO-16, Lab-PC+,
PCI-1200, PC-LPM-16, DAQCard-500, DAQCard-700, and DAQCard-1200), you
cannot set independent channel and scan clock rates. Setting one resets the other because
the channel rate equals scan rate/number of channels to scan.

For devices that have no channel clock (NB-A2000, NB-A2100, NB-A2150,
EISA-A2000, AT-A2150, and AT-DSP2200), setting the channel clock produces an
€rror.

If you specify a value of 0 for the scan clock rate, interval scanning turns off, and channel
scanning (or round-robin scanning) proceeds at the channel clock rate. This option is
meaningful only for devices with independent channel and scan clocks.

The clock rate is the rate at which LabVIEW samples data or acquires scans. You can
express the clock rate three ways—with clock frequency, with clock period, or with
timebase source, timebase signal, and timebase divisor. The VI searches these
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parameters in that order and sets the clock rate using the first one with a value not equal
to -1.

Table 17-2 lists default settings and ranges for the controls of the AI Clock Config VI.

Table 17-2. Device-Specific Settings and Ranges for Controls in the Al Clock Config VI

Configuration |Retrigger

Mode Mode Which Clock | Clock Source
Device
Default Default |Default Default
Setting | Range | Setting |Setting | Range | Setting | Range
AT-MIO-16E-2 1 1,3 no 1 1,2 1 1,2
AT-MIO-64E-3 support 4<n<l11

NEC-MIO-16E-4
PCI-MIO-16E-1
PCI-MIO-16E-4
PCI-MIO-16XE-10

AT-MIO-16E-10 1 1,3 no 1 1,2 1 1,2

AT-MIO-16DE-10 support 4<n<9
AT-MIO-16XE-50
PCI-MIO-16XE-50

AT-A2150 1 1,3 no 1 1 1 1<n<3

NB-A2150 support

NB-A2100

NB-A2000

AT-DSP2200

EISA-A2000

PC-LPM-16 1 1,3 no 1 1,2 1 1,2

DAQCard-500 support

DAQCard-700

Lab-PC

Lab-LC 1 1,3 no 1 2 1 1,2

Lab-NB support

NB-MIO-16

All Other Devices 1 1,3 no 1 1,2 1 1<n<3
support
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Al Control

Controls the analog input tasks and specifies the amount of data to acquire.

rinirnurn pretrigger scans to acquire —_|_|
task ID Contrl task ID out
control code _|—_'_r\
total scans to acquire ol =
error in (no error) el error out
[nurnber of buffers to acquire]

1%  Note: You cannot use this VI to start an acquisition when you use a Lab and 1200
Series device, PC-LPM-16, DAQCard-500, or a DAQCard-700 device to
scan multiple SCXI channels in multiplexed mode. For this special case,
you must use the Al SingleScan VI to acquire data. (For more information
about the Al SingleScan VI, refer to its description in this chapter.)
However, you can use the AI Control VI for a Lab and 1200 Series device,
PC-LPM-16, DAQCard-500, or DAQCard-700 device when you scan SCXI
channels in parallel mode or sample a single SCXI channel in multiplexed
mode. You can use this VI for an MIO device scanning SCXI channels in
either mode.

Note: Nonbuffered acquisitions are not supported for the following devices.

« (Macintosh) NB-A2000, NB-A2100, or NB-A2150
«  (Windows) AT-DSP2200, EISA-A2000, or AT-A2150
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Table 17-3 lists default settings and ranges for the AI Control VI.

Table 17-3. Device-Specific Settings and Ranges for the Al Control VI

Minimum
Pretrigger Number of
Device Control Total Scans Scans to Buffers to
Code to Acquire Acquire Acquire

D S* R* DS* R* DS* R* DS* R*

AT-DSP2200, 0 0,1,4 0 0, n=0 0 0, n=3 1 n=0
EISA-A2000,

AT-A2150,

NB-A2000,

NB-A2150,

PC-LPM-16, 0 0,1,4 0 0, n=3 0 no 1 1
DAQCard-500, support
DAQCard-700

MIO-E Series 0 0,1,4 0 0, n=3 0 0, n=3 1 1
5102 Devices 0 0,1,4 0 n=0 0 n=0 1 1
All Other Devices 0 0,14 0 0, n=3 0 n=0 1 1

* DS = Default Setting; R = Range

Al Group Config

Defines what channels belong to a group and assigns them.

derice I:GWIFIP task ID
[ group (O] < A :scan width
channel scan Tlist (empty) ﬁ e error out
error in (no error)

Refer to Appendix A, DAQ Hardware Capabilities, for the channel ranges and scanning
order available with your DAQ device.
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Table 17-4 lists default settings and ranges for the AI Group Config VI. The first row of
the table gives the values for most devices, and the other rows give the values for devices
that are exceptions to the rule.

Table 17-4. Device-Specific Settings and Ranges for the Al Group Config VI

Group Channel Scan List
Device

Default

Setting Range Default Setting Range
Most Windows Devices 0 0<n<15 all channels 0<n<15
Most Macintosh Devices 0 0<n<15 all channels 0<n<15
AT-MIO-64F-5 0 0<n<15 all channels 0<n<63
AT-MIO-64E-3
AT-A2150, EISA-A2000 0 0<n<15 all channels 0<n<3
AT-DSP2200 0 0<n<l15 all channels 0,1
Lab-PC+, PCI-1200, 0 0<n<l15 all channels 0<n<7
DAQCard-1200
Lab-LC, Lab-NB 0 0<n<15 all channels 0<n<7
NB-A2000, NB-A2150 0 0<n<15 all channels 0<n<3
NB-A2100 0 0<n<15 all channels 0,1
5102 Devices 0 0<n<15 all channels 0,1

Note: The Lab-LC, Lab-NB, Lab-PC+, PCI-1200, PC-LPM-16, DAQCard-500,
DAQCard-700, and DAQCard-1200 must scan channel lists containing
multiple channels from channel n (n =2 0) to channel 0 in sequential order,
including all channels between n and 0. The NB-A2000, NB-A2150,
EISA-A2000, and AT-A2150 allow only the following scan lists: (0), (1),
(2), (3), (0, 1), (2, 3), and (0, 1, 2, 3). The NB-A2100 allows the following
scan lists: (0), (1), (0, 1), and (1, 0).

The channel scan list range shown above is for single-ended mode. Please

refer to Appendix A, DAQ Hardware Capabilities, to determine the valid
range for channels in differential mode.
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SCXI modules in multiplexed mode must scan channels in ascending consecutive order,
starting from any channel on the module. The module order you specify can be arbitrary.
SCXI modules in parallel mode must follow the DAQ device restrictions on the order of
channel scan lists. Refer to the Channel, Port, and Counter Addressing section of
Chapter 3, Basic LabVIEW Data Acquisition Concepts, in the LabVIEW Data Acquisition
Basics Manual for information about SCXI channel string syntax.

Al Hardware Config

Configures either the upper and lower input limits or the range, polarity, and gain. The
Al Hardware Config VI also configures the coupling, input mode, and number of
AMUX-64T devices. The configuration utility determines the default settings for the
parameters of this VI.

[ nurmber of AMUE ] —_|_|
task ID Hr dwit task ID out
channe] lizt sepeessaqCantis group channel settings
input limits m'\.\;
error in (no error) ce=d ﬂ
[ alternate input limits settings ]
[ ehannel input configuration ]

error out

You can use this VI to retrieve the current settings by wiring taskID only or by wiring
both taskID and channel list. If channel list is empty, the VI configures channels on a
per group basis. This means that the configuration applies to all the channels in the
group. When you specify one or more channels in channel list, the VI configures
channels on a per channel basis. This means that the configuration applies only to the
channels you specify. This VI always returns the current settings for the entire group.

When the configuration is on a per channel basis, channel list can contain one or more
channels. The channels in channel list must belong to the group named by taskID. You
specify channels the same way you specify them for the AI Group Config VI. If you take
multiple samples of a channel within a scan and you want to change the hardware
configuration for that channel at each sample, you must supply the settings for each
instance of the channel within the scan. If an element of channel list specifies more than
one channel, the corresponding element of the other arrays applies to all those channels.

The VI applies the values contained in the configuration arrays (upper input limits,
lower input limits, coupling, range, polarity, gain, and mode) to the channels in the
group (if you configured on a per group basis) or the channels in channel list (if you
configured on a per channel basis) in the following way. The VI applies the values listed
first in the arrays (at index 0) to the first channel in the group or the channel(s) listed in
index O of channel list. The VI applies the values listed second in the configuration
arrays (at index 1) to the second channel in the group or channel(s) listed in index 1 of
channel list. The VI continues to apply the values in this fashion until the arrays are
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exhausted. If channels in the group or channel list remain unconfigured, the VI applies
the final values in the arrays to all the remaining unconfigured channels.

Table 17-5 gives examples of this method. The parameter channel scan list, which is
part of the AI Group Config VI, is used in the following table.

Table 17-5. Al Hardware Config Channel Configuration

Configuration
Basis Array Values Results

Group Group channel scan list = 1, 3,4, 5,7 All channels in the group have
channel list is empty input limits of —1.0 to +1.0.
lower input limit [0] =-1.0
upper input limit [0] = +1.0

Group Group channel scan list = 1, 3,4, 5,7 Channel 1 has input limits of
channel list is empty —1.0 to +1.0. Channel 3 has
lower input limit [0] =-1.0 input limits 0.0 to +5.0.
upper input limit [0] = +1.0 Channels 4, 5, and 7 have input
lower input limit [1] = 0.0 limits of —10.0 to +10.0.
upper input limit [1] = +5.0
lower input limit [2] =-10.0
upper input limit [2] = +10.0

Channel Group channel scan list = 1, 3,4, 5,7 Channels 1, 3, 4, and 5 have
channel list [0] = 1 input limits of —1.0 to +1.0.
channel list [1] = 3:5 Channel 7 has the default input
lower input limit [0] =-1.0 limits set by the configuration
upper input limit [0] = +1.0 utility. It is unchanged because

it is not listed in channel list.
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Table 17-5. Al Hardware Config Channel Configuration (Continued)

channel list is empty

lower input limit [0] =-1.0
upper input limit [0] = +1.0
lower input limit [1] =-1.0
upper input limit [1] =+1.0

Configuration
Basis Array Values Results

Channel Group channel scan list = 1, 3,4, 5,7 Channel 1 has input limits of
channel list [0] = 1 —1.0 to +1.0. Channels 3, 4,
channel list [1] = 3:5 and 5 have input limits of 0.0
lower input limit [0] =-1.0 to +5.0. Channel 7 has the
upper input limit [0] = +1.0 default input limits set by the
lower input limit [1] = 0.0 configuration utility.
upper input limit [1] = +5.0

Group Group channel scan list =0, 1, 0, 1 Channels 0 and 1 have input

limits of —1.0 to +1.0 the first
time they are sampled and
input limits of —10.0 to +10.0
the second time they are
sampled.

LabVIEW Function and VI Reference Manual

lower input limit [2] =-10.0
upper input limit [2] = +10.0
lower input limit [3] =-10.0
upper input limit [3] = +10.0

The range, polarity, and gain determine the lower and upper input limits. When you
wire valid input limit arrays (that is, arrays of lengths greater than zero) the VI chooses
suitable input ranges, polarities, and gains to achieve these input limits. The VI ignores
the range, polarity, and gain arrays.

If you do not wire the input limit arrays, the VI checks range, polarity, and gain. Where
the VI finds an array, it sets the corresponding input property to the values in the array.
Where the VI does not find an array, it leaves the corresponding input property
unchanged.

For some devices and SCXI modules, onboard jumpers set range, polarity, and/or gain.
LabVIEW does not alter the settings of jumpered parameters when you specify input
limits. If LabVIEW cannot achieve the desired input limits using the current jumpered
settings, it returns a warning.

To override the current jumper values, you must call the Al Hardware Config VI and
specify range, polarity, and/or gain explicitly. The configuration utility determines the
initial setting for these parameters (the default value is the factory jumper setting).

If a pair of input limits values are both 0, the VI does not change the input limits.
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SCXI channel hardware configurations are actually a combination of SCXI module and
DAQ device settings and require special considerations. The way you specify channels
indicates whether LabVIEW alters the SCXI module settings and/or the DAQ device
settings. The input limits parameter always applies to the entire acquisition path.

When you configure on a per group basis, LabVIEW may alter both SCXI module and
DAQ device settings. In this case, gain applies to the entire path and is the product of the
SCXI channel gain and acquisition device channel gain. LabVIEW sets the highest gain
needed on the SCXI module, then adds DAQ device gain if necessary.

When configuration is on a per channel basis, you can specify the channels in one of three
ways. The first way is to specify the entire path, as in the following example.

OBO!SC1!MD1!CHO:7

(Windows) Also, you can specify the path using channel names configured in the DAQ
Channel Wizard, as in the following example.

temperature

If you use either of these methods, LabVIEW can alter both SCXI and DAQ device
settings, and gain applies to the product of the SCXI channel gain and the DAQ device
gain. LabVIEW sets the highest gain needed on the SCXI module, then adds DAQ device
gain if necessary.

The second method is to specify the SCXI channel only, as in the following example.
SC1!MD1!CHO:7

This specification indicates that LabVIEW should alter SCXI settings only. Additionally,
gain applies only to the SCXI channel.

The third way is to specify the acquisition device channel only, as in the following
example.

OBO

In this case, LabVIEW alters only DAQ device settings. The gain parameter applies to
the onboard channel only.

Refer to Appendix A, DAQ Hardware Capabilities, for the channel ranges, input limits,
and scanning order available with your DAQ device.

Tables 17-6 through 17-9 list default settings and ranges for the AI Hardware Config VI.
A tilde (~) indicates that the parameter is configurable on a per group basis only. This

means you cannot configure it by channel. The first row of these tables give the values
for most devices, and the other rows give the values for devices that are exceptions to the
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rule. If you did not set the default settings with the configuration utility, use the default
settings shown in these tables.

Table 17-6. Device-Specific Settings and Ranges for the Al Hardware Config VI

Channel Input
Configuration Cluster
Device Number Channel
Coupling Input Mode ~ of AMUX List

DS* R* DS* R* DS* R* DS*

Most Devices 1 1 1 1 <n<3 0 0<n<4 | empty
EISA-A2000, 2 1,2 2 2 0 0 empty
NB-A2000

PC-LPM-16, 1 1 2 2 0 0 empty
Lab-LC, Lab-NB

Lab and 1200 1 1 2 1 <n<3 0 0 empty
Series devices

AT-MIO-16X, 1 1 I (no~)| 1<n<3 0 0<n<4 | empty
AT-MIO-64F-5

AT-A2150, 1 1,2 2 2 0 0 empty
AT-DSP-2200,

NB-A2100,

NB-A2150

DAQCard-500, 1 1 2 1,2 0 0 empty

DAQCard-700

5102 Devices 5 1,2 2 2 0 0 empty

* DS = Default Setting; R = Range

Note: Channels 0 and 1 and channels 2 and 3 must have the same coupling for
the NB-A2150, AT-DSP2200, and AT-A2150.
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Al Parameter

Configures and retrieves miscellaneous parameters associated with Analog Input of an
operation of a device that are not covered with other Al VIs.

=tring in
float i
walue |
bBoalaan im -
tcarfaknll?ellg ,_.aran]- tazk ID out
operation J_Af error out
parameter name =tring out
error in (no ermror) i Float ot
walue out

R boaolean out

Al SingleScan

Returns one scan of data. If you started an acquisition with the AI Control VI, this VI
reads one scan of the data from the internal buffer. On the Macintosh and in Windows,
the VI reads from the onboard FIFO if the acquisition is nonbuffered. If you have not
started an acquisition, this VI starts an acquisition, retrieves a scan of data, and then
terminates the acquisition. The group configuration determines the channels the VI
sample. This VI does not support 5102 devices.

aequisition state

task ID Single task I out
cutput type Csoaled ) Soan scakd data
opeods (e changs) — ™ S binary data
error in (no error) ) error out
time Timit Cno change) data remaining

If you do not call the AI Control VI, this VI initiates a single scan using the fastest and
most safe channel clock rate. You can, however, alter the channel clock rate with the Al
Clock Config VI.

If you run the AI Control VI with control code set to 0 (Start), a clock signal initiates the
scans.

If you want externally clocked conversions, you must use the AI Clock Config VI to set
the clock source to external.

If clock sources are internal and you do not allocate memory, a timed, nonbuffered
acquisition begins when you run the AI Control VI with control code set to 0. This type
of acquisition is useful for synchronizing analog inputs and outputs in a point-to-point
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control application. The following devices do not support timed, nonbuffered
acquisitions.

e (Macintosh) Lab-NB, Lab-LC, NB-A2000, NB-A2100, and NB-A2150
e  (Windows) AT-DSP2200, EISA-A2000, and AT-A2150

Note: In the event of a FIFO overflow during a timed, nonbuffered acquisition,
LabVIEW restarts the device.

Table 17-7 lists default settings and ranges for the Al SingleScan VI.

Table 17-7. Device-Specific Settings and Ranges for the Al SingleScan VI

Output Type Opcode Time Limit
Device
DS R DS R DS R
AT-DSP2200,EISA-A2000,| 1 1=n<3 1 1 variable | n=0
AT-A2150, NB-A2000,
NB-A2100, NB-A2150
All Other Devices 1 1<n<3 1 1<n<4 1<n<4 n=0
Al Trigger Config
Configures the trigger conditions for starting the scan and channel clocks and the scan
counter.

additional trigger specific...
Terve] (0,000 —— E

task ID Tr'ig%rg:ri task ID out
trigger type (0: no change) Eﬁ_‘}% B 3ctual trigger specificatior
mode (0: no change) ] = error out

i —
error in {no error) mr‘ E
trigger source Cempty string)

trigger or pause condition ...

Refer to Appendix A, DAQ Hardware Capabilities, for information on the triggers
available with your DAQ device. Refer to your E Series device user manual for a detailed
description of the triggering capabilities of the device.

The following is a detailed description of trigger types 1 (analog trigger), 2 (digital
trigger A), and 3 (digital trigger B) as they apply to three types of applications:
posttrigger, pretrigger with software start, and pretrigger with hardware start. The other
trigger types are discussed at the end of this section.
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Application Type 1: Posttriggered Acquisition (Start
Trigger Only)

If total scans to acquire is = 0 and pretrigger scans to acquire is 0, you are performing
a posttriggered acquisition. A trigger type of 1 or 2 (analog trigger or digital trigger A,
respectively) starts the acquisition (digital trigger B is illegal). You provide a start
trigger. Refer to Table 17-10, parts 2 and 3, to determine the default pin to which you
connect your trigger signal.On some devices you can specify an alternative source
through the trigger source parameter.

With E Series devices, if you are using an analog trigger and the analog signal is
connected to one of the analog input channels, that channel must be first in the scan list.
This restriction does not apply if you connect the analog signal to PFIO0.

! = acquired data —
B i,""*\
I —
R N SN
signal a0 . J|': 1 7
SV I —
5.0 : —

In the above illustration, total scans to acquire is 1000 and pretrigger scans to acquire
is 0. The start trigger can come from digital trigger A or an analog trigger (trigger or
pause condition =1: Trigger on a rising edge or slope, level = 5.5, window size = 0. 2).

Application Type 2: Pretriggered Acquisition (for all
trigger types)

If total scans to acquire and pretrigger scans to acquire are both > 0, a trigger type
of 1 or 2 (analog trigger or digital trigger A, respectively) starts the acquisition of
posttrigger data after the pretrigger data is acquired. The trigger is called a stop trigger
because the acquisition does not stop until the trigger occurs. A software strobe starts the
acquisition. This is a software start pretrigger acquisition. You provide the stop trigger.
Refer to Table 17-10, parts 2 and 3, to determine the default pin to which you connect
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your trigger signal. On some devices, you can specify an alternative source through the
trigger source parameter.

|+—— acquired data — |
6.0 r’rﬁ\i
. 5.0 | .‘k

mput - ) NN
signal . N }

NS [ —
. \_ A

1
p— :

1

1
stop |_|
trigger

In the above illustration, total scans to acquire is 1000 and pretrigger scans to acquire
is 900. The stop trigger can come from digital trigger A or an analog trigger (trigger or
pause condition = 1: Trigger on rising edge or slope, level = 3.7, window size = 0.5).

With E Series devices, if you are using an analog trigger and the analog signal is
connected to an analog input channel, that channel must be the only channel in the scan
list (no multiple channel scan allowed). This restriction does not apply if you connect the
analog signal to PFIO.

Application Type 3: Pretriggered Acquisition (Start and
Stop Trigger)

Application Type 3 is used infrequently. Unless you plan to provide both a start trigger
and a stop trigger, skip this section.

On MIO devices, you can enable both the start trigger and the stop trigger. (You must call
the AI Trigger Config VI twice to do this.) In this case, a digital or analog trigger signal
starts the acquisition rather than a software strobe. This is a hardware start pretriggered
acquisition. You provide both the start trigger (as described in Application Type I) and the
stop trigger (as described in Application Type 2). Refer to Table 17-10 , parts 2 and 3, to
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determine the default pin to which you connect your trigger signal. On some devices, you
can specify an alternative source through the trigger source parameter.

le— acquired data——m|
Y

Ll r \ i

input 50 - .g .\

NS |
signal 40 N Y L
\Vi —~—

30

i
shart |_| !

tigger

stap rL

bigger

In the above illustration, total scans to acquire is 1000 and pretrigger scans to acquire
is 900. The start trigger can come from digital trigger B or an analog trigger (trigger or
pause condition = 1: Trigger on rising edge or slope, level = 5. 5, window size = 0.2).
The stop trigger can come from digital trigger A or an analog trigger (trigger or pause
condition = 1: Trigger on rising edge or slope, level = 4.0, window size = 0. 2). Notice
that some of the data after the start trigger has been discarded, because all 900 pretrigger
scans have been collected and the stop trigger is more than 900 scans away from the start
trigger.

When using analog triggering on E Series devices, there are several restrictions that
apply, as shown in Table 17-8.

Table 17-8. Restrictions for Analog Triggering on E Series Devices

Start Stop
Trigger Trigger Restrictions

Digital A | Digital B | None

Digital B | Analog Analog signal must be connected to PFI0, unless you are
scanning only one channel, in which case the input to that
channel can be used.

Analog Digital A | Analog signal must be first in scan list if it is connected to an
analog input channel.
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A trigger type of 4 (digital scan clock gating) enables an external TTL signal to gate the
scan clock on and off, effectively pausing and resuming an acquisition.

Channel clock and scan clock are the same on the NB-MIO-16. Therefore, if the scan
clock gate becomes FALSE, the current scan does not complete and the scan clock ceases
operation. When the scan clock gate becomes TRUE, the scan clock immediately begins
operation again, where it left off previously. You wire your signal to the EXTGATE pin.

A trigger type of 5 (analog scan clock gating) enables an external analog signal to gate
the scan clock on and off, effectively pausing and resuming an acquisition. A trigger type
of 6 allows you to use the output of the analog trigger circuitry (ATCOUT) as a general
purpose signal. For example, you can use ATCOut to start an analog output operation, or
you can count the number of analog triggers appearing at ATCOut.

Note: Trigger types 1, 5, and 6 on E Series devices use the same analog trigger

circuitry. All three types can be enabled at the same time, but the last one
enabled dictates how the analog trigger circuitry behaves. The

E Series restrictions described in the trigger applications apply to all three

trigger types.

Trigger type 5 on E Series devices uses the digital scan clock gate and the analog trigger
circuitry. Therefore, enabling trigger type 5 overwrites any settings made for trigger type
4.

For some devices, digital triggering is supported, but for these devices the source is
predetermined. Therefore, the trigger source parameter is invalid. Table 17-9 shows the
pin names on the I/O connector to which you should connect your digital trigger signal.

Table 17-9. Digital Trigger Sources for Devices with Fixed Digital Trigger Sources

Posttriggering Pretriggering
Device
Start Start Stop

Trigger Pin Trigger Pin Trigger Pin
MIO-16L/H, MIO-16DL/DH STARTTRIG* | STARTTRIG* STOPTRIG
NB-MIO-16L/H STARTTRIG* no support no support
AT-MIO-16X, AT-MIO-16F-5, EXTTRIG* EXTTRIG* EXTTRIG*
AT-MIO-64F-5
Lab and 1200 Series devices EXTTRIG no support EXTTRIG
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Table 17-9. Digital Trigger Sources for Devices with Fixed Digital Trigger Sources (Continued)

Posttriggering Pretriggering
Device
Start Start Stop
Trigger Pin Trigger Pin Trigger Pin
PC-LPM-16, DAQCard-500, no support no support no support

DAQCard-700

AT-DSP2200, EISA-A2000, EXTTRIG* no support EXTTRIG*
AT-A2150, NB-A2000,
NB-A2100, NB-A2150

* On the AT-MIO-16X, AT-MIO-16F-5, and AT-MIO-64F-5, the same pin is used for
both the start trigger and the stop trigger. Refer to your hardware user manual for more
details

Table 17-10 lists the default settings and ranges for the AI Trigger Config VI. The first
row of each table gives the values for most devices, and the other rows give the values
for devices that are exceptions to the rule.

Table 17-10. Device-Specific Settings and Ranges for the Al Trigger Config VI—Part 1

Trigger or
Trigger Pause
Device Type Mode Condition Level

DS* R* DS* R* DS* R* DS* R*

Most Devices 2 2,3 1 1sn<3| no support no support
AT-MIO-16E-10, 2 2<n<4 1 1sn< 3 1 1,2,7, no support
AT-MIO-16DE-10, 8

AT-MIO-16XE-50,
PCI-MIO-16XE-50

AT-MIO-16E-2, 2 1<n<6 1 1<n <3 1 1<n<8 0 -10
AT-MIO-64E-3, <n<
NEC-MIO-16E-4 10
Lab and 1200 2 2 1 1<n<3 no no
Series devices support support
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Table 17-10. Device-Specific Settings and Ranges for the Al Trigger Config VI—Part 1 (Continued)

Trigger or
Trigger Pause
Device Type Mode Condition Level

DS* R* DS* R* DS* R* DS* R*

PC-LPM-16, no support no support no support no support
DAQCard-500,

DAQCard-700

AT-DSP2200, 1 1,2 1 1<n<3 1 1,2 0 -2.828

AT-A2150, <n<

NB-A2100, 2.828

NB-A2150

EISA-A2000, 1 1,2 1 1<n <3 1 1,2 0 -5.12

NB-A2000 <n<
5.12

* DS = Default Setting; R = Range

Table 17-11. Device-Specific Settings and Ranges for the Al Trigger Config VI—Part 2

Additional Trigger Specifications

Trigger Source Cluster
Device (Analog)
Window Size Coupling
Default Default Default
Setting | Range | Setting | Range | Setting | Range
AT-MIO-16E-2 0 0=<n<I5, 0 0=n<20 no support
NEC-MIO-16E-4 PFIO
AT-MIO-64E-3 0 0<n<63, 0 0=n<20 no support
PFIO
EISA-A2000, 0 0<n<3 no support 2 1,2
NB-A2000
AT-A2150, 0 0<n<3 0 0<n< 1 1,2
NB-A2100, NB-A2150 5.656
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Table 17-11. Device-Specific Settings and Ranges for the Al Trigger Config VI—Part 2 (Continued)

Additional Trigger Specifications
Trigger Source Cluster
Device (Analog)
Window Size Coupling
Default Default Default
Setting | Range | Setting | Range | Setting | Range
AT-DSP2200 0 0,1 0 0 <n< 1 1,2
5.656
All Other Devices, no support no support no support
Device Trigger Source (Digital)
DS R
E Series Start Trigger PFIO PFI 0~9, RTSI 0~6, GPCTRO
E Series Stop Trigger PFI1 PFI 0~9, RTSI 0~6
E Series Digital Scan Clock Gate PFIO PFI 0~9, RTSI 0~6
All Other Devices no support*

* See Table 17-9 for devices with fixed digital trigger sources.

Table 17-12. Device-Specific Settings and Ranges for the Al Trigger Config VI—Part 4

Additional Trigger Specifications
Cluster
Device

Delay Skip Time

Count | Limit
DS R DS|R|DS| R

EISA-A2000, NB-A2000 0 0<n<655.35 no no
support | support

AT-A2150 0 0<n<2.05 no no
support | support
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Table 17-12. Device-Specific Settings and Ranges for the Al Trigger Config VI—Part 4 (Continued)

Additional Trigger Specifications
Cluster
Device
Delay Skip Time
Count | Limit
DS R DS|R|DS| R
NB-A2100, NB-A2150S 0 0<n<32.77 no no
support | support
NB-A2150C 0 0<n<16.38 no no
support | support
NB-A2150F 0 0<n<17.05 no no
support | support
AT-DSP2200 0 no support no no
support | support
All Other Devices no support no no
support | support
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This chapter describes the Easy Analog Output VIs in LabVIEW, which
perform simple analog output operations. You can run these VIs from
the front panel or use them as subVlIs in basic applications.

You can access the Easy Analog Output VIs by choosing
Functions»Data A cquisition»Analog Output. The Easy Analog Output
VIs are the VIs on the top row of the Analog Output palette, as shown
below.

[I:l Analog Dutput

Al AT Al AT
HULT FT [ | HULT FT || aHE FT || 9HE FT | <ef———— Easy Analog Output Vls

e w
[a]+, o]+, = gl .-
:}.‘rl :}i':ll \;ﬂ -\;ﬂ

A A R [ L} R
CONFIG | [ wRITE || START || "AIT || CLEAR

Easy Analog Output VI Descriptions

The following Easy Analog Output VIs are available.

AO Generate Waveform
Generates a voltage waveform on an analog output channel at the specified update rate.

d 3 —_— Al
dat te (1000 cdhatnnej?fﬁi mmnmnnand HULT FT
update rate I avetorm s

The AO Generate Waveform VI generates a multipoint voltage waveform on a specified
analog output channel. If an error occurs, a dialog box appears, giving you the option to
stop the VI or continue.
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AO Generate Waveforms

Generates multiple voltage waveforms on the specified analog output channels at the
specified update rate.

119?' — HO

channels fﬁg rnnnnnnn] HILT FT

update rate (1000 updatesfsec) — +%
waveforms ——C3 i

If an error occurs, a dialog box appears, giving you the option to stop the VI or continue.

Refer to Appendix A, DAQ Hardware Capabilities, for the channel numbers you can use
with your DAQ device.

A0 Update Channel

Writes a specified voltage value to an analog output channel.

device A

OME FT

channel {0} B .~
roltage B

The AO Update Channel VI writes a single update to an analog output channel. If an error
occurs, a dialog box appears, giving you the option to stop the VI or continue.

Refer to Appendix A, DAQ Hardware Capabilities, for the channel numbers and output
limits available with your DAQ device.

A0 Update Channels

Writes voltage values to each of the specified analog output channels.

device Ll
OHE FT
channels (0) .
roltages =

The AO Update Channels VI updates multiple analog output channels with single voltage
values. If an error occurs, a dialog box appears, giving you the option to stop the VI or
continue.

Refer to Appendix A, DAQ Hardware Capabilities, for the channel numbers you can use
with your DAQ device.
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This chapter describes the Intermediate Analog Output VIs. These
VIs—AO Write One Update, AO Waveform Gen, and AO Continuous
Gen—are single VI solutions to common analog output problems. The
intermediate-level VIs are convenient, but they lack flexibility. Because
all the VIs in this chapter rely on the advanced layer, you can refer to
Chapter 21, Advanced Analog Output Vls, for additional information on
the inputs and outputs and how they work.

You can access the Intermediate Analog Output VIs by choosing
Functions»Data Acquisition» Analog Output. The Intermediate Analog
Output VIs are the VIs on the second row of the Analog Output palette,
as shown below.

B[] Analog Dutput

i A0 AQ .
CONFIG | | WRITE || 2TART || wAIT || CLEAR Intermediate
B, || B || B, m@' B <& Analog Output Vis

Handling Errors

LabVIEW makes error handling easy with the Intermediate Analog
Output VIs. Each intermediate-level VI has an error in input cluster
and an error out output cluster. The clusters contain a Boolean that
indicates whether an error occurred, the error code for the error, and the
name of the VI that returned the error. If error in indicates an error, the
VI returns the error information in error out and does not continue

to run.
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Note: The AO Clear VI is an exception to this rule—this VI always clears the
acquisition regardless of whether error in indicates an error.

When you use any of the Intermediate Analog Output VIs in a While
Loop, you should stop the loop if the status in the error out cluster
reads TRUE. If you wire the error cluster to the General Error Handler
VI, the VI deciphers the error information and describes the error to
you.

The General Error Handler VI is in Functions»Time and Dialog in
LabVIEW. For more information on this VI, refer to your LabVIEW
User Manual.

Analog Output VI Descriptions

The following Analog Output VIs are available.

AO Clear
Clears the analog output task associated with taskID in.
taskID in cLEE R taskID out
error in (no error) !":‘:':«::'.! error out

The AO Clear VI always clears the generation regardless of whether error in indicates
an error.

A0 Config

Configures the channel list and output limits, and allocates a buffer for analog output
operation.

Tirnit zettings (no change)

b d]ev(iﬁt]a I:'F'I'JFIG taskiD

channels rolf “ nurmber of channels

buffer size (1000 updates) — B, [ R DSP handle structure out
[group] (O ’ error out

error in (no error)
allocate mode
'SP handle structure

Refer to Appendix A, DAQ Hardware Capabilities, for the channel ranges and output
limits available with your DAQ device.
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AO Start
Starts a buffered analog output operation. This VI sets the update rate and then starts the
generation.
taskiD in Rl taskiD out
number(-:-f buffer iteratiu:-;s (1; e TF'RT L actual update rate
update rate (1000 updatesfsec Sty
error in (no error) o= {1 error out
clock (update clock 1:1)
clock source Cinternal:1)
A0 Wait

Waits until the waveform generation of the task completes before returning.

tazklD in . tasklD out
update rate [1000 updates/sec] J—J )
check every M updates [5] nnr‘ =Tl error out
error in [no error)

Use the AO Wait VI to wait for a buffered, finite waveform generation to finish before

calling the AO Clear VI. The AO Wait VI checks the status of the task at regular intervals
by calling the AO Write VI and checking its generation complete output. The AO Wait
VI waits asynchronously between intervals to free the processor for other operations. The
VI calculates the wait interval by dividing the check every N updates input by the update
rate. You should not use the AO Wait VI when you generate data continuously, because
the generation never finishes. The AO Clear VI stops a continuous waveform generation.

AOQ Write

Writes data into the buffer for a buffered analog output operation.

LSP updates to write

taskID in [T taskID out
wvoltage data =F W RITE L numnber of updates dane
tirne Timit in zec (no change ==1) P | = e P numbet of buffers done
allow regeneration T (T) ~i " TF f = genetation cormplete
error in (no error) error out
DSP handle structure e
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This chapter describes the Analog Output Utility VIs. The VIs—AO
Continuous Generation, AO Waveform Generation, and AO Write One
Update—are single-VI solutions to common analog output problems.
The Analog Output Utility VIs are intermediate-level VIs, so they rely
on the advanced-level VIs. You can refer to Chapter 21, Advanced
Analog Output Vs, for additional information on the inputs and outputs
and how they work.

You can access the Analog Output Utilities palette by choosing
Functions»Data A cquisition» Analog Output»Analog Output Utilities.
The icon that you must select to access the Analog Output Utility VIs is
on the bottom row of the Analog Output palette, as shown below.

[I:l Analog Dutput i

Al [ A
NULT FT || MULT FT || OME FT || OME FT

Analog Output Utility VIs

Handling Errors

LabVIEW makes error handling easy with the intermediate-level
Analog Output Utility VIs. Each intermediate-level VI has an error in
input cluster and an error out output cluster. The clusters contain a
Boolean that indicates whether an error occurred, the error code for the
error, and the name of the VI that returned the error. If error in
indicates an error, the VI returns the error information in error out and
does not continue to run.
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When you use any of the Analog Output Utility VIs in a While Loop,
you should stop the loop if the status in the error out cluster reads
TRUE. If you wire the error cluster to the General Error Handler VI, the
VI deciphers the error information and describes the error to you.

The General Error Handler VI is in Functions» Utilities in LabVIEW.
For more information on this VI, refer to your LabVIEW User Manual.

Analog Output Utility VI Descriptions

The following Analog Output Utility VIs are available.

AO Continuous Gen

Generates a continuous, timed, circular-buffered waveform for the given output channels
at the specified update rate. The VI updates the output buffer continuously as it generates
the data. If you simply want to generate the same data continuously, use the AO
Waveform Gen VI instead.

buffer gize [1000 updates] ——
[irmit zettings [no change | ==

device (1] e | number of update: done

channels [0] =& - L

update rate (1000 updates/zec] J_ By =y gﬁgbiztuf bufters done
voltage data E

error in [no eror]

iteration [T:initialize]

clear generation [¥agT] -

m You use the AO Continuous Gen VI when your waveform data resides
. . on disk and is too large to hold in memory, or when you must create
iteration . . : . .
terminal your waveform in real time. Place the VI in a While Loop and wire the
iteration terminal to the VI iteration input.

Note: If your program iterates more than 2311 times, do not wire this VI
iteration terminal to the loop iteration terminal. Instead, set iteration to 0
on the first loop, then to any positive value on all other iterations. The VI
reconfigures and restarts if iteration <0.

Also wire the condition that terminates the loop to the VI's clear acquisition input,

inverting the signal if necessary so that it is TRUE on the last iteration. On iteration 0, the
VI calls the AO Config VI to configure the channel group and hardware and to allocate
a buffer for the data. It also calls the AO Write VI to write the given voltage data into the
buffer, and then the AO Start VI to set the update rate and start the signal generation. On
each subsequent iteration, the VI calls the AO Write VI to write the next portion of data
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into the buffer at the current write position. On the last iteration (when clear generation
is TRUE) or if an error occurs, the VI also calls the AO Clear VI to clear any generation
in progress. Although it is not normally necessary, you can call the AO Continuous Gen
VI outside of a loop (that is, to call it only once). But if you do, leave the iteration and
clear generation inputs unwired.

The first call to the AO Write VI sets allow regeneration to TRUE, so that the same data
can be generated more than once. If you change allow regeneration to FALSE, you must
write new data fast enough that new data is always available to be generated. If you do
not fill the buffer fast enough, you get a regeneration error. To correct this problem,
decrease the update rate, increase the buffer size, increase the amount of data written
each time, or write data more often.

(Windows) If you set allow regeneration to FALSE, and your device has an analog output
FIFO, your buffer size must be at least twice as big as your FIFO.

If an error occurs, the VI calls the AO Clear VI to clear any generation in progress, then
passes the unmodified error information to error out. If an error occurs inside the AO
Continuous Gen VI, the AO Clear VI clears any generation in progress and passes its
error information out.

Refer to Appendix A, DAQ Hardware Capabilities, for the channel ranges and output
limits available with your DAQ device.

Note: The AO Continuous Gen VI uses an uninitialized shift register as local
memory to remember the taskID of the output operation between calls. You
normally use this VI in one place on a diagram, but if you use it in more
than one place, the multiple instances of the VI share the same taskID. All
calls to this VI configure, write data, or clear the same generation.
Occasionally, you may want to use this VI in multiple places on the
diagram but have each instance refer to a different taskID (for example,
when you want to generate waveforms with two devices simultaneously).
Save a copy of this VI with a new name (for example, AO Continuous Gen
R) and make your new VI reentrant.

AO Waveform Gen

Generates a timed, simple-buffered or circular-buffered waveform for the given output
channels at the specified update rate. Unless you perform indefinite generation, the VI
returns control to the LabVIEW diagram only when the generation completes.

= andnee\;icue nmnnnnnn
update rake (1000 upuatesxséﬁj — Bl
TANTET O] =
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m If you place this VI in a loop to generate multiple waveforms with the
) - same group of channels, wire the iteration terminal to the VI iteration
iteration input
terminal put.
Note: If your program iterates more than 231_] times, do not wire this VI

iteration terminal to the loop iteration terminal. Instead, set the iteration
value to 0 on the first loop, then to any positive value on all other iterations.
The VI reconfigures and restarts if iteration <0.

On iteration 0, the VI calls the AO Config VI to configure the channel group and
hardware and to allocate a buffer for the data. On each iteration, the VI calls the AO Write
VI to write the data into the buffer, then the AO Start VI to set the update rate and start
the generation. If you call the AO Waveform Gen VI only once, you can leave iteration
unwired. The iteration parameter defaults to 0, which tells the VI to configure the device
before starting the waveform generation.

If an error occurs, the VI calls the AO Clear VI to clear any generation in progress, then
passes the error information unmodified through error out. If an error occurs inside the
AO Waveform Gen VI, it clears any generation in progress and passes its error
information out.

Refer to Appendix A, DAQ Hardware Capabilities, for the channel ranges, output limits,
and scanning order available with your DAQ device.

Note: The AO Waveform Gen VI uses an uninitialized shift register as local
memory to remember the taskID of the output operation between calls. You
normally use this VI in one place on your diagram, but if you use it in
multiple places, all instances of the VI share the same taskID. All calls to
this VI configure, write data, or clear the same generation. Occasionally,
you may want to use this VI in multiple places on the diagram, but have
each instance refer to a different taskID. Save a copy of this VI with a new
name (for example, AO Waveform Gen R) and make the new VI reentrant.

A0 Write One Update

Writes a single voltage value to each of the specified analog output channels.

Timnit zattings (no change)l ammmmrrmy

device
channels (O} 3==""

rvoltage data
error in [no error)
iteration (0 initialize]
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The AO Write One Update VI performs an immediate, untimed update
of a group of one or more channels. If you place the VI in a loop to write
more than one value to the same group of channels, wire the iteration
terminal to the VI iteration input.

If your program iterates more than 231_1 times, do not wire this VI
iteration terminal to the loop iteration terminal. Instead, set the iteration
value to 0 on the first loop, then to any positive value on all other iterations.
The VI reconfigures and restarts if iteration <0.

On iteration 0, the VI calls the AO Config VI to configure the channel group and
hardware, then calls the AO Single Update VI to write the voltage to the output channels.
On future iterations, the VI calls only the AO Single Update VI, avoiding unnecessary
configuration. If you call the AO Write One Update VI only once to write a single value
to each channel, leave the iteration input unwired. Its default value of 0 tells the VI to
perform the configuration before writing any data.

Refer to Appendix A, DAQ Hardware Capabilities, for the channel ranges, output limits,
and scanning order available with your DAQ device.

%= Note:

The AO Write One Update VI uses an uninitialized shift register as local
memory to remember the taskID for the group of channels when calling
between VIs. Usually, this VI appears in one place on your diagram.
However, if you use it in more than one place, the multiple instances of the
VI share the same taskID. All calls to this VI configure or write data to the
same group. If you want to use this VI in more than one place on your
diagram, and want each instance to refer to a different taskID (for
example, to write data with two devices at the same time), you should save
a copy of this VI with a new name (for example, AO Write One Update R)
and make your new VI reentrant.
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This chapter contains reference descriptions of the Advanced Analog
Output VIs. These VIs are the interface to the NI-DAQ software and are
the foundation of the Easy, Utility and Intermediate Analog Output VIs.

You can access the Advanced Analog Output palette by choosing
Functions»Data Acquisition»Analog Output»Advanced Analog
Output. The icon that you must select to access the Advanced Analog
Output VIs is on the bottom row of the Analog Output palette, as shown
below.

B[] Analog Dutput

R il = @ L
=] :}i‘:‘l ﬂ.‘.’. -\;'ﬁ \;ﬂ
Al

p— v Advanced
e &%," ' | 7 Analog Output Vis

Advanced Analog Output VI Descriptions

The following Advanced Analog Output VIs are available.

A0 Buffer Config

Allocates memory for an analog output buffer. If you are using interrupts, you can
allocate a series of analog output buffers and assign them to a group by calling the AO
Buffer Config VI multiple times. Each buffer can have its own size. If you are using
DMA, you may allocate only one buffer.

1%  Note: (Macintosh) If you are using the NB-A2100 with the NB-DMA2800, the AO
Buffer Write VI restricts the amount of data that can be put into the VI to
one-half of the buffer size specified in the AO Buffer Config VI.
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Use the number you assign to the buffer with this VI when you need to refer to this buffer

for other VIs.
'SP handle
task ID Config| task ID out
channel Tist ot .}Hl  DSP handle aut
number of updates — __ =1 error out

buffer nurber

error in (no error)
allocate mode Q

AO Buffer Write

Writes analog output data to buffers created by the AO Buffer Config VI.

tirme Timit

alternate data and rode set
tazk ID

channel indices

voltage fcurrent data
error in (no error)
regeneration mode

buffer number

]|

r'ite tadsli I out
= = i o pdate progress
=R error out

=]

You wire the new data to one of three inputs—voltage/current data, binary data, or
DSP memory handle. The VI searches these inputs in that order for the first array with
alength greater than zero. The VI then writes the data from this array to the output buffer.
The length of the voltage/current data or binary data arrays determines the number of
updates the VI writes. If DSP memory handle points to the source of the data, updates
to write must indicate how many updates the VI is to write. When no data is wired, this
V1 is still useful for reporting update progress information.

The total number of updates written to a buffer before you start it can be less than the
number of updates you allocated the buffer to hold when you called the AO Buffer Config
VI. LabVIEW generates only the updates written to the buffer.

LabVIEW Function and VI Reference Manual 21-2
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A0 Clock Config

Configures an update or interval clock for analog output.

clock source specification
config mode (0 no change)
alternate rate set (no change)

tazk ID €L°$k tazk 1D out
buffer number (-1 : no change) — o "‘5‘ L tmactual rates used
—I_.-T error out

clack (0: no change)

error in (no error) mﬂr:
ticks per second (-1: no ch...
clock source (0 no change)

Refer to Appendix A, DAQ Hardware Capabilities, for the clocks available with your
DAQ device.

You can express clock rates three ways—with ticks per second, seconds per tick, or the
three timebase parameters. The VI searches these parameters in that order and expresses
clock rates on the first parameter with a wired valid input. When you configure an update
clock, one tick equals one update. When you configure the interval clock, one tick equals
one interval.

AO Control

Starts, pauses, resumes, and clears analog output tasks.

task ID
control code ——]
staging list mﬁm l**"“*

error in (no errur]
iterations Q

pause fresume channel list

[:.;.,-,_ task ID out

error out

A0 Group Config

Assigns a list of analog output channels to a group number and produces the taskID that
all the other analog output VIs use.

device «-vr'wP task ID out
unfug

gr o - graup size
n i
channel Tlis ﬁ;::j error out
error in (no error)

Refer to Appendix A, DAQ Hardware Capabilities, for the channels available with your
DAQ device.
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AOQ Hardware Config

Configures the reference voltage level, output polarity, and the unit of measure for the
data of a given channel (volts or milliamperes). This VI always returns the current
settings for all the channels in the group.

task ID

channel Tist 2

channel type

error in (no error)
Timit settings =

task ID out
i PR cyrrent hardware settings

e arror out

Refer to Appendix A, DAQ Hardware Capabilities, for the channel ranges, and output
limits available with your DAQ device.

AO Parameter

Sets miscellaneous parameters associated with the Analog Output operation of the
devices that are not covered with other Analog Output VlIs.

float in

value in

boolean in .

tazk ID in Paararn task ID out

channels

parameter name B ermror oul
error in (no error]

A0 Single Update

Performs an immediate update of the channels in the group.

voltage Ffecurrent array \_;-’"'

error in (no error)
binary array —I

task ID [Update] task ID out
opcode [=t=binary atray written
error out
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Configures the trigger and gate conditions for analog output operations on E Series

devices 5411 devices.

tazk D
—

trigger or gate source [0 ..
ag g [ =

Trigger

Config
<P

=

tazk |0 out

errar out

trigaer or gate condition [
Efrar in [ho erar]
trigger or gate source =pe...
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This chapter describes the Easy Digital I/O VIs, which perform simple
digital I/O operations. You can run these VIs from the front panel or use

them as subVIs in basic applications.

Access the Easy Digital I/O VIs by choosing Functions»Data
Acquisition»Digital 1/O.

O Drigital 150

DI DI DI DI
LIME FORT LIME PO

B ||B B BT
A iic |[Tin 3
CONFIG|| READ || W'RITE || 2TART WHIE)
e || i 2 | [ B | ane i | | B

-+—— Easy Digital 110V

T1i0 ADU b
cLear || e Ee,
S| [

The Easy Digital I/O VIs are the VIs on the top row of the Digital I/O
palette. For examples of how to use the Easy Digital I/O VlIs, open the
example library by opening examples\dag\digitalldigital.llb.

You must define the high and low limit settings for your board when using

Note:
the Easy 1/0 DAQ VIs.

Easy Digital 1/0 Descriptions

The following Easy Digital I/Os are available.
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Read from Digital Line

Reads the logical state of a digital line on a port that you configure.

port width (2] — ]

device EII;:']E Tine state
port numh_er {_
Tine o g Y

iteration (0 initialize)

If an error occurs, a dialog box appears, giving you the option to stop the VI or continue.

Note:

When you call this VI on a digital I/0 port that is part of an 8255 PPI when
your iteration terminal is left at 0, the 8255 PPI goes through a
configuration phase, where all the ports within the same PPI chip get reset
to logic low, regardless of the data direction. The data direction on other
ports, however, is maintained. To avoid this effect, connect a value other
than 0 to the iteration terminal once you have configured the desired ports.

Read from Digital Port
Reads a digital port that you configure.

port width C8) —
device OIE pattern
port number FORT

B

jteration [0 :initialize)

If an error occurs, a dialog box appears, giving you the option to stop the VI or continue.

Note:

When you call this VI on a digital 1/O port that is part of an 8255 PPI when
your iteration terminal is left at 0, the 8255 PPI goes through a
configuration phase, where all the ports within the same PPI chip get reset
to logic low, regardless of the data direction. To avoid this effect, connect
a value other than 0 to the iteration terminal once you have configured the
desired ports.

LabVIEW Function and VI Reference Manual 22-2 © MNational Instruments Corporation



Chapter 22 Easy Digital I/0 Vis

Write to Digital Line

Sets the output logic state of a digital line to high or low on a digital port that you specify.

part width (3]

device
port number
Tine

Tine state
jteration (0 :initialize)

If an error occurs, a dialog box appears, giving you the option to stop the VI or continue.

Note:

When you call this VI on a digital 1/0 port that is part of an 8255 PPI when
your iteration terminal is left at 0, the 8255 PPI goes through a
configuration phase, where all the ports within the same PPI chip get reset
to logic low, regardless of the data direction. The data direction on other
ports, however, is maintained. To avoid this effect, connect a value other
than 0 to the iteration terminal once you have configured the desired ports.

Write to Digital Port

Outputs a decimal pattern to a digital port that you specify.

part width (31

device
port number
pattern

iteration [0 rinitialize)

If an error occurs, a dialog box appears, giving you the option to stop the VI or continue.

7 & Note:

When you call this VI on a digital 1/0 port that is part of an 8255 PPI when
your iteration terminal is left at 0, the 8255 PPI goes through a
configuration phase, where all the ports within the same PPI chip get reset
to logic low, regardless of the data direction. The data direction on other
ports, however, is maintained. To avoid this effect, connect a value other
than 0 to the iteration terminal once you have configured the desired ports.
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This chapter describes the Intermediate Digital I/O VIs. These VIs are
single VI solutions to common digital problems.

For example, the DIO Single Read/Write VI is a single VI solution for
non-buffered reads and writes to the ports in your group. The DIO
Single Read/Write VI works with any device with digital ports.

You combine the other VIs—DIO Config, DIO Start, DIO Read, DIO
Write, DIO Wait, and DIO Clear—to build more demanding
applications using buffered digital reads and writes. Your device must
support handshaking to use this group of VIs, with the exception of the
DIO Single Read/Write VI.

All the VIs described in this chapter are built from the fundamental
building block layer, the advanced-level VIs.

You can access the Intermediate Digital I/O VIs by choosing
Functions»Data Acquisition»Digital I/O. The Intermediate Digital I/O
VIs are the VIs on the second and third rows of the Digital palette, as
shown below.

DIG DIG DIG DIG
LIME FORT LIME PORT

{—
—|_ =T (B _}{
]
COHFIG
i
TI0
CLERR
e

J—— Intermediate
| — Digital /0 Vls
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Handling Errors

LabVIEW makes error handling easy with the Intermediate Digital I/O
VIs. Each intermediate-level VI has an error in input cluster and an
error out output cluster. The clusters contain a Boolean that indicates
whether an error occurred, the error code for the error, and the name of
the VI that returned the error. If error in indicates an error, the VI
returns the error information in error out and does not continue to run.

Note: The DIO Clear VI is an exception to this rule—this VI always clears the
acquisition regardless of whether error in indicates an error.

When you use any of the Intermediate Digital I/O VIs in a While Loop,
you should stop the loop if the status in the error out cluster reads
TRUE. If you wire the error cluster to the General Error Handler VI, the
VI deciphers the error information and describes the error to you.

The General Error Handler VI is in Functions» Time and Function in
LabVIEW. For more information on this VI, refer to your LabVIEW
User Manual.

Intermediate Digital 1/0 VI Descriptions

The following Intermediate Digital I/O VIs are available.

DIO Clear

Calls the Digital Group Buffer Control VI to halt a transfer and clear the group.

tazkID in —| [t — taskID out

error in (no error) ==n Bexerror out

DIO Config

The DIO Config VI calls the advanced Digital Group Config VI to assign a list of ports
to the group, establish the group's direction, and produce the taskID. The VI then calls
the Digital Mode Config VI to establish the handshake parameters, which only affect the

LabVIEW Function and VI Reference Manual 23-2 © MNational Instruments Corporation



Chapter 23 Intermediate Digital I/0 Vis

operation of the DIO-32 devices. Finally, the VI calls the Digital Buffer Config VI to
allocate a buffer to hold the scans as they are read or the updates to be written.

# of zcans fupdates(1000)
device ] taskiD
group —mame| COMFI
port lis ovcl] el
group direction —I_ﬂ r=e=error out

error in (no error)
hand=zhaking rmode pararmeters o)

Refer to Appendix A, DAQ Hardware Capabilities, for the ports and directions available
with your DAQ device.

DIO Read

Calls the Digital Buffer Read VI to read data from the internal transfer buffer and returns
the data read in pattern.

=Can backlog
nurmber read

taskiD in [ taskiD out
humber of scans to read(1000) — READ 1=port data
tirme limit in sec (o change -1 Ty retrieval complets

error_in (no error) I=l=='=n:.E'!ﬂm-errrunr out

DIO Single Read/Write

Reads or writes digital data to the ports specified in the port list. This single VI configures
and transfers data. When you use this VI in a loop, wire the iteration counter to the
iteration input so that port configuration takes place only once.

nurmber to Fead
d:\;imta o101 scans read
port list oF R#ld - nurnber transferred
group direction —I_I—"-%-"_I—readg state
operation code e @rTOr OUL

error in (no error)
updates to write
tirne lirit
iteration (0 :initialize]
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DIO Start

Starts a buffered digital I/O operation. This VI calls the Digital Clock Config VI to set
the clock rate if the internal clock produces the handshake signals, and then starts the data
transfer by calling the Digital Buffer Control VI.

taskiD in
number of scans fupdates to ___

handshake zource —I_l nnnr S error out
clock frequency E

error in (no errorl

4] taskiD oul
ETART

DIO Wait

Waits until the digital buffered input or output operation completes before returning. For
input, the VI detects completion when the acquisition state returned by the Digital Buffer
Read VI finishes with or without backlog. For output, the VI detects completion when
the generation complete indicator of the DIO Write VI is TRUE.

TaskID in R TasEID ou
direction —
heck every N miliseconds (50 — ] "nf-::

error_in (no error) error out

Refer to Appendix A, DAQ Hardware Capabilities, for the handshake modes available
with your DAQ device.

DIO Write

Calls the Digital Buffer Write VI to write to the internal transfer buffer.

(Macintosh) You must fill the buffer with data before you use the DIO Start VI to begin the
digital output operation. You can call the DIO Write VI after the transfer begins to
retrieve status information.

—TazKID in e TaskID out
digital data W RITE buffer iterations

o
tirme Timit in sec Cno change =12 j Elnnrt gener ation completd
wiite location ﬂ_ error out
error_in {no error)
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This chapter describes the Advanced Digital I/O VIs, which include the
digital port and digital group VIs. You use the digital port VIs for
immediate reads and writes to digital lines and ports. You use the digital
group VIs for immediate, handshaked, or clocked I/O for multiple ports.
These VIs are the interface to the NI-DAQ software and the foundation
of the Easy and Intermediate Digital I/O VIs.

You can access the Advanced Digital I/O palette by choosing
Functions»Data Acquisition»Digital 1/O»Advanced Digital I/O. The
icon that you must select to access the Advanced Digital I/O VIs is on
the bottom row of the Digital I/O palette, as shown below.

i1 Digital 170

DI DI DI DIG

LIME FORT LIMNE PORT

{_

B B B B

nIn DIO OIo nIn DIo

CONFIG) [ READ || wRITE || START '-.-\.-'Fll'&I

o3| | nni S| | B | nne S | | B

pId | foIo 1 EA0 b Advanced
FLERE (| R :‘ﬁ- Digital /O Vls
| e

Digital Port VI Descriptions

The digital port VIs perform immediate digital reads and writes only.
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DIO Port Config

Establishes a port configuration. You can use the taskID that this VI returns only in

digital port VIs.

error in (no error) s=f

line direction map

device Fort
port number ~r~Config

part width —T "B

Refer to Appendix A, DAQ Hardware Capabilities, for the ports and directions available

with your DAQ device.

Table 24-1 shows the physical port widths you can use.

Table 24-1. Physical Port Widths of Digital Ports

task ID out

pcoeoo grror out

Device Ports Physical Port Width
MIO-16L/H 0,1 4 bits
AT-MIO-16D 0,1 4 bits
2,3,4 8 bits
Most E Series Devices 0 8 bits
AT-MIO-10DE-10 0,2,3,4 8 bits
AT-AO-6/10 0,1 4 bits
PC-TIO-10, NB-TIO-10, AO-2DC Devices| 0, 1 8 bits
PC-LPM-16, PC-LPM-16PnP, 0,1 8 bits (cannot be combined)
DAQCard-700
DAQCard-500, 516 Devices 0,1 4 bits
Lab and 1200 Series Devices, DIO-24 0,1,2 8 bits
Devices
DIO-96 Devices 0 through 11| 8 bits
AT-DIO-32F, NB-DIO-32F 0 through 3 | 8 bits
4 3 bits (cannot be combined)

24-2
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Table 24-1. Physical Port Widths of Digital Ports (Continued)

Device Ports Physical Port Width
DIO32HS
SCXI-1160 0 16 bits
SCXI-1161 0 8 bits
SCXI-1162, SCXI-1162HV, SCXI-1163, 0 32 bits
SCXI-1163R

DIO Port Read

Reads the port identified by taskID and returns the pattern read in pattern.

task ID Fort task ID out
line maszk — Fead  pattern
R |mﬂam|
error in (no error) error out

DIO Port Write

Writes the value in pattern to the port identified by taskID.

task ID

pattern —— Write

: =
) Tine rask — S
error in (no error)

Fart

oo arror out

task ID out

Digital Group VI Descriptions

The digital group VIs perform immediate, handshaked, or clocked digital I/O.

Digital Buffer Config

Allocates memory for a digital input or output buffer.

task ID

© National Instruments Corporation

# of zeans fupdates — ]

Buffer
Config

allocation mode —___|

oro(alion
-]

task ID out

error in (no error)

error out
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Digital Buffer Control

Starts an input or output operation.

tazk ID Buffer task ID out
control code ——Contrl
# of seans fupdates —___|"1E

- t
error in (no error) o= error ou
data overwrite fregen. Q
Digital Buffer Read
Returns digital input data from the internal data buffer.
taszk ID Euffer task ID out
nurnber to read 23 Emrark locations

o]

tead location sl —i0E nurnbet read
tirne Tirnit —I

1 —
port data
error in (no error) mﬂ: =IE======I1!-rr1:nr out

scan backlog

Digital Buffer Write

Writes digital output data to the buffer created by the Digital Buffer Config VI. The write
always begins at the write mark. After a write, the write mark points to the update
following the last update written.

tazk ID Buffer task ID out
digital data == "%rite
wiite location oo wigh

error in (no error) s==f |

tirme Timit

update progress
= error out

(Macintosh) Fill the buffer with data before you use the Digital Buffer Control VI to begin
the digital output operation. You can call the Digital Buffer Write VI after the transfer
begins to retrieve status information.

The total number of updates written to a buffer before you start it can be less than the
number of updates you allocated the buffer to hold when you called the Digital Buffer
Config VI. The VI generates only the updates written to the buffer.
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Digital Clock Config

Configures a DIO-32 device to produce handshake signals based on the output of a clock
for timed digital I/O.

pTiernate oIk rate spec.

canfig rode
task ID Clack task I out
handshake source ———[Config . .
clock frequency — ___|"5=l clock infarrnation
terror out

=]
error in (no error el
gating rmode

Refer to Appendix A, DAQ Hardware Capabilities, for the clocks available with your
DAQ device.

The following example illustrates how to use the three timebase parameters to specify a
clock rate. Assume these parameters have the following settings:

timebase source: 1
timebase signal: 1,000,000.0 Hz
timebase divisor: 25

In this case, the ticks per second rate is 1,000,000.0 divided by 25, so LabVIEW updates
the digital group 40,000 times per second.

Digital Group Config

Defines a digital input or output group. You can use the taskID this VI returns only in
the digital group VlIs.

dewice G aup task ID out
group = Config — group size
port list cod ! "°' — handshaking

error in (no error) el | error out

group direction

Refer to Appendix A, DAQ Hardware Capabilities, for the ports and directions available
with your DAQ device.

1%  Note: The same port cannot belong to two different groups. If you configure a
group to use a specified port, that port must be one that is not already
defined in another group or you will get an error.

MIO devices (except for the AT-MIO-16D and the AT-MIO-16DE-10), as well as the
NB-TIO-10, LPM devices, DAQCard-500, 516 devices, DAQCard-700, PC-TIO-10,
AO-2DC devices, PC-OPDIO-16, and AT-AO-6/10, do not allow handshaking. The
digital port VIs are more appropriate for these devices. The AT-MIO-16D and
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AT-MIO-16DE-10 do not allow handshaking if port list includes ports 0, 1, and/or 4. The
DIO-96 devices do not allow handshaking if port list includes ports 2, 5, 8, and/or 11.
The DIO-24 and Lab and 1200 Series devices do not allow handshaking if port list
includes port 2. The DIO-32F allows handshaking for the following configurations only:

e A group containing any one port
* A group containing ports 0 and 1, or ports 2 and 3, in that order

e A group containing ports 0, 1, 2, and 3, in that order

Digital Mode Config

Configures the handshaking characteristics for DIO-32 devices.

request polariiy
acknowledge modify armount
acknowledge modify mode

task ID Made task I oud
=1qnal mode —'_Eﬂn1 fal |
edge ml:u:le g error out

error in (no error) s
acknowledge polarity —I

atrdwrare double buffer mods ———

Refer to Appendix A, DAQ Hardware Capabilities, for the handshake modes available
with your DAQ device.

DIO Parameter

Configures and retrieves miscellaneous parameters associated with digital input and
output that are not configured by other DIO VIs.

float in
value in
[ T
taszk 1D in Faram task 1D out
channels

operation J_Imgm error aut
parameter name |— flaat out

arrar In I:I'IIZI EFFDFJ —_— alue out

[ boalean oot
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Table 24-2 lists device specific parameters and legal ranges for devices.

Table 24-2. Device specific parameters and legal ranges for devices

Input/output
Parameter Setting you should Legal Default
Device Name Support | Possible use Values Value
VXI-DI | O: Input per input | yes channels, N/A N/A
0-128 Port Logic | port float in, float
Threshold out

Digital Single Read

Reads the ports that belong to the group identified by taskID and returns the
patterns read.

task ID

task ID out

Girou

opeode —

Rea

- patterns read

nurnber to read —

error in (no error) —

(=]
L=l

b—pattern list
error out

time Tirnit

ready state

Digital Single Write

Writes the data in pattern array to the ports that belong to the group identified by

taskID.

task ID

task ID out

opcode —

error in (no error)
tirne Timit

pattern list —|_'°'°""'_|—r'eadl,| state

sl

— patternz written

error out

Digital Trigger Config
Configures the trigger condition for starting and/or stopping a digital pattern generation
operation. This VI is only valid when the Digital Clock Config VI has its handshake

source parameter set to 1 or 4 (internal or external pattern generation w/ external clock).

© National Instruments Corporation

additional trigger specific...
tazk IO

trigger type [0 no change)
mode (0 no change)

error in [ho error)

trigger condition 0: no ch..

M

Trigger tazk D out
_I—Config

101 |-:-|
S — g error out

i
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Note:

The Easy Counter VIs perform simple counting operations. You can run
these VIs from the front panel or use them as subVlIs in basic
applications.

You can access the Easy Counter VIs by choosing Functions»Data
Acquisition»Counter. The Easy Counter VIs are the VIs on the top row
of the Counter palette.

i Counter
e |FULSE| | FULSE | | FREQ | [
153t || FOCE, | a——
1 TT.;; e | Errat] Easy
4w ||| A ||l Courter
2y = Vs

This chapter describes the high-level VIs for programming counters on
the MIO, TIO, and other devices with the Am9513 or DAQ-STC
counter/timer chips. These VIs call the Intermediate Counter VIs to
generate a single delayed TTL pulse, a finite or continuous train of
pulses, and to measure the frequency, pulse width, or period of a

TTL signal.

These VIs do not work with Lab and 1200 Series devices, DAQCards, and
other devices that have the 8253 chip. Use the intermediate-level ICTR
Control for those devices. Refer to Chapter 26, Intermediate Counter VIs
for more information on the ICTR Control VL.

Some of these VIs use other counters in addition to the one specified.
In this case, a logically adjacent counter is chosen, which is referred to
as counter+1 when it is the adjacent, logically higher counter and
counter—1 when it is the adjacent, logically lower counter.

For a device with the Am9513 chip, if the counter is 1, then counter+1
is counter 2 and counter—1 is counter 5.
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See the Adjacent Counters VI described in Chapter 26, Intermediate
Counter VlIs, for more information.

For examples of how to use the Easy Counter VIs, open the example
library by opening examples\dag\counter\counter.1lb.

Easy Counter VI Descriptions

The following Easy Counter VIs are available.

Count Events or Time

Configures one or two counters to count external events or elapsed time. An external
event is a high or low signal transition on the specified SOURCE pin of the counter.

source edge [rizing :0)
event source ftimebase (coun._.

device L = count
counter -~ = L ceconds since start
counter size (16524-bits:0) seconds since last call

startfrestart (F: no) -
stop (F: no) -

To count events, set the event source/timebase to 0.0 and connect the signal you want to
count to the SOURCE pin of the counter. To count time, set this control to the timebase
frequency you want to use.

Generate Delayed Pulse

Configures and starts a counter to generate a single pulse with the specified delay and
pulse width on the counter’s OUT pin. A single pulse consists of a delay phase (phase 1),
followed by a pulse phase (phase 2), and than a return to the phase 1 level. If an internal
timebase is chosen, the VI selects the highest resolution timebase for the counter to
achieve the desired characteristics. If an external timebase signal is chosen, the user
indicates the delay and width as cycles of that signal. Execute the Counter Start VI with
this VI's taskID to generate another pulse. You can optionally gate or trigger the pulse
with a signal on the counter’s GATE pin.

tirmebase source (internal:0)
gate rmode (ungated 01 ————

device PLLSE [tazkID]
counter -F _l_l L [actual delay (s or cycles)]
pulse palarity Chigh I:I:I [actual width (s or cycles)]

pulse delay (= or cycles) Q

pulse width (s or cycles)
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Generate Pulse Train

Configures the specified counter to generate a continuous pulse train on the counter's
OUT pin, or to generate a finite-length pulse train using the specified counter and an
adjacent counter. The signal has the prescribed frequency, duty cycle, and polarity. Each
cycle of the pulse train consist of a delay phase (phase 1) followed by a pulse phase
(phase 2).

gate mode (ungated:0)
pulze polarity Chigh:0) ———— |

device _ri_Hlﬁle [taskID of counter]
t wnf . -
coun _er ) "_ﬁl [taskID of counter-1]
number of pulses (cont:0) — - actual parameters
frequency (Hz) 4'

duty cycle (0.5}

This VI uses only the specified counter to generates a continuous pulse. For a
finite-length pulse, the VI also uses counter—1 to generate a minimum-delayed pulse to
gate counter. To generate another pulse train, execute the intermediate Counter Start VI
with the taskIDs supplied by this VI. To stop a continuous pulse train, execute the
intermediate Counter Stop VI or execute this counter again to generate one, short pulse.
You must externally wire counter—1’s OUT pin to counter's GATE pin for a finite-length
pulse train. You can optionally gate or trigger the start of the train with a signal on the
counter—1’s GATE pin.

Note: A pulse train consists of a series of delayed pulses, where phase 1 or the
first phase of each pulse is the inactive state of the output (low for a high
pulse) and the phase 2 of the second phase is the pulse itself. Refer to the
following illustration of a high polarity pulse train.

Measure Frequency

Measures the frequency of a TTL signal on the specified counter’s SOURCE pin by
counting positive edges of the signal during a specified period of time. In addition to this
connection, you must wire the counter’s GATE pin to the OUT pin of counter—1. This VI
is useful for relatively high frequency signals, when many cycles of the signal occur
during the timing period. Use the Measure Pulse Width or Period VI for relatively low
frequency signals. Keep in mind that period(s) = 1/frequency (Hz).

counter-1 gate modefungated 0] 1 f [actual parameters
device FREL] frequency (Hzl
counter - LERT e yalid ?

gate width (5] R Izﬂmﬂm:-:nth-e-r' status

counter size (16/24-bit:0)
[rnasirnurn delay to gate (S.0...
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This VI configures the specified counter and counter+1 (optional) as event counters to
count rising edges of the signal on counter's SOURCE pin. The VI also configures
counter—1 to generate a minimum-delayed pulse to gate the event counter, starts the event
counter and then the gate counter, waits the expected gate period, and then reads the gate
counter until its output state is low. Next the VI reads the event counter and computes the
signal frequency (number of events/actual gate pulse width) and stops the counters.
You can optionally gate or trigger the operation with a signal on counter—1’s GATE pin.

Measure Pulse Width or Period

Measures the pulse width (Iength of time a signal is high or low) or period (length of time
between adjacent rising or falling edges) of a TTL signal connected to the counter’s
GATE pin. The method used gates an internal timebase clock with the signal being
measured. This VI is useful in measuring the period or frequency (1/period) of relatively
low frequency signals, when many timebase cycles occur during the gate. Use the
Measure Frequency VI to measure the period or frequency of relatively high frequency

signals.
time Timit (computed :-1) 1] count
device pulse width/period (=)
FULSE N
counter -4 o owalid?
type of measurement = counter overflow ?
timebase (1M Hz) — timeout ?

The VI iterates until a valid measurement, timeout, or counter overflow occurs. A valid
measurement exists when count ( 4 without a counter overflow. If counter overflow
occurs, lower the timebase. If you start a pulse width measurement during the phase you
want to measure, you get an incorrect low measurement. Therefore, make sure the pulse
does not occur until after the counter is started. This restriction does not apply to period
measurements.
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This chapter describes Intermediate Counter VIs you can use to
program counters on MIO, TIO, and other devices with the Am9513 or
DAQ-STC counter chips. These VIs call the Advanced Counter VIs to
configure the counters for common operations and to start, read, and
stop the counters. You can configure these VIs to generate single pulses
and continuous pulse trains, to count events or elapsed time, to divide
down a signal, and to measure pulse width or period. The Easy Counter
VIs call these Intermediate VIs for several pulse generation, counting,
and measurement operations.

This chapter also describes the ICTR Control VI that you use with Lab
and 1200 Series and PC-LPM devices that contain the 8253
counter/timer chip.

You can access the Intermediate Counter VIs by choosing
Functions»Data Acquisition»Counter. The Intermediate Counter VIs
are the VIs on the second row of the Counter palette, as shown below.

i[] Counter i

[ = T=] L —
PULSE [P (1250 | oo

_HAnt [T s

5

Intermedia\t‘e Counter Vis

Handling Errors

LabVIEW makes error handling easy with the Intermediate Counter
VIs. Each intermediate-level VI has an error in input cluster and an
error out output cluster. The clusters contain a Boolean that indicates
whether an error occurred, the error code for the error, and the name of
the VI that returned the error. If error in indicates an error, the VI
returns the error information in error out and does not continue to run.
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When you use any of the Intermediate Counter VIs in a While Loop,
you should stop the loop if the status in the error out cluster reads
TRUE. If you wire the error cluster to the General Error Handler VI, the
VI deciphers the error information and describes the error to you.

The General Error Handler VI is in Functions»Utilities in LabVIEW.
For more information on this VI, refer to your LabVIEW User Manual.

Intermediate Counter VI Descriptions

The following Intermediate Counter VIs are available.

Adjacent Counters

This VIidentifies the counters logically adjacent to a specified counter of an MIO or TIO
device. It also returns the counter size (number of bits) and the timebases.

Timebazes
| counter

derice 7 T counter+1
counter (=1~} -4 + 2 v counter+1
counter — | E'=1=2"%rt:-munt-er—l
counter—1

counter

counter size (bits

Devices with the Am9513 chip have one or two sets of five, 16-bit counters (1-5, 6-10)
that can be connected in a circular fashion. For example, the next higher counter to
counter 1 (called counter+1) is 2 and the next lower one (called counter—1) is 5.

Continuous Pulse Generator Config
Configures a counter to generate a continuous TTL pulse train on its OUT pin.

gate mods (ungated :0) ————
device EHIFI%IEG ?asklb ol
counter -d H L [actual frequency (Hz
pulse polarity Chigh 00 fm{ %[actua] duty cyele]
error in (no error) error out
frequency (Hz)
duty cycle (0.3)

The signal is created by repeatedly decrementing the counter twice, first for the delay to
the pulse (phase 1), then for the pulse itself (phase two). The VI selects the highest
resolution timebase to achieve the desired characteristics. You can optionally gate or
trigger the operation with a signal on the counter’s GATE pin. Call the Counter Start VI
to start the pulse train or to enable it to be gated.
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Counter Read
Reads the counter or counters identified by taskID.

taskiD E-:-un;er taskiD
[counter lizt] of220eoqRea count
=
error in {(no error) -=======- averflow 7
error out

The VI is designed to read one counter or two concatenated counters of an Am9513
counter chip or to read one counter of a DAQ-STC counter chip.

Counter Start
Starts the counters identified by taskID.

tazkID E:untth tazk|D
[Founter list] o “;23
&rar in [no error] oo errar out

Counter Stop
Stops a count operation immediately or conditionally on an input error.
task ID Eyunter] task ID
error in (no error) =T error ouf

stop when (Row T e

Delayed Pulse Generator Config
Configures a counter to generate a single, delayed TTL pulse on its OUT pin.

timebase source Cinternal )
gate mode (ungated :0) ————

device FULSE task ID
counter -f L [actual delay (s or cycles)]
1 4 4
pulze polarity Chigh:0) f 4 % [actual width (= ar cycles)]
error in (no error) error out

pulse delay (s or cycles)
pulse width (s or cycles)

The signal is created by decrementing the counter twice, first for the delay to the pulse
(called phase 1), then for the pulse itself (phase 2). If an internal timebase is chosen, the
VI selects the highest resolution timebase for the counter to achieve the desired
characteristics. If an external timebase signal is chosen, the user designates the delay and
width as cycles of that signal. You can optionally gate or trigger the operation with a
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signal on the counter’s GATE pin. Call the Counter Start VI to start the pulse or enable
it to be gated.

Down Counter or Divider Config

Configures the specified counter to count down or divide a signal on the counter’s
SOURCE pin or on an internal timebase signal using a count value called the timebase
divisor. The result is that the signal on the counter’s OUT pin is equal to the frequency
of the input signal/timebase divisor.

gate mode (ungated 0]
source edge ——

device OH &TR taskiD
counter ~F Fl"_"uuﬂun_i'?
output Chigh pulse :0) f b error out
error in (no error)

timebase divisor
timebase (counter s SOURCE....

You can use this VI to generate finite pulse trains by enabling a continuous pulse
generator until the desired number of pulses has occurred. You can also use it in place of
the Continuous Pulse Generator Config VI to generate a train of strobe or trigger signals.

Event or Time Counter Config

Configures one or two counters to count edges in the signal on the specified counter’s
SOURCE pin or the number of cycles of a specified internal timebase signal.

count lirmit Ceontinuous:1)
gate rmode (ungated 00
device , taskID

counter =~ L

counter size [16/524-bits :0) e

errar in [no errar) mﬂ

event source Stimebaze [cou...
source edge (rising 00

error out

When the internal timebase is used, this VI works like the Tick Count (ms) function but
uses a hardware counter on the DAQ device with programmable resolution. You can
optionally gate or trigger the operation with a signal on the counter’s GATE pin. Call the
Counter Start VI to start the operation or enable it to be gated.
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Pulse Width or Period Meas Config

Configures the specified counter to measure the pulse width or period of a TTL signal
connected to its GATE pin.

timebase (Hz) ————
device LT taskiD
counter ~f Ferrorh

type of measurement Chigh p... f

error in (no error)

error out

The measurement is done by counting the number of cycles of the specified timebase
between the appropriate starting and ending events. To accurately measure pulse width,
the pulse must occur after the counter is started. Call the Counter Start VI to start the
operation. You can also use this VI to measure the frequency of low frequency signals.
For more accurate measurements, use a faster timebase.

ICTR Control

Controls counters the following devices that use the 8253 chip:
e Lab and 1200 Series devices, DAQCard-500, and DAQCard 700
¢ (Windows) LPM devices, 516 devices

count
autput state ———
device I CTR
counter |—I:ntn:-| read value
124 error out

control code f
error in (no error)
binary ot bed

In setup mode 0, as shown in Figure 26-1, the output becomes low after the mode set
operation, and the counter begins to count down while the gate input is high. The output
becomes high when counter reaches the TC (that is, when the counter decreases to 0) and
stays high until you set the selected counter to a different mode.

Figure 26-1.
G ampipgipgiigipipgipipipipipipins
wro L
bate s 4a—— & oz 1 0
Output fn =6
N !
A B+EB=n B

In setup mode 1, as shown in Figure 26-2, the output becomes low on the count following
the leading edge of the gate input and becomes high on TC.
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Figure 26-2.

Clack | | |
L — T
qu:lut [I"I = 4] I

In setup mode 2, as shown in Figure 26-3, the output becomes low for one period of the
clock input. The count indicates the period between output pulses.

Figure 26-3.
] 7% PR I 6 I Iy
G g4 03 0z o1 odjE o2 1 0]
Dutput T = 4) L1 L1

In setup mode 3, the output stays high for one-half of the count clock pulses and stays
low for the other half. Refer to Figure 26-4.

Figure 26-4.
1= " I I I I I O I I I I B I o "
Hote: Counting is possible onhy when Gate
Gm4242424242424mhgh_
Supur [n=d) | ] I ] I
5 4 2 5 2 5 4 2 5§ 2 5 4 2
Quput (m=5) _ L

In setup mode 4, as in Figure 26-5, the output is initially high, and the counter begins to
count down while the gate input is high. On TC, the output becomes low for one clock
pulse, then becomes high again.

Figure 26-5.
Cloge [ LML LML LM
WE h=+
Gale 43 2 1 0
ot [

Setup mode 5 is similar to mode 4, except that the gate input triggers the count to start.
See Figure 26-6 for an illustration of mode 5.

Figure 26-6.
50 F I I I I A B I I
Gae ——, 3 21 o
Cilput - 4 L

See the 8253 Programmable Interval Timer data sheet in your Lab device user manual for
details on these modes and their associated timing diagrams.
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Pulse Width or Period Meas Config

Configures the specified counter to measure the pulse width or period of a TTL signal
connected to its GATE pin.

timebase (Hz) —
device e taskiD
counter ~f Ferrorh

type of measurement Chigh p_.. f

error in (no error)

error out

The measurement is done by counting the number of cycles of the specified timebase
between the appropriate starting and ending events. To accurately measure pulse width,
the pulse must occur after the counter is started. Call the Counter Start VI to start the
operation. You can also use this VI to measure the frequency of low frequency signals.
For more accurate measurements, use a faster timebase.

Wait+ (ms)

Calls the Wait (ms) function only if no input error exists.

millizecands to wait rnillisecond timer walue
zecands to wait (unused 00 - L zecond timer value
error in (no error) [ errar out

This VI is useful when you want to wait between calls to I/O subVIs that use the error
I/0 mechanism; without it you need to use a Sequence Structure to control the execution
order.
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Note:

This chapter describes the VIs that configure and control hardware
counters. You can use these VIs to generate variable duty cycle square
waves, to count events, and to measure periods and frequencies.

You can access the Advanced Counter palette by choosing
Functions»Data Acquisition»Counter»Advanced Analog Input. The
icon that you must select to access the Advanced Counter VIs is on the
bottom row of the Counter palette, as shown below.

UTIL § RO Advanced
e, Ev, | <—— Gounter Vs

An important basic data acquisition concept is to use only the inputs that
you need on each VI. Leave the rest of the inputs unwired, and LabVIEW
sets them to their default values. In the Help window, the most important
terminals are labeled in bold, and the least commonly used are in brackets.
Values given in parentheses are default values.

The following lists the type of counter chips that your device must have
to work with your version of LabVIEW:

e Am9513, 8253, or DAQ-STC Counter Chip
e DAQ-STC Counter Chip

The ICTRControl VI works with devices that contain the 8253 counter
chip.
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Refer to Table 27-1 for the counter chips used with the various devices.

Table 27-1. Counter Chips and Their Available DAQ Devices

Counter DAQ Device
Chip

Am9513 AT-MIO-16, AT-MIO-16D, AT-MIO-16F-5,
AT-MIO-16X, AT-MIO-64F-5, PC-TIO-10, All
AO-2DC Devices, EISA-A2000, NB-MIO-16,
NB-MIO-16X, NB-DMA-8-G, NB-DMA2800,
NB-TIO-10, NB-A2000

DAQ-STC | All E Series Devices, 5102 Devices

8253 All Lab and 1200 Series Devices, DAQCard-500,
DAQCard-700, LPM Devices, 516 Devices

Advanced Counter VI Descriptions

The following Advanced Counter VIs are available.

CTR Buffer Config

Allocates memory where LabVIEW stores counter data. The CTR Buffer Config VI also
configures the specified group to perform buffered counter operations instead of the
normal single point operations.

task ID Euffgr task ID out
counts per buffer (-1:no c.._ - onfig
error out
CTR Buffer Read

Returns data from the buffer allocated by CTR Buffer Config.

e gtk Tocations
—— acquisition state
task ID Eutfer| task ID out
number to read (-1: no change) I | Fead nurnber read
i 13 binary dat

error in (no error) sl inary data
error out
backlog

tirme Timit (-1 : no change)
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Note: Incremental reading from the count buffer is not supported at this time.
Therefore, you must allow the buffer to fill before you read from it and then
you must read all of it. Until incremental reading and circular use of the
buffer are implemented, leave number to read unwired (with a value
of =1) or set it to the value of counts per buffer.

CTR Group Config

Collects one or more counters into a group. You can use counter groups containing more
than one counter to start, stop, or read multiple counters simultaneously. DAQ-STC
devices do not currently support multiple counter groups.

device Grou task ID
group = ': L group size
counter list l==l==E===ern:|nr out
error in (no error)

Table 27-2 contains valid counter numbers for devices supported by this VI.

Table 27-2. Valid Counter Numbers for CTR Group Config Devices

Device Type Valid Numbers
DAQ-STC Devices Oand 1
Am9513 MIO Devices 1,2,and 5
NB-DMA-8-G, NB-DMA2800 1 through 5
PC-TIO-10, NB-TIO-10 1 through 10
EISA-A2000, NB-A2000 2
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CTR Mode Config

Configures one or more counters for a designated counter operation and selects the
source signal, gating mode, and output behavior on terminal count (TC).

count direction
gate parameters oo
source edge

tack ID Made | tack ID out

courtar izt fmﬂslﬁ

config mode f c] error out
timebase source

error in (ne error)
timebkase =ignal

output type
output polarity

This VI does not start the counters. Use CTR Control VI with control code 1 (Start) to
start the counters. If you are using a counter for pulse generation, you do not have to call
this VI unless you want to change the gate mode or output behavior.

Modes 3, 4, and 6 can be used with or without buffered counting. Mode 7 must be used
with buffered counting. With buffered counting, call the CTR Buffer Config VI before or
after the CTR Mode Config VI and before the CTR Control VI to start the operation, then
call the CTR Buffer Read VI to read the buffered count values. With buffered or
unbuffered operations, call the CTR Control VI to read the most recently acquired,
unbuffered count value.

Unless otherwise stated, the following figures show timing and counter values for
operations in which the gate mode is set to high-level or rising-edge and the source edge
is set to rising-edge.

Use mode 1 to reset all the CTR Mode Config VI parameters to their default settings. This
mode overrides any conflicting parameter settings.

Use mode 2 to count transitions of the selected signal and to stop at the first TC. The
overflow status bit is set at TC. Use the CTR Control VI to read the overflow status. This
mode is available only with Am9513 devices. Mode 2 counting is unbuffered.
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Figure 27-1 shows the count values you would read with this mode using three gate mode
settings (gating off; high-level gating; and rising-edge gating).

Stark
Gale *_I—l | l—l_
|

Source | | LM LI Mm_rr_rn rwo

Cowker :Q&gm t—=1 3 4
Value Il =2 — G — G ] — o
Fae

Figure 27-1. Unbuffered Mode 2 and 3 Counting

Use mode 3 to count transitions of the selected signal continuously, rolling over at TC
and then continuing on. Figure 27-1 shows unbuffered mode 3 counting. Figure 27-2
illustrates a buffered mode 3 operation with rising-edge gating. This buffered operation
is available only with DAQ-STC devices. With buffered mode 3 operation, LabVIEW
stores the current count value into the buffer on each selected edge of the source signal.

Start
Conated

* | 1 !
' - Courted Evats —mim— oy —=be— Courbed Evatts —wl
1 1 = I 1
1

—

Gate

Source

.

[
3 4

Burfer

Figure 27-2. Buffered Mode 3 Counting

Use mode 4 with level gating to measure pulse width and with edge gating to measure the
period of the selected gate signal.

Note: For the following descriptions of pulse width measurements (modes 4, 6,
and 7), a high pulse is defined simply as the high-level phase of a signal
when gate mode is set to high-level gating. This definition differs from that
of a high pulse using pulse generation (mode 5), which consists of a low

© National Instruments Corporation 27-5 LabVIEW Function and VI Reference Manual



Chapter 27

LabVIEW Function and VI Reference Manual

Advanced Counter VIs

level delay phase followed by a high level pulse phase. (Low pulses are
similarly defined by switching the words high and low.)

To measure pulse width, set the gate mode to high or low level. Figure 27-3 shows
unbuffered mode 4 pulse width measurements. You can start an Am9513 counter at any
time, and it will measure pulses until you stop it. If you start it in the middle of the pulse
you want to measure (for example, during a high pulse for high-level gating), LabVIEW
returns a short count for that measurement. You must start a DAQ-STC counter only
when the signal is in the opposite polarity from the selected gate level (for example, a
low-level phase for high-level gating). Otherwise, the VI returns error number —10890.
With unbuffered counting, the DAQ-STC stops counting after one measurement. Mode
5 configures the counter for pulse generation. Use the CTR Pulse Config VI to specify
the pulse you want to generate.

Stirt 1 Start 2
I
Gaate _I | }_¢_‘ |_| | I_

1 1 1 1 1 1 1 | 1
. 1 1 | | 1 1 1 | 1

Timekase
| i1 2 | | i1 2 2 4 1 |
1 1 1 1 I 1 1 1
Amasiz 0 — = = 4 "
1 1 1 1 1 1 1 1
De-5TC ! I apror —L 1 1 g1 |
1 1 1 1 1 1 1 1

Figure 27-3. Unbuffered Mode 4 High Pulse Width Measurement

Figure 27-4 shows the buffered mode 4 pulse width measurement, which is available only
with DAQ-STC devices. The measured value is stored into the buffer at the end of each
pulse. See mode 6 for another way to measure pulse width with a DAQ-STC device.

Figure 27-4. Buffered Mode 4 Rising-Edge Pulse Width Measurement

To measure period, set the gate mode to rising or falling edge. Figure 27-5 shows
unbuffered mode 4 pulse width measurement.

You may start either an Am9513 or a DAQ-STC counter at any time. The counter begins
counting at the start of the next period. The Am9513 counter measures periods
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continuously. With unbuffered counting, the DAQ-STC stops counting after one
measurement.

Stark

aate I e I e M
I

Timebase LI LTl

24719513 0 1 4 i

DAG-5TC o 4 -

Figure 27-5. Unbuffered Mode 4 Rising-Edge Period Measurement

Figure 27-6 shows buffered mode 4 period measurement, which is available only with
DAQ-STC devices. The measured value is stored into the buffer at the end of each period.

Start

‘ Measured Measured . Measired

— 1 Peficd ———=,=—— Period —+ 1= Petiod—~

Figure 27-6. Buffered Mode 4 Rising-Edge Pulse Width Measurement

Use mode 5 to configure for pulse generation when you also need to configure the gate
mode, output type, or output polarity to non-default values. Otherwise, avoid calling
the CTR Mode Config VI and use only the CTR Pulse Config VI for pulse generation.
See the CTR Pulse Config VI more additional information about this operation.

Use mode 6 with level gating to measure the pulse width of the selected signal. This mode
is available only with DAQ-STC devices. Mode 6 differs from mode 4 in that the
measurement of a high (low) pulse does not begin until the first falling (rising) edge of
the signal after you start the counter. If you use unbuffered counting, the counter
continues to measure pulses until you call the CTR Control VI to read the most recently
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measured value, at which time the counter stops. Unbuffered mode 6 counting is
illustrated in Figure 27-7.

Start Counter Read
Gae I L] I .3y N
1 1
: | A
Timebas2 M MMM ML LCLAL L nr e
1 | 1 1
DAG-STC I 2 _ -

Figure 27-7. Unbuffered Mode 6 High Pulse Width Measurement

With buffered mode 6 counting, the measured value is stored into the buffer at the end of
each pulse, as illustrated with Figure 27-8. Call the CTR Buffer Read VI to read the
values.

Figure 27-8. Buffered Mode 6 High Pulse Width Measurement (Count on Rising Edge of Source)

Use mode 7 to measure every phase of the selected signal using buffered counting. This
mode is available only with DAQ-STC devices. The count value is stored in the buffer

on each low-to-high and high-to-low transition. Use the CTR Buffer Read VI to read the
values. To measure period with this mode, sum successive pairs of signals. To measure
phase, use every other value. LabVIEW ignores the value of gate mode with mode 7,
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which means that you cannot tell whether the first measurement starts at a rising or falling
edge.

Pairs of arrows indicate measured semi-periods

. Measured | Measured, Meamired ___ihessured) Me d 1 d
1 . asure 1 Measured |
Interval ' hteral ! hteral ' Inkerval 1 Inbarval | hteral !
Gale | i —d h—d

] I | i
| | I |
I I | I
I I I I
! L LT - T R O -
Bufer 1 Ve [ EIEF =] [E]
! TR =l ] o ET R P
: : : L4 L] R HRE]
: : : | L] I
| | | ! v : i =]
i i i i ] ] N
I
i i i i L .

Figure 27-9. Buffered Mode 7 Semi-Period Measurement

Table 27-3 shows the legal values and default settings for timebase signal. A value of -1
tells LabVIEW to use the default settings. When the table says counter, it refers to the
counter being configured. If there are multiple counters, LabVIEW configures each
counter successively.
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Refer to Table 27-3 to determine what is the next higher or lower consecutive counter.

Table 27-3. Adjacent Counters.

Next Next
Device Lower Higher
Type Counter Counter Counter
5 1 2
1 2 3
2 3 4
3 4 5
4 5 1
Am9513
10 6 7
6 7 8
7 8 9
8 9 10
9 10 6
1 0 1
DAQ-STC
0 1 0
CTR Pulse Config

Specifies the parameters for pulse generation. This VI configures the counters but does
not start them. Use the CTR Control VI with control code 1 (Start) to produce the pulse.

Tows Tevel parameters
duty cycle q

task ID
counter list f2775%
config rmode mﬁﬂi—l

error in (no error)
clock frequency
pulze mode

Pulse

Contig
i

tazk I out
actual parameters used
error out
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Use this VI to specify the characteristics of your pulses. You can also use the CTR Mode
Config VI to set your desired gate modes, output polarity, and output type. Use the CTR
Pulse Config VI to specify timebase source and timebase signal for pulse generation,
because LabVIEW ignores these values specified in the CTR Mode Config VI.

CTR Control

Controls and reads groups of counters. Control operations include starting, stopping, and
setting the output state.

change parameter data
output state ——

task (D Cortol] tazk 1D out
counter izt ué_|_.E TR read value array
control code H = overflow state aray

ermar in (o erar] &rmar out
fout data output state aray

ICTRControl

Controls counters on devices that use the 8253 chip (Lab and 1200 Series devices,
516_devices PC-LPM-16, DAQCard-500, and DAQCard 700).

count
autput state —————
device I CTR
counter Contral read value

5]
control code f 1é3 error out
error in {no error) Jpﬂm
binary ar bed
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Calibration and
Configuration Vis

This chapter describes the VIs that calibrate specific devices and set and
return configuration information.

This chapter also includes a VI for controlling the RTSI bus, which is a
triggering and timing bus you can use to synchronize, time, and trigger
multiple DAQ devices.

(Windows) There is also a VI you can use to set up data acquisition event
occurrences.

You can calibrate certain DAQ devices with the device-specific Vs, but
this is not always necessary because National Instruments calibrates all
devices at the factory.

You can access the Calibration and Configuration VIs by choosing
Functions»Data Acquisition» Calibration and Configuration as shown
below.

Calibration and Configuration

SET||INFO|[RESET][[HamL K Devi i
evice Setting and
] - . .
[25E Channel Confiquration Vls
alibr| | Calibr alibi | Calibr | Calibration Vls
=
Route Crtel | M0
Fignal - Contfig . .
e Other Calibration
an
Index || 25355 ||[] Configuration ¥ls
(| 5 -4
“-a‘ i {0
o] = =]
1] =1
Se7 || BET Cal -4 SCAl
fFo || IHFD || const
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Calibration and Configuration VI Descriptions

The following Calibration and Configuration VIs are available.

1200 Calibrate

This VI calibrates the gain and offset values for the ADCs and DACs on 1200 Series
devices (i.e., DAQPad-1200, DAQCard-1200, etc.).

C&C1 channel
[ACO channel ———
dewvice 12a0 dewice aut
calibration -~ | Calibr

zawve new calibration "
EEFPROM location —I_
ADC Calibration Cluster

=tatus

You can perform a new calibration (and optionally save the new calibration constants in
one of four user areas in the onboard EEPROM) or load an existing set of calibration
constants by copying them from their storage location in the onboard EEPROM.
LabVIEW automatically loads the calibration constants stored in the onboard EEPROM
load area when LabVIEW launches or when you reset the device. By default the
EEPROM load area contains a copy of the calibration constants in the factory area

A2000 Calibrate

Calibrates the NB-A2000 or EISA-A2000 A/D gain and offset values or restores them to
the original factory-set values.

device 2000 device out

sample clock drive fenfia
dither — status

You can calibrate your NB-A2000 or EISA-A2000 to adjust the accuracy of the readings
from the four analog input channels. LabVIEW automatically loads the stored calibration
values when it launches or when you reset your NB-A2000 or EISA-A2000.

Warning: This VI is supported only up to NI-DAQ version 4.9.0 and has been
? removed from the Calibration and Configuration palette. This VI is still
included in the DAQ VI Library for compatibility only, therefore if you are
using NI-DAQ version 5.0 or later, this VI will return the following
message: deviceSupportError. If you wish to use this VI, please
re-install NI-DAQ version 4.9.0 or an earlier version.
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Refer to Appendix A, DAQ Hardware Capabilities, for more information on the
NB-A2000 or EISA-A2000 DAQ devices.

? Warning: Read the calibration chapter in the NB-A2000 or EISA-A2000 User Manual
before using the A2000 Calibrate VI.

If you set save new values to 1, then this VI stores the gain and offset calibration values
in an EEPROM on the NB-A2000 or EISA-A2000 device, which does not lose its data
even if the device loses power. LabVIEW reads these EEPROM values and loads them
into the NB-A2000 or EISA-A2000, you can choose to replace the permanent copies of
the gain and offset EEPROM values and use the new values until the next calibration,
even if you reinitialize the device. You can also choose not to replace the EEPROM
values, but to use the new values until the next calibration or initialization.

For example, if you consistently get inaccurate readings from one or more input channels
after you reset the device, you can calibrate and save the new gain and offset values as
permanent copies in the EEPROM. However, if acquisition results are accurate after
initialization but start to drift after a few hours of device operation when the device
temperature increases, you can calibrate the device at this operating temperature and
retain the current EEPROM values to use after the next initialization.

A2000 Configure
Configures dithering and whether to drive the SAMPCLK* line for the NB-A2000 or
EISA-A2000.
device A2000 device out
sample clock drive Gonfig
P dither — status

Warning: This VI is supported only up to NI-DAQ version 4.9.0 and has been
? removed from the Calibration and Configuration palette. This VI is still
included in the DAQ VI Library for compatibility only, therefore if you are
using NI-DAQ version 5.0 or later, this VI will return the following
message: deviceSupportError. If you wish to use this VI, please
re-install NI-DAQ version 4.9.0 or an earlier version.

Refer to Appendix A, DAQ Hardware Capabilities, for more information on the
NB-A2000 or EISA-A2000 DAQ devices.

After system startup, LabVIEW configures the NB-A2000 or EISA-A2000 as follows.
¢ sample clock drive = 0: Sample clock signal does not drive SAMPCLK* line.
* dither = 0: Dither disabled.
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A2100 Calibrate (Macintosh)

Selects the desired calibration reference and performs an offset calibration cycle on the
ADCs on the NB-A2100 or the NB-A2150.

device [ — device out

AD group —— |
reference — | CAL

status

NI-DAQ driver software calibrates the two A/D channels using the analog input ground
as the reference for each channel when you turn on the computer.

A2100 Config (Macintosh)

Selects the signal source used to provide data to the DACs and lets you configure the
external digital trigger to be shared by data acquisition and waveform generation
operations on the NB-A2100.

device Br— device out

DA source — Ezzh
shared trigger —  |CORFIG

status

If LabVIEW acquires multiple data acquisition frames and generates multiple waveform
cycles with a trigger required at the beginning of each cycle, then the external trigger
recognition synchronizes so that each trigger simultaneously initiates the acquisition of
the next data frame while generating the output of the next waveform cycle.

A2150 Config (Macintosh)

Selects whether or not LabVIEW should drive an internally generated trigger to the
NB-A2150 I/O connector. This VI also determines whether LabVIEW should drive the
NB-A2150 sampling clock signal over the RTSI bus to other devices for multiple-device
synchronized data acquisition.

device ST device out

io trigger drive —— Ez=0
master clock — __|cORfIc
number of slaves
slave list

status

Enable io trigger drive only if you have executed the RTSI Control VI to receive the
RTSITRIG* signal over the RTSI bus, or if you have enabled the analog level trigger
using the Al Trigger Config VI. In these cases, you can monitor the signal being sent to
the A/D trigger circuitry at the EXTTRIG* line of the I/O connector after starting the
acquisition. A high-to-low edge of the signal triggers the data acquisition.
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The NB-A2150 uses signals over the RTSI bus for sampling clock synchronization
between two or more NB-A2150 devices. The sampling clock synchronization circuitry
makes simultaneous sampling possible on more than four channels using additional
NB-A2150 devices. If master clock is 1, slave list should contain the list of devices that
accept the sampling clock from device. After you run A2150 Config with master clock
equal to 1 and number of slaves greater than 0, you cannot use the Al Clock Config to
set the scan rate for devices in slave list until you run A2150 Config again on device with
master clock equal to 1 and number of slaves equal to 0.

Note: Executing A2150 Config with master clock equal to 1 and number of slaves
equalto 0 deconfigures the devices previously in the slave list and sets them
up to use their own sampling clock signal.

A2150 Calibrate (Windows)
Performs offset calibrations on the ADCs of the specified AT-A2150.

device AZiS0 device out
ADCO reference ——|Calibr
ADCT reference — |

status

Refer to Appendix A, DAQ Hardware Capabilities, for more information on the
AT-A2150 DAQ device.

When you launch LabVIEW, or when you reset the AT-A2150, LabVIEW performs an

offset calibration using the analog ground as the reference. Use this VI only for device

calibration to an external reference or for device recalibration for ground reference after
using an external reference.

A0-6/10 Calibrate (Windows)

Loads a set of calibration constants into the calibration DACs or copies a set of
calibration constants from one of four EEPROM areas to EEPROM area 1.

-:-Fif':tiit-::: IEah'I:-r' device out
- Bl ,
EEPROM location = ctatus

You can load an existing set of calibration constants into the calibration DACs from a
storage area in the onboard EEPROM. You can copy EEPROM storage areas 2 through 5
to storage area 1. EEPROM area 5 contains the factory calibration constants. LabVIEW
automatically loads the calibration constants stored in EEPROM area 1 upon start-up or
when you reset the AT-AO-6/10.
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Note: You can also use the calibration utility provided with the AT-A0-6/10 to
perform a calibration procedure. Refer to the calibration chapter in the
AT-AO-6/10 User Manual for more information.

Refer to Appendix A, DAQ Hardware Capabilities, for more information on the
AT-AO0-6/10 DAQ devices.

When LabVIEW initializes the AT-AO-6/10, the DAC calibration constants stored in
EEPROM location 1 (user calibration area 1) provide the gain and offset values that
ensure proper device operation. So, this initialization is the same as running the
AO-6/10 Calibrate VI with operation set to 1 and EEPROM location set to 1. When the
AT-AO0-6/10 leaves the factory, EEPROM location 1 contains a copy of the calibration
constants stored in EEPROM location 5 (factory calibration).

A calibration procedure performed in bipolar mode is not valid for unipolar mode and
vice versa. See the calibration chapter of the AT-AO-6/10 User Manual for more
information.

Channel To Index

Uses the current group configuration for the specified task to produce a list of indices into
the group’s scan or update list for each channel specified in the channel list.

task ID |
channel Tist s Inde: |

=
buffer number — ™

task ID out
= channel indices

status

You can use this list of channel indices to locate data for a particular channel within a
multiple channel buffer. You can also use the indices to read or write to a group subset
with the buffer read and write VIs.

Refer to your specific device information in Appendix A, DAQ Hardware Capabilities, for
the channel limitations that apply to your device.
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Table 28-1 shows possible values for the channel scan list, channel list, and channel
indices parameters. Table 28-2 shows the possible values for the Sun. The channel scan
list parameter is an input for the group configuration VIs.

Table 28-1. Channel to Index VI Parameter Examples

(The device samples
channel 1 three times
during a scan.)

Channel Scan List Channel List Channel Indices
1,3,4,5,7 channel list[0] = 5 channel indices[0] = 3.
Data for channel 5 is at position 3
within a scan. Indices are
zero-based.
1,3,4,5,7 channel list is of 0 length. | channel indices is of 0 length.
(In this case, status is non-zero.)
1,2,1,3,1,4 channel list[0] =1, 1,1 channelindices[0] = 0,

channelindices[1] = 2, and
channelindices[2] = 4.

The first occurrence of channel 1
within a scan is at index 0, the
second at index 2, and the third at
index 4

0,1,3,14
(For this example,
channel scan list is a

channel list[0] = 3

channel indices[0] = 2.
The eight bits of data from port 3
are at index 2 in the scan list.

digital input group.)

0:3 channel list[0] = AM1 !9 channel indices[0] = .

(One AMUX-64T in Data obtained from channel 9 on
use.) AMUX-64T device number 1 is at

index 9 in the data buffer.

SC1!MD1!CHO:7,
SC1!MD2!CHO: 4

channel list[0] =
SC1!MD2!CH3

channel indices[0] = 11.

Data obtained from channel 3 of
the SCXI module in slot 2 is at
index 11 in the data buffer.
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Table 28-2. Channel to Index VI Parameter Examples for Sun

channel scan list channel list channel indices

1,3,4,5,7 channel list[0] = 5 channel indices[0] = 3.

Data for channel 5 is at position 3
within a scan. Indices are
zero-based.

1,3,4,5,7 channel list is of 0 length. | channel indices is of 0 length. (In
this case, status is non-zero.)

1,2,1,3,1,4 channel list[0] =1, 1, 1 channel indices[0] = 0,

(The device samples channel indices[1] = 2, and
channel 1 three times channel indices[2] = 4.

during a scan.) The first occurrence of channel 1

within a scan is at index 0, the
second at index 2, and the third at
index 4

DAQ Occurrence Config (Windows)

Creates occurrences that are set by data acquisition events.

general value B
general value A —|

task ID in task ID out
oreate folear — : — OCCUr rence
DAl even't -D error out

error in {no errnr) E
channel

Tewel conditions e

A DAQ event can be the completion of an acquisition, the acquisition of a certain number
of scans, an analog signal meeting certain trigger conditions, a periodic event, an
aperiodic (externally driven) event, or a digital pattern match or mismatch. Your VI can
sleep while waiting for an occurrence to be set, freeing your computer to execute other
VIs.

When you set the create/clear control to 1 (create) and call the VI, this VI creates an
occurrence. Use the DAQ event control to select the event that sets the occurrence. Wire
the occurrence this VI produces to the Wait on Occurrence function. Anything you wire
to the output of the Wait on Occurrence function does not execute until the occurrence is
set. The occurrence is set each time the event occurs. The occurrence does not clear until
you set the create/clear control to 0 (clear) and call this VI, or call the Device Reset VI
for the device.
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LabVIEW returns a Not a Refnum file I/O constant along with a non-zero status code if
it cannot create the occurrence.

For each computer platform, LabVIEW limits the number of occurrences per second that
you can set. Although this limit depends on the speed of your computer, avoid exceeding
500 occurrences per second.

For some of the events, you must perform your operation using interrupts instead of
DMA. Refer to the description of the DAQ event control in this section for more
information.

Device Reset

Resets either an entire device or the particular function identified by taskID.

tazk I RESETI task I out
device

device string status

Resetting a taskID function has the same result as calling the control VI for that function
with control code set to clear. When you reset the entire device, LabVIEW clears all
tasks and changes all device settings to their default values.

DSP2200 Calibrate (Windows)

Performs offset calibrations on the analog input and/or analog output of the
AT-DSP2200.

device =R device out
mode =] ibr

ADC reference — |

status

Refer to Appendix A, DAQ Hardware Capabilities, for more information on the
AT-DSP2200 DAQ device.

When you launch LabVIEW or reset the AT-DSP2200, LabVIEW performs an offset
calibration on both the analog input and output using analog ground as the reference.

You can use this VI to calibrate the analog input using an external reference or to
recalibrate the AT-DSP2200 to compensate for configuration or environmental changes.
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DSP2200 Configure (Windows)

Specifies data translation and demultiplexing operations that the AT-DSP2200 performs
on analog input and output data.

device Dﬁf device out
aitranslate —] Zonfig
aotranslate — |
demux

status

Refer to Appendix A, DAQ Hardware Capabilities, for more information on the
AT-DSP2200 DAQ device.

Because software running locally on the AT&T WE DSP32C DSP chip reads data from
the ADCs and writes data to the DACs, you can manipulate the data during these
transfers. When you write analog input data to DSP memory, you can write the data as
unscaled 16-bit integers, unscaled 32C floating-point numbers, or scaled 32C
floating-point voltages. You can use the demux option only when you write analog input
data to DSP memory. When you enable demux, the device writes data from channel 0
consecutively into DSP memory, beginning at the start of each buffer, and writes channel
1 data consecutively beginning at the half-way point of each buffer. When the device
writes analog input data to PC memory, it can write the data as unscaled 16-bit integers,
unscaled IEEE single-precision floating-point numbers, or scaled IEEE single-precision
voltages.

The analog output translations in the opposite directions from the analog input
translations. If aotranslate is 0, the source data must be in a format suitable for the DACs
(16-bit integer DAC values). If aotranslate is 1 or 3, the source data are DAC values in
32C format in DSP memory or in IEEE single-precision format in PC memory. If
aotranslate is 2 or 4, the source data are voltages in 32C format in DSP memory or in
IEEE single-precision format in PC memory.

E-Series Calibrate (Windows)

Use this VI to calibrate your E Series device and to select a set of calibration constants
to be used by LabVIEW.

task ID E-Zericd task ID out
aperation — Calibr
calibration constants f error out
error in (no error)
reference voltage

Warning: Read the calibration chapter in your device user manual before using the
E-Series Calibrate VI.
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Your device contains calibration D/A converters (calDACs) that are used for fine-tuning
the analog circuitry. The calDACs must be programmed (loaded) with certain numbers,
called calibration constants. Those constants are stored in non-volatile memory
(EEPROM) on your device or are maintained by LabVIEW. To achieve specification
accuracy, you should perform an internal calibration of your device just before a
measurement session, but after your computer and the device have been powered on and
allowed to warm up for at least 15 minutes. Frequent calibration produces the most stable
and repeatable measurement performance. The device is not harmed in any way if you
recalibrate it as often as you like.

Two sets of calibration constants can reside in two areas inside the EEPROM, called load
areas. One set of constants is programmed at the factory, the other is left for the user.
One load area in the EEPROM corresponds to one set of constants. The load area
LabVIEW uses for loading calDACs with calibration constants is called the default load
areas. When you get the device from the factory, the default load area is the area that
contains the calibration constants obtained by calibrating the device in the factory.
LabVIEW automatically loads the relevant calibration constants stored in the load area
the first time you call a VI that requires them.

Note: Calibration of your E Series device takes some time. Do not be alarmed if
the VI takes several seconds to execute.

Warning: When you run this VI with the operation set to self calibrate or external
? calibrate, LabVIEW will abort any ongoing operations the device is
performing and set all configurations to their defaults. Therefore, you
should run this VI before any other DAQ VIs or when no other operations
are running.

12-hit E Series Devices

e Connect the positive output of your reference voltage source to the analog input
channel 8.

¢ Connect the negative output of your reference voltage source to the AISENSE line.
*  Connect DACO line (analog output channel 0) with analog input channel 0.

e If your reference voltage source and your computer are floating with respect to each
other, connect the AISENSE line with the AIGND line as well as with the negative
output of your reference voltage source.

16-hit E Series Devices

¢ Connect the positive output of your reference voltage source to the analog input
channel 0.
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e Connect the negative output of your reference voltage source to the analog output
channel 8 (by performing those two connections you supply reference voltage to the
analog input channel 0, which is configured for differential operation.)

e If yourreference voltage source and your computer are floating with respect to each
other, connect the negative output of your reference voltage source to the AIGND
line, as well as to the analog input channel 8.

Get DAQ Device Information

Returns information about a DAQ device.

tazk |0 or device IMFO task 10 oot

infarmation hpe B infarmation string
2rar in [fo ermar] E¥ ermar out

Refer to Appendix A, DAQ Hardware Capabilities, for the transfer methods available with
your DAQ device.

Get SCXI Information

Returns the SCXI chassis configuration information that you set using the configuration
utility or the Set SCXI Information VI.

chassis type

o] chazziz address
slot inforrmation

HEn [— — communication mode

| "~ L— =status
cormunication path

device string

LPM-16 Calibrate

Calibrates the PC-LPM-16 or PC-LPM-16PnP converter. The calibration calculates the
correct offset voltage for the voltage comparator, adjusts positive linearity and full-scale
errors to less than 0.5 LSB each, and adjusts zero error to less than +1 LSB.

device LP1E device out
Calibr
ctatus

Refer to Appendix A, DAQ Hardware Capabilities, for more information on the
PC-LPM-16, DAQCard-500, or DAQCard-700 device.
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Master Slave Config

Configures one device as a master device and any remaining devices as slave devices for
multiple-buffered analog input operations.

M/ F— Mazter TaskiD Out
Master Taskll ——(Config
Slave TasklD List ——

— Statu=

Warning: This VI is supported only up to NI-DAQ version 4.9.0 and has been
? removed from the Calibration and Configuration palette. This VI is still
included in the DAQ VI Library for compatibility only, therefore if you are
using NI-DAQ version 5.0 or later, this VI will return the following
message: deviceSupportError. If you wish to use this VI, please
re-install NI-DAQ version 4.9.0 or an earlier version.

Makes sure LabVIEW always re-enables the slave devices before the master device in a
multiple-buffer analog input operation. Only the following devices, which support
multiple buffered acquisitions, can use this VI.

*  (Macintosh) NB-A2000, NB-A2100, and NB-A2150.

The master device sends a trigger or clock signal to the slave device(s) to control the
slave device sampling. In a multiple-buffer acquisition, you must enable the slave device
before the master device to make sure the slave device always responds to a master
signal. If you enable the master device first, it can send a signal to the slave devices
before they can respond. You are responsible for the initial startup order. You should
always start the master device last. The Master Slave Configuration VI makes sure
LabVIEW arms the master device last for each subsequent buffer acquired during a
multiple-buffer acquisition.

MIO Calibrate (Windows)

Calibrates the AT-MIO-16F-5, AT-MIO-64F-5, and AT-MIO-16X gain and offset values
for the ADCs and the DACs. You can either perform a new calibration or use an existing
set of calibration constants by copying the constants from their storage location in the
onboard EEPROM. You can store several sets of calibration constants. LabVIEW
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automatically loads the calibration constants stored in the EEPROM load area during
startup or when you reset the device.

reference location
DaCT channel

DACO channel — ]

device M0 device out
calibration — |Calibr| |
save new calibration — ]

EEFROM location —
reference channel Q
reference voltage

ctatus

The load area for the AT-MIO-16F-5 is user area 5. The load area for the AT-MIO-64F-5
and AT-MIO-16X is user area 8.

Warning: Read the calibration chapter in your device user manual before using the
MIO Calibrate VL.

Refer to Appendix A, DAQ Hardware Capabilities, for more information on the
AT-MIO-16F-5, AT-MIO-64F-5, and AT-MIO-16X DAQ devices.

Note: You should always calibrate the ADC and the DACs after you calibrate the
internal reference voltage.

Note: If the device takes analog input measurements with the wrong set of
calibration constants loaded, you may get erroneous data.

MIO Configure (Windows)

Turns dithering on and off. This VI supports the following devices: AT-MIO-16F-5,
AT-MIO-64F-5, all 12-bit E Series devices, and all 1200 Series devices.

device B0 device oul
dither — |Config
status

Refer to Appendix A, DAQ Hardware Capabilities, for more information on the devices
supported by this VI.

Route Signal

Use this VI to route an internal signal to the specified I/O connector or RTSI bus line, or
to enable clock sharing through the RTSI bus clock line.
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Note: This VI is supported by E Series and 54XX Series devices only.

task ID Fioute task ID out
zignal narme — %
gignal source mrﬂ—l error out
error in {no error)

RTSI Control

Connects or disconnects trigger and timing signals between DAQ devices along the
Real-Time System Integration (RTSI) bus.

device Crtel device out
contral code — &?@ = t-igger line usemap
board signal — |
trigger line —|_|_ status
direction

This VI is not supported for E Series devices. For E Series devices, multiple RTSI
connections can be set directly in the analog input, analog output, and counter VIs and
used along with the Route Signal VI. Other RTSI connections must be made using the
Route Signal VI.

SCXI Cal Constants

Calculates calibration constants for the given channel and range or gain using measured
voltage/binary pairs. You can use this VI with any SCXI module.

TE Gain {1.00

Cal Constant In 1
Yalt/ Amp 2

Yolt/ dmp 1

SCEI Chassis Cluster
Task ID - Task 10 Out

A
Op Code Cal Cal Constant Out 1

Cal Area Lonzt L a1 Canstant Out 2
Range Code errar out
SCH1 Gain
ertor in (no error)
LAl Board Cluster s
Binary 1
Binary 2
Cal Constant In 2
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Set DAQ Device Information

Sets the data transfer mode for different types of operations.

task ID SET task I out
infarrmation type
infarration setting error out
error in (no error)

Refer to Appendix A, DAQ Hardware Capabilities, for the transfer methods available with
your DAQ device.

Set SCXI Information

Sets the SCXI chassis configuration information.

=lot information

device string ]
chassizs type — e

chassis address — | |?1EFI:|

communication mode —
cornrunication path

status

Use this VI to override the configuration already set with the configuration utility You
can use this VI instead of using the configuration utility to enter the chassis configuration
information. If you do not use this VI, the first VI that accesses an SCXI chassis
automatically tries to load information from the configuration file.

Channel Configuration Vls

The following illustration shows the Channel Configurations VIs palette.

Channel Utilities
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Set DAQ Configuration File (Windows)
Sets the default DAQ Configuration file, which the NI-DAQ driver uses.

file path [dialog if empty] SET new file path (Mot & Path ...
error in [no eror) AE] Error ot

Note: This VI is specific to computers running Windows with NI-DAQ 5.0 or
later. LabVIEW returns an UnsupportedError message if you attempt to
run this VI on computers not running Windows.

Get DAQ Channel Names (Windows)

Returns the an array of all the channel names in the default configuration file. A
corresponding array of the channels' configured physical units is also returned.

(FET_poonscon channel names
%= channel unitz

. w0
&rrar in [hio erar] 1 Pt 2rior ot

Note: This VI is specific to computers running Windows with NI-DAQ 5.0 or
later. LabVIEW returns an UnsupportedError message if you attempt to
run this VI on computers not running Windows.
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This chapter describes the data acquisition Signal Conditioning Vs,
which you use to convert analog input voltages read from resistance
temperature detectors (RTDs), strain gauges, or thermocouples into
units of strain or temperature.

You can edit the conversion formulas used in these VIs or replace them
with your own to meet the specific accuracy requirements of your
application. If you edit or replace the formulas, you should save the new
VI in one of your own directories or folders outside of vi.lib.

You can access the Signal Conditioning VIs by choosing
Functions»Data Acquisition»Signal Conditioning, as shown below.

FO Data Acquisition
Signal Conditioning

] ] ] ]
Br " |By B, |,
IIE'I-..E'I-E
Sl
i) [ ~—Signal Conditioning
TR | T [ e
: iy RTo
e e |t 5 Pty
soalg | oo
oyt |
”s £CAN
s W

© National Instruments Corporation 29-1 LabVIEW Function and VI Reference Manual



Chapter 29 Signal Conditioning Vs

Signal Conditioning VI Descriptions

The following Signal Conditioning VIs are available.

Convert RTD Reading
Converts a voltage you read from an RTD into temperature in Celsius.
Ra
RTDvolts JoA
Ie: ﬂc%TN% RTDtemp-
E— 1

This VI first finds the RTD resistance by dividing RTDVolts by Iex. The VI then
converts the resistance to temperature using the following solution to the Callendar
Van-Dusen equation for RTDs:

Rt = Ro[1 + At + Bt + C(t-100)t3]

For temperatures above 0° C, the C coefficient is 0, and the preceding equation reduces
to a quadratic equation for which the algorithm implemented in the VI gives the
appropriate root. So, this conversion VI is accurate only for temperatures above 0° C.

Your RTD documentation should give you Ro and the A and B coefficients for the
Callendar Van-Dusen equation. The most common RTDs are 100-Q platinum RTDs that
either follow the European temperature curve (DIN 43760) or the American curve. The
following table gives the values for A and B for the European and American curves.

European Curve (DIN 43760) American Curve
A =3.90802e-03 A =3.9784e-03
B =-5.80195¢-07 B =-5.8408¢-07
(o =0.00385; 0 = 1.492) (o =0.00392; 0 = 1.492)

Some RTD documentation gives values for o and 0, from which you can calculate A and
B using the following equations:

A =a(l + 0/100)

B = —00/1002
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Convert Strain Gauge Reading

Converts a voltage you read from a strain gauge to units of strain.

Rg(120)
GF
¥
"Ry s
Bridge Configuration (3]
Yex(Z Z3)
- Winit
[l

Strain

STRAIN
CoHY

The conversion formula the VI uses is based solely on the bridge configuration.
Figures 29-1 through 29-3 show the seven bridge configurations you can use and the
corresponding formulas. For all bridge configurations, the VI uses the following formula
to obtain Vr:

Vr = (Vsg — Vinit) / Vex

In the circuit diagrams, VOUT is the voltage you measure and pass to the conversion VI
as the Vsg parameter. In the quarter-bridge and half-bridge configurations, R1 and R2 are
dummy resistors that are not directly incorporated into the conversion formula. The
SCXI-1121 and SCXI-1122 modules provide R1 and R2 for a bridge-completion network,
if needed.

Refer to your Getting Started with SCXI manual for more information on
bridge-completion networks and voltage excitation.
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Figures 29-1 through 29-3 illustrate the bridge-completion networks available.

RL

bridgeConfig = 1 [ Eridge 1]

. - AW I'-.
srEnlE) = e Ut

Fale)
+
Vo =
i Fig [duminn g
bridgeConfig = 1 [GtrBridge 1]
slrain 5] = G-Fﬁ%?ﬂ . 1+—%

Figure 29-1. Strain Gauge Bridge Completion Networks (Quarter-Bridge Configuration)
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bridgeConfig = 2 [Half Eridge |
N Ay AL
RN (2] = Ty - e e T G”‘F&E

bridgaConfig = 2 [H=lf Bridge 1]
2 £ooRL™
R

strain (4] = o
T GF

Figure 29-2. Strain Gauge Bridge Completion Networks (Half-Bridge Configuration)
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bridgeConfig = 5 [Full Eridge 1]

oy
SN SE AT

bridgeConfig = £ [Full Bridge 1]

N Y,
SN e 1]- [T

Figure 29-3. Strain Gauge Bridge Completion Networks (Full-Bridge Configuration)
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Convert Thermistor Reading

Converts a thermistor voltage into temperature. This VI has two different modes of
operation for voltage-excited and current-excited thermistors.

Type of Excitation ——|—|
THERMT

Yoltage

Valtage Beference — L
Ri —— &2

Temperature

=

*
;o

Excitation Curtent

This VI has two modes of operation for use with different types of thermistor circuits.
Figure 29-4 shows how the thermistor can be connected to a voltage reference. This is
the setup used in the SCXI-1303, SCXI-1322, SCXI-1327, and SCXI-1328 terminal
blocks, which use an onboard thermistor for cold-junction compensation.

A

Figure 29-4. Circuit Diagram of a Thermistor in a Voltage Divider

Figure 29-5 shows a circuit where the thermistor is excited by a constant current source.
An example of this setup would be the use of the DAQPad-MIO-16XE-50, which
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provides a constant current output. The DAQPad-TB-52 has a thermistor for
cold-junction sensing.

s e

Figure 29-5. Circuit Diagram of a Thermistor with Current Excitation

If the thermistor is excited by voltage, the following shows equation relating the
thermistor resistance, R, to the input values:

P I
T ! |:VREF_ VOD

If the thermistor is current excited, the equation is

R —VO
T gy

The following equation is the standard formula the VI uses for converting a thermistor
resistance to temperature:

1
T, =

a+b(InRy)+c(InRy)’

The values used by this VI for a, b, and ¢ are given below. These values are correct for
the thermistors provided on the SCXI and DAQPad-TB-52 terminal blocks. If you are
using a thermistor with different values for a, b, and ¢ (refer to your thermistor data
sheet), you can edit the VI diagram to use your own a, b, and ¢ values.

a= 1.295361E-3

b= 2.343159E-4

c= 1.018703E-7

The VI produces a temperature in degrees Celsius. Therefore, T = T — 273.15.
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Convert Thermocouple Buffer

Converts a voltage buffer read from a thermocouple into a temperature buffer value in
degrees Celsius.

Yoltage Buffer TC LIN Temperature Buffer
C.JC Yoltage BUFF
ThermocoupleType —— =
C.JC Sensor{D) g

Convert Thermocouple Reading
Converts a voltage read from a thermocouple into a temperature value in degrees Celsius.

Thermuculﬁulle Yoltage THEERD Linearized Temperature
C Yoltage | ’
ThemrmocoupleType ——1

CJC Sensor(0)

Scaling Constant Tuner

Adjusts the scaling constants, which LabVIEW uses to account for offset and non-ideal
gain, to convert analog input binary data to voltage data.

task ID scabi task ID out
channel Tist scposssag LON binary offzets oul
binary offsets —r 5.2 actual gains out
precision voltages status
binary readings

To use this VI correctly, you must first take two analog input readings—a zero offset
reading and a known-voltage reading.

The default binary offset for each channel in the group is 0. To determine the actual
binary offset for a channel path, ground the channel inputs and take a binary reading, or
take multiple binary readings and average them to get fractional LSBs of the offset.

If you use SCXI, ground the inputs of the SCXI channels to measure the offset of the
entire signal path, including both the SCXI module and the DAQ device. The SCXI-1100,
SCXI-1122, and SCXI-1141 modules have an internal switch you can use to ground the
amplifier inputs without actually wiring the terminals to ground. To use this feature, type
the special SCXI string CALGND in your SCXI channel string as described in the Amplifier
Offset section of Chapter 19, Common SCXI Applications, in the LabVIEW Data
Acquisition Basics Manual. Use intermediate or advanced analog input VIs to get binary
data instead of voltage data.
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Note: If your device supports dithering, you should enable dither on your DAQ
device when you take multiple readings and average them.

LabVIEW assumes the DAQ devices gain settings and SCXI modules are ideal when it
scales binary readings to voltage, unless you use this VI to determine actual gain values
for the channels. Apply a known precision voltage to each channel and take a binary
reading, or take multiple readings from each channel and compute an average binary
reading for each channel. Your precision voltage should be about ten times as accurate
as the resolution of your DAQ device to produce meaningful results. When you wire
binary readings, precision voltages, and binary offsets to this VI, LabVIEW
determines the actual gain using the following formula:

voltage resolution * (binary reading — binary offset)
precision voltage

actual gain =

In this formula, the voltage resolution value expressed in volts per LSB and is a value
that varies depending on the DAQ device type, the polarity setting, and the input range
setting. For example, the voltage resolution for a PCI-MIO-16E-1 device in bipolar mode
with an input range of +5 to -5 V is 2.44 mV. The VI returns an array of the actual gain
values that the VI stores for each channel.

I+ Note: When you take readings to determine the offset and actual gain, you should
use the same input limits settings and clock rates that you use to measure
your input signals.

LabVIEW uses the following equation to scale binary readings to voltage:

voltage resolution * (binary reading — binary offset)

voltage = gain

When you run the AI Group Config VI, it sets the attributes of all the channels in the
group to their defaults, including the binary offset and gain values.

You can wire channel list if you want to adjust the scaling constants for a subset of the
channels in the group. If you leave channel list unwired, the VI adjusts the scaling
constants for all channels in the group. The VI uses the same method as the Al Hardware
Config VI to apply values in the binary offsets, precision voltages, and binary readings
input arrays That is, if you wired channel list first (at index 0) of the input arrays apply
to the channels listed at index O of channel list if you wired channel list, or to the
channels listed at index O of channel list. If you leave channel list unwired, the first
values of the input arrays apply to the first channel in the group. The VI applies the values
of each input array to channel list channels or the group in this manner until the VI
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exhausts the arrays. If channels in channel list or in the group remain unconfigured, the
VI applies the final values in the arrays to all the remaining unconfigured channels.

If you want to adjust only the channel offsets, and you want to assume the gain settings
on the DAQ device and SCXI modules are ideal, wire only binary offsets and leave
precision voltages and binary readings unwired.

You can also use this VI to retrieve the binary offset and actual gain values for all the
channels in the group by wiring taskID only.

After you use this VI to adjust the scaling constants for a channel path, any analog input
VIs that return voltage data use the adjusted constants for scaling. You can use the Al
Group Config VI to reset the scaling constants for each channel in the group to their
default values (zero offset and ideal gain).

SCXI Temperature Scan

This VI returns a single scan of temperature data from a list of SCXI channel. The SCXI
Temperature Scan VI uses averaging to reduce 60 Hz and 50 Hz noise, performs
thermocouple linearization, and performs offset compensation for the SCXI-1100
module.

CJC zenzor type [IC)
ternperature units (C)

devicel(1) readings
channels (ob0lsc1Imd1 10:3)
channel sensor types [J tc) errar out

channel signal limits (£50C)
ertar in (no error)
iteration
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Introduction to LabVIEW
Instrument Driver Vis

This chapter includes an overview of LabVIEW instrument drivers and
the GPIB, serial port, instrument driver template, and VISA VIs and
functions. It also contains a history of the GPIB, and an explanation of
GPIB improvements and standards. Descriptions of the VIs and
functions comprise Chapter 31 through Chapter 37.

You can find the Instrument Driver VIs in the Functions palette from
your block diagram in LabVIEW. The Instrument Driver VIs are
located near the bottom of the Functions palette.

To access the Instrument I/O palette, choose
Functions»Instrument I/O, as shown in the following illustration.

iE»! Functions X |
Instrument 1/0

C C
men (23] |[EF
o
’

M 13
iaikE| o)

B EVE VB

&

The Instrument I/O palette consists of the following subpalettes:
* VISA
e Traditional GPIB
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* GPIB 488.2

e Serial

You can find helpful information about individual VIs online by using
the LabVIEW Help window (Help»Show Help). When you place the
cursor on a VI icon, the wiring diagram and parameter names for that
VI appear in the Help window. You can also find information for front
panel controls or indicators by placing the cursor over the control or
indicator with the Help window open. For more information on the
LabVIEW Help window, refer to the Getting Help section in Chapter 2,
Creating Vls, of the LabVIEW User Manual.

In addition to the Help window, LabVIEW has more extensive online
information available. To access this information, select Help»Online
Reference. For most block diagram objects, you can select Online
Reference from the object’s pop-up menu to access the online
description. For information on creating your own online reference
files, see the Creating Your Own Help Files section in Chapter 25,
Managing Your Applications of the LabVIEW User Manual.

Instrument Drivers Qverview

A LabVIEW instrument driver is a set of VIs that control a
programmable instrument. Each VI corresponds to a programmatic
operation such as configuring, reading from, writing to, or triggering
the instrument. LabVIEW instrument drivers simplify instrument
control and reduce test program development time by eliminating the
need to learn the low-level programming protocol for each instrument.

The LabVIEW instrument driver library contains instrument drivers for
a variety of programmable instrumentation, including GPIB, VXI, and
serial. If a driver for your instrument is in the library, you can use it as
is to control your instrument. Instrument drivers are distributed with
their block diagram source code, so you can customize them for your
specific application. If a driver for your particular instrument does not
exist, you can:

e  Try using a driver for a similar instrument. Often similar
instruments from the same manufacturer have similar if not
identical instrument drivers.

*  Modify the Instrument Driver Template VIs to create a new driver
for your instrument.
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e Use either the GPIB, VXI, Serial, or VISA 1/0O libraries provided
with LabVIEW to send commands directly to your instrument.

Instrument Driver Distribution

LabVIEW instrument drivers are distributed in a variety of media
including electronic via bulletin board and internet and CD-ROM.

You can download the latest versions of the LabVIEW instrument
drivers from one of the National Instruments bulletin boards and, if you
have internet access, you can download the latest instrument driver files
from the National Instrument File Transfer Protocol site. See the
Bulletin Board Support and FTP Support sections of Appendix E,
Customer Communication.

CD-ROM Instrument Driver Distribution

The entire library of LabVIEW instrument drivers is available on
CD-ROM. The instrument driver CD-ROM is available from National
Instruments at no charge.

You can retrieve the latest instrument driver list on a touch-tone phone
by calling the National Instruments automated fax system, Fax-on-
Demand, at (512) 418-1111 or by calling National Instruments.

Instrument Driver Template Vis

The LabVIEW instrument driver templates are the foundation for all
LabVIEW instrument driver development. The templates have a simple,
flexible structure and a common set of instrument driver VIs that you
can use for driver development. The VIs establish a standard format for
all LabVIEW drivers and each has instructions for modifying it for a
particular instrument.

The LabVIEW instrument driver templates are predefined instrument
driver VIs that perform common operations such as initialization,
self-test, reset, error query, and so on. Instead of developing your own
VIs to accomplish these tasks, you should use the LabVIEW instrument
driver template VIs, which already conform to the LabVIEW standards
for instrument drivers.

Chapter 33, Instrument Driver Template Vls, provides more information
on the Instrument Driver Template VlIs.
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Introduction to VISA Library

VISA (Virtual Instrument Software Architecture) is a single interface
library for controlling VXI, GPIB, RS-232, and other types of
instruments. The VISA Library provides a standard set of I/O routines
used by all LabVIEW instrument drivers. Using the VISA functions,
you can construct a single instrument driver VI which controls a
particular instrument model across different I/O interfaces.

An instrument descriptor string is passed to the VISA Open function in
order to select which kind of I/O will be used to communicate with the
instrument. Once the session with the instrument is open, functions such
as VISA Read and VISA Write perform the instrument I/O activities in
a generic manner such that the program is not tied to any specific GPIB
or VXI functions. Such an instrument driver is considered to be
interface independent and can be used as is in different systems.

Instrument drivers which use the VISA functions perform activities
specific to the instrument, not to the communication interface. This
creates more opportunities for using the instrument driver in many

diverse situations.

For more information on VISA functions, see Chapter 34, VISA Library
Reference.

Introduction to GPIB

History of the GPIB

The General Purpose Interface Bus (GPIB) is a link, or interface
system, through which interconnected electronic devices communicate.

Hewlett-Packard designed the GPIB (originally called the HP-IB) to
interconnect and control its line of programmable instruments. The
GPIB was soon applied to other applications such as intercomputer
communication and peripheral control because of its 1 Mbytes/s
maximum data transfer rates. It was later accepted as IEEE Standard
488-1975 and has since evolved into ANSI/IEEE Standard 488.2-1987.
The versatility of the system prompted the name General Purpose
Interface Bus. For a basic description of the GPIB, see Appendix C,
Operation of the GPIB.
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National Instruments brought the GPIB to users of
non-Hewlett-Packard computers and devices, specializing in both
high-performance, high-speed hardware interfaces and comprehensive,
full-function software. The GPIB functions for LabVIEW follow the
IEEE 488.2 specification.

The IEEE 488.2 Standard

The ANSI/IEEE Standard 488.2-1987 expanded on the earlier

IEEE 488.1 standard to describe exactly how the Controller should
manage the GPIB, including the standard messages that compliant
devices should understand, the mechanisms for reporting device errors
and other status information, and the various protocols that discover and
configure compliant devices connected to the bus.

The original standard, renamed IEEE 488.1, addressed only the
hardware specifications of the GPIB cable and basic protocols. Its main
shortcoming was that it left the interpretation of the standard as it
applied to GPIB devices up to the instrument manufacturers. Thus, each
GPIB instrument had a unique command set. To integrate each
instrument into a particular GPIB system, programmers had to learn
programming particulars for each device, a time-consuming and
frustrating process. IEEE 488.2 specifically states how compliant
devices must communicate. This standard, along with Standard
Commands for Programmable Instruments (SCPI), which defines
specific function-dependent command sets, makes instrument
programming more uniform.

The IEEE 488.2 standard also addresses Controller issues, such as the
capabilities a compatible Controller must have. For example, the ability
to monitor any of the bus lines at any time is crucial for detecting active
devices (Talkers and Listeners) on the GPIB. IEEE 488.2 also defines
the bus commands and protocols a Controller must use. The new
standard also lists minimum functionality requirements, which directly
influence the style of the NI-488.2 software in general and the GPIB
488.2 functions for LabVIEW in particular. Appendix C, Operation of
the GPIB, for more information on Talkers, Listeners, and Controllers.
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Compatible GPIB Hardware

The following National Instruments GPIB hardware products are
compatible with LabVIEW:

LabVIEW for Windows 95 and Windows 95-Japanese

AT-GPIB/TNT, AT-GPIB/TNT (PnP), AT-GPIB/TNT+ 2 PCI-
GPIB

PCMCIA-GPIB, PCMCIA-GPIB+
GPIB-ENET

EISA-GPIB

VXIpc Model 850

NEC-GPIB/TNT, NEC-GPIB/TNT (PnP)
GPIB-PCII/IIA

PC/104-GPIB

CPCI-GPIB

GPIB-ENET

PMC-GPIB

LabVIEW for Windows NT

AT-GPIB, AT-GPIB/TNT
PCMCIA-GPIB
PCI-GPIB

VXIpc Model 850
GPIB-ENET

LabVIEW for Windows 3.1

AT-GPIB, AT-GPIB/TNT, AT-GPIB/TNT (PnP), AT-GPIB/TNT+
PCI-GPIB

PCMCIA-GPIB, PCMCIA-GPIB+
GPIB-ENET

EISA-GPIB

VXIpc Model 850

NEC-GPIB/TNT (Japanese), NEC-GPIB/TNT (PnP) (Japanese) 2
GPIB-PCII/IIA

GPIB-232CT-A
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* GPIB-485CT-A
* GPIB-1284CT

e PCII/ITIA

e STD-GPIB

¢« EXM-GPIB

¢« MC-GPIB

LabVIEW for Mac 0S
« PCI-GPIB

* NB-GPIB/TNT, NB-GPIB-P/TNT

¢ PCMCIA-GPIB

« LC-GPIB

* GPIB-ENET

« GPIB-232CT-A

¢ GPIB-SCSI-A

e PC/104-GPIB

e NB-DMAZ2800 (Traditional GPIB VI's only)

LabVIEW for HP-UX

e GPIB-ENET
 EISA-GPIB
e AT-GPIB/TNT

LabVIEW for Sun (Solaris)

* GPIB-ENET
* GPIB-SCSI-A
*  SB-GPIB/TNT

LabVIEW for Concurrent PowerMAX

« GPIB-1014
 GPIB-1014D
* GPIB-1014P

» GPIB-1014DP
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LabVIEW Traditional GPIB Functions

The traditional GPIB functions are compatible with all the GPIB boards
listed in the Compatible GPIB Hardware section of this chapter.

These traditional GPIB functions are compatible with both IEEE 488
and IEEE 488.2 devices and are suffcient for most applications. For
more complex applications, such as using several devices and more than
one GPIB interface, you can use the GPIB IEE 488.2 functions.

For more information on the LabVIEW Traditional GPIB functions, see
Chapter 35, Traditional GPIB Functions.

GPIB 488.2 Functions

Using GPIB 488.2 functions together with IEEE 488.2-compatible
devices improves the predictability of instrument and software behavior
and lessens programming differences between instruments of different
manufacturers.

The latest revisions of many National Instruments GPIB boards are
fully compatible with the IEEE 488.2 specification for Controllers. The
LabVIEW package also contains functions that make use of

IEEE 488.2. By using these functions, your programming interface will
strictly adhere to the IEEE 488.2 standard for command and data
sequences.

The GPIB 488.2 functions contain the same basic functionality as the
traditional GPIB functions, and include the following enhancements
and additions:

*  You specify the GPIB device address with an integer instead of a
string. Further, you specify the bus number with an additional
numeric control, which makes dealing with multiple GPIB
interfaces easier.

*  You can determine the GPIB status, error, and/or byte count
immediately from the connector pane of each GPIB 488.2 function.
You no longer need to use the GPIB Status Function to obtain error
and other information.

e  The FindLstn Function implements the IEEE 488.2 Find All
Listeners protocol. You can use this function at the beginning of an
application to determine which devices are present on the bus
without knowing their addresses.

* The GPIB Misc Function is still available, but it is no longer
necessary in most cases. IEEE 488.2 specifies routines for most
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GPIB application needs, which are implemented as functions.
However, you can mix the GPIB Misc Function, as well as other
GPIB functions, with the GPIB 488.2 functions if you need to.

e There are GPIB 488.2 functions with low-level as well as
high-level functionality, to suit any GPIB application. You can use
the low-level functions in Non-Controller situations or when you
need additional flexibility.

e Although you must use an IEEE 488.2-compatible Controller to use
these functions, they can control both IEEE 488.1 and IEEE 488.2
devices. The GPIB 488.2 functions are divided into five functional
categories: single-device, multiple-device, bus management,
low-level, and general.

Single-Device Functions

The single-device functions perform GPIB I/O and control operations
with a single GPIB device. In general, each function accepts a
single-device address as one of its inputs.

For more information on Single-Device Functions, see Chapter 36,
GPIB 488.2 Functions.

Multiple-Device Functions

The multiple-device functions perform GPIB I/O and control operations
with several GPIB devices at once. In general, each function accepts an
array of addresses as one of its inputs.

For more information on Multiple Device Functions, see Chapter 36,
GPIB 488.2 Functions.

Bus Management Functions

The bus management functions perform system-wide functions or
report system-wide status.

For more information on Bus Management functions, see Chapter 36,
GPIB 488.2 Functions.

Low-Level Functions

The low-level functions let you create a more specific, detailed program
than higher-level functions. You use low-level functions for unusual
situations or for situations requiring additional flexibility.
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For more information on Low-Level functions, see Chapter 36,
GPIB 488.2 Functions.

General Functions

The general functions are useful for special situations. The following
table lists the general functions:

For more information on General functions, see Chapter 36,
GPIB 488.2 Functions.

Serial Port VI Overview

The serial port VIs configure the serial port of your computer and
conduct I/0 using that port.

For more information on serial port functions, see Chapter 37,
Serial Port VIs.
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LabVIEW Instrument Driver
Models

This chapter contains an overview of the LabVIEW instrument driver
external interface model and the LabVIEW Instrument Driver Internal
Design Model.

The following two conceptual models help define a standard for
LabVIEW instrument driver software design, development and use. The
first model, the instrument driver external interface model, shows how
the instrument driver interfaces with other system components. The
second model, the instrument driver internal design model, defines the
internal organization of an instrument driver software module.

LabVIEW Instrument Driver External Interface Model

The following figure shows a general model of how a LabVIEW
instrument driver interfaces with the rest of the system.

Application Program

» 4

Interactive Programmatic
Developer Interface Developer Interface

Instrument Driver
(Functional Body)

Subroutine 1/0 Interface
Interface (VISA)

Figure 31-1. General Model of Instrument Drivers in LabVIEW
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Functional Body

The functional body is the actual code for the instrument driver. Refer
to the LabVIEW Instrument Driver Internal Design Model section of this
chapter, for more information.

The most successful instrument driver products historically have been
developed by using a standard programming language for the functional
body. This is the approach LabVIEW instrument drivers take. The
advantages include greater developer control over the driver, more
robust drivers, and increased functionality. LabVIEW instrument
drivers are written using the standard LabVIEW graphical
programming environment.

The functional body of a LabVIEW instrument driver is a set of VIs that
control a specific instrument. The source code for these VIs are block
diagrams consisting of executable icons connected by data flow wires.
Because the functional body is developed with the standard tools
provided in LabVIEW, users can view instrument driver source code
easily and optimize it for their application.

Interactive Developer Interface

The interactive developer interface of a LabVIEW instrument driver is
the front panel. It is analogous to a physical instrument panel and is the
interactive user interface of the VI. On the panel, controls and
indicators graphically represent the inputs and outputs of the VI. With
the LabVIEW front panel, users can operate individual instrument
driver VIs interactively and verify communication.

Programmatic Developer Interface

The icon/connector is the programmatic interface of the LabVIEW
instrument driver V1. It consists of a graphical representation of the VI
(icon) and a definition of the input and output terminals for the VI
(connector). When you call or execute a VI from another VI, you place
a copy of the subVI icon/connector in the block diagram of the calling
VI. Information passes between the two VIs through the connector
terminals. There are several benefits to this approach. You can assemble
test systems easily using LabVIEW instrument drivers by combining a
few instrument driver VIs, each using multiple parameters. The
instrument driver interface in the user program is modular and easy to
identify, and you can recall the VI front panels during debugging to
understand how the program uses the instrument driver.
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1/0 Interface

An important consideration for instrument drivers is how they perform
1/0 to and from instruments. The I/O interfaces for LabVIEW
instrument drivers are the VISA and GPIB function libraries, and the
VXI and Serial VI libraries. These libraries contain sets of functions
and VIs that cover the capabilities of GPIB, VXIbus, and Serial bus
capabilities, including both message-based and register-based
programming, interrupt and event handling, and direct access to the
VXI backplane.

VISA, an acronym for Virtual Interface Software Architecture, is a
single interface library for controlling VXI, GPIB, RS-232, and other
types of instruments. Refer to Chapter 34, VISA Library Reference, for
further information.

Subroutine Interface

Because you write LabVIEW instrument drivers in standard LabVIEW
graphical code, an instrument driver has the same capabilities as any
other LabVIEW VI. While some VIs (such as instrument drivers)
perform only simple I/O to and from an instrument, other VIs might
control multiple instruments or use support libraries to integrate data
analysis or other measurement-specific operations. With LabVIEW,
you can build virtual instruments that combine hardware and software
capabilities. You can develop and package complete, high-level tests as
single VIs, which other test developers can reuse.

By ensuring compatibility with the virtual instrument concept, the
LabVIEW instrument driver standard has unlimited potential for
delivering baseline as well as sophisticated application-specific
instrument drivers. The LabVIEW instrument driver standard defined in
this document applies both to instrument drivers that control only a
single instrument, and to virtual instrument drivers that combine
features of multiple instruments and add software processing.

LabVIEW Instrument Driver Internal Design Model

The LabVIEW instrument driver internal design model, shown in the
following figure, defines the organization of the LabVIEW instrument
driver functional body. Because development guidelines and all
LabVIEW instrument drivers are based on this model, it is important to
both developers and end users of instrument drivers. When you
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understand the model and how to use one instrument driver, you can use
that knowledge across numerous instrument drivers.

Soft Front Panel Application Program

Functional Body

Initialize

Application Functions

Close

Action & -
Configure status Data Utility

Component Functions

Support Libraries VISA

Figure 31-2. LabVIEW Instrument Driver Internal Design Model

The functional body of a LabVIEW instrument driver consists of two
main categories of VIs. The first category is a collection of component
VIs, which are individual software modules that each control a specific
type of instrument function. The second category is a collection of
higher-level application VIs that illustrate how to combine the
component VIs to perform basic test and measurement operations with
the instrument.

The internal design model of LabVIEW instrument drivers is built on a
proven methodology. With this model, you have the necessary
granularity to control instruments properly in your software
applications. You can, for example, initialize all instruments once at the
beginning, configure multiple instruments, and then trigger several
instruments simultaneously. As another example, you can initialize and
configure an instrument once, and then trigger and read from the
instrument several times.

Instrument Driver Application Vis

The application Vs are at the highest level of the instrument driver
hierarchy. They are written in LabVIEW block diagram source code and
control the most commonly used instrument configurations and
measurements. These VIs serve as a code example for how to configure
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the instrument for a common operation, trigger the instrument, and take
measurements. Because the application VIs are standard VIs, with icons
and connector panes, you can call them from any high-level application
when you want a single, measurement-oriented interface to the driver.
For many developers, the application VIs are the only instrument driver
VIs needed for instrument control. The Tek VX4790 Example VI,
shown in the following figure, demonstrates an application VI front
panel.

)2 |

pplication Font |2 v| e i

YISA Refaum
L&A
In=t-

dup ¥ISA Refnum

Tektronix =

Instr

YH47790 Arb. Waveform Generator

Waveform (square: |] High Peak Amplitude Error Dut
Error In (no error) = [ I Hi5.o0 | Tiatis o
status gode
Frequenoy (Hz) Low Peak Amplitude
source lez.uDEﬂs Il HI—:.DD |

Figure 31-3. Tek VX4790 Example VI

The application VIs are built from a low-level set of instrument driver
component VIs.

Instrument Driver Component Vis

LabVIEW instrument drivers have component VIs, which are a modular
set of VIs that contain all of the instrument configuration and
measurement capabilities. The component VIs fit into six categories:
initialize, configuration, action/status, data, utility, and close.

All LabVIEW instrument drivers should have an initialize VI. It is the
first instrument driver VI called, and establishes communication with
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the instrument. Additionally, it can perform any necessary actions to
place the instrument either in its default power on state or in some other
specific state.

The configuration Vls are a collection of software routines that
configure the instrument to perform the desired operation. There may
be numerous configuration VIs, depending on the particular instrument.
After these VIs are called, the instrument is ready to take measurements
or stimulate a system.

The action/status category contains two types of VIs. Action Vis cause
the instrument to initiate or terminate test and measurement operations.
These operations can include arming the trigger system or generating a
stimulus. These VIs are different from the configuration VIs because
they do not change the instrument settings, but only order the
instrument to carry out an action based on its current configuration.
Status VIs obtain the current status of the instrument or the status of
pending operations. The specific routines in this category and the actual
operations they perform are left up to you.

Data VIs transfer data to or from the instrument. Examples include VIs
for reading a measured value or waveform from a measurement
instrument, VIs for downloading waveforms or digital patterns to a
source instrument, and so on. The specific routines in this category and
the actual operations performed by those routines are left up to you.

Utility VIs can perform a variety of operations that are auxiliary to the
most often used instrument driver VIs. These VIs include the majority
of the instrument driver template Vs such as reset, self-test, revision
query, error query, and error message and may include other custom
instrument driver VIs, such as calibration or storing and recalling
setups.

All LabVIEW instrument drivers should include a close VI. The close
VI terminates the software connection to the instrument and deallocates
system resources.

Each of these categories, with the exception of the initialize and close
VIs, consists of several modular VIs. Most of the critical work in
developing an instrument driver lies in the initial design and
organization of the instrument driver component VIs. The specific
routines in each category are further categorized as either template VIs
or developer-specified V1s.
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The template Vs are instrument driver VIs that you can use as templates
or examples. These VIs perform common operations such as initialize,
close, reset, self-test, and revision query. The template VIs contain
modification instructions for their use in a specific instrument driver for
a particular instrument. For more information, refer to Chapter 33,
Instrument Driver Template VIs.

The remainder of instrument driver VIs are known as
developer-specified Vs, and the actual operations performed by those
routines are left up you. Although all instruments will have
configuration VIs, some instruments can have a different number of
configuration VIs depending on the unique capabilities of the
instrument.

Figure 31-4 shows how the Tek VX4790 Example application VI
diagram uses the instrument driver component VIs:

VIS & session

High Peak drnplitude
“Waveform [1 : ging)

Frequency (Hz)  |[DBL

start connect

TES

dup Y154 session

=1

—mo

UECREL O T [ & ]
i a :

p&..,

Hun-St!

Errar In (no error)

| E=—=
CHWHELT
""" am o
Error Out
[DBL]

Low Peak &rmplitude
Config Standard Start Wave Connect Output
waveform

Figure 31-4. Vs in Tek VX4790 Example Diagram

The block diagram of the instrument driver component VIs uses
standard LabVIEW Vs, as well as VISA VIs to build command strings
and send them to the instrument. In the following figure, the Tek
VX4790 Config Std Wave component VI block diagram assembles the
command string and wires it into the VISA Write function. This function
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performs the necessary 1/0, checks for errors, and updates the
appropriate error indicators.

SETSIMO
SETSHUARE
SETSéwT00
SETTRIANG

set memory ptr to 0

o]
W aveform [1: Sine) i

error in [no eror] J[56 5 e n

Low Peak Amplitude [-5.0]
Frequency [25 MHz]

WISA session IIEI ] [ ]| dup 154 zession

rlabc—,

errar aut

Figure 31-5. Tek VX4790 Config Std Wave Diagram

Error Reporting

LabVIEW instrument drivers use error clusters to report all errors.
Inside the cluster, a Boolean error indicator, a numeric error code, and
an error source string indicator report if there is an error, the specific
error condition, and the source (name) of the VI in which the error
occurred. Additional comments may also be included. Each instrument
driver VI has an error in and an error out terminal defined on its
connector pane in the lower left and lower right terminals respectively.
By wiring the error out cluster of one VI to the error in cluster of another
VI, you can pass error information all the way through your instrument
driver and out to your full application.

Another benefit of error input/output is that data dependency is added
to VIs that are not otherwise data dependent.

Additional Vis Distributed with the Instrument Driver

In addition to the VIs described by the internal model, include a Getting
Started VI and a VI Tree VI with your instrument driver files.
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The Getting Started VI

The Getting Started VI allows the user to use the instrument without
wiring a subVI on the block diagram. This is generally the first VI the
end user runs to verify communication with the instrument. This VI
generally consists of three sub-VIs: the initialize VI, an Application VI
and the Close VI. The front panel of the Getting Started VI then
resembles the application VI’s front panel that it calls. Instead of having
the user provide the VISA resource name, the user should only provide
the GPIB address, VXI logical address or communications port. For
example, instead of requiring the resource name “GPIB0::24”, the
Getting Started VI would require the user supply a GPIB address of
“24.” The front panel and block diagram of the Getting Started VI for
the HP34401A are shown below.
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ED [.000E +0 Source [(Internall 5,7
0.000E +0 ; 4
lﬂ_g Internal .
error out
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@ Copyright 1995 Mational Ingtruments Corparation. ALL RIGHTS RESERVED.
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HP: T CLEEELIE
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The VI Tree VI

In order for customers to view the entire instrument driver hierarchy at
once, a VI Tree VI is required. This VI is a non-executable VI that is
designed to show the functional structure of the VI. If an end user does
not install the palette menu files for the instrument, the VI Tree is the
only resource to understanding the structure. An example of a VI tree
VI is shown below.
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LabVIEW Instrument Driver
Development

This chapter describes the procedure for developing a LabVIEW
instrument driver. The ideal LabVIEW instrument driver has full
function control of the instrument. Rather than mandate the required
functionality of all instrument types, such as DMMs, counter/timers,
and so on, this chapter focuses on the architectural guidelines of all
drivers. With this information, driver developers can implement
functionality unique to a particular instrument, and still organize,
package and use all drivers in the same way.

Development Procedure

The best way to develop a LabVIEW Instrument Driver is to follow a
three-step process. In step one, you design the instrument driver
structure. In step two, you modify the instrument driver templates VIs.
In step three, you add developer defined VIs.

Designing the Instrument Driver Structure

The ideal instrument driver does what the user needs—no more and no
less. No particular type of driver design is perfect for everyone, but by
carefully studying the instrument and grouping controls into modular
Vs, you can satisfy most users.

When the number of programmable controls in an instrument increases,
so does the need for modular instrument driver design since a single VI
cannot access all features. However, when an instrument driver
contains hundreds of VIs, each controlling a single instrument feature,
more instrument rules regarding command order and interaction apply.
Modular design simplifies the tasks of controlling the instrument and
modifying VIs to meet special requirements.

Ideally, you should devise the overall structure of your instrument
driver before you build the individual VIs. A useful instrument driver is
more than a series of VlIs; it is a tool to help users develop application
programs. You should design an instrument driver with the application
and end user in mind.
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You must create some instrument driver VIs that control unique
instrument features. However, you can use template VIs for common
operations. For more information about template VIs see Chapter 33,
Instrument Driver Template VIs.

Instrument Driver Structure and VI Hierarchy

When you develop a LabVIEW instrument driver, it is important to
clearly define the structure and VI hierarchy of the driver. First, define
the primary VIs and develop a modular VI hierarchy. This hierarchy is
the design document for a LabVIEW instrument driver.

Useful instrument drivers come from an in-depth knowledge of the
instrument operation and use in test applications. The following steps
outline one approach to developing the structure for the LabVIEW
instrument drivers:

1. Familiarize yourself with the instrument operation. Read the
operating manual thoroughly. Typically the foundation of the
driver hierarchy is in the instrument programming manual. Learn
how to use the instrument interactively before you attempt any
programming.

2. Use the instrument in an actual test set-up to get practical
experience. (The operating manual may explain how to set up a
simple test.)

3. Study the programming section of the manual. Skim the instruction
set to see which controls and functions are available and how the
features are organized. Decide which features are best suited for
programmatic use.

4. Examine instrument drivers for similar instruments. Often
instruments from the same family have the same programming
command set and you can easily modify their corresponding
instrument drivers.

5. Determine which LabVIEW template VIs are suitable for use with
your instrument.

6. Develop a structure for the driver by looking for controls that are
used together to perform a single task or function. The sections of
a well organized manual often correspond to the functional
groupings of an instrument driver.
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Instrument Driver VI Organization

After you have developed your Instrument Driver structure, you can
develop a VI hierarchy to organize the VIs that will be necessary to
create the driver.

The VI organization of an instrument driver defines the hierarchy and
overall relationship of the instrument driver component VIs.

You define the majority of instrument driver VIs and design them to
access the unique capabilities of a particular instrument. However,
many operations common to all types of instrumentation are performed
by the template instrument driver VIs: initialize, close, reset, self-test,
revision query, error query, and error message.

The template VIs for LabVIEW instrument drivers include prewritten
VIs to perform these common instrument operations. The command
strings are based on the VISA functions. To include these VIs in your
instrument driver, modify the command strings as required for your
instrument. If the instrument is IEEE 488.2 compliant, little or no
modifications are needed. If you are developing a driver for a non-IEEE
488.2 compliant or a register-based device, you will develop equivalent
VIs for your instrument.

A class is a group of VIs that perform similar operations. Common
classes of VIs are configuration, action/status, data, and utility.

The following table shows an example instrument driver organization
for an oscilloscope. At the highest level of the hierarchy, you see the
template Vs, initialize and close and the typical classes of VlIs.

Table 32-1.  Instrument Driver Organization Example

VI Hierarchy Type
Initialize VI (Template)
Application VIs
* Autosetup and Read Waveform (Developer Defined)
* Rise-Time/Fall-Time Measurement (Developer Defined)
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Table 32-1.  Instrument Driver Organization Example (Continued)

VI Hierarchy Type
Configuration VIs
* Configure Vertical (Developer Defined)
* Configure Horizontal (Developer Defined)
* Configure Trigger (Developer Defined
¢ Configure Acquisition Mode (Developer Defined)
* Autosetup (Developer Defined)
Action VIs
* Acquire Data (Developer Defined)
Data VIs
¢ Read Waveform (Developer Defined)
¢ Voltmeter Measurement (Developer Defined)
¢ Counter/Timer Measurement (Developer Defined)
Utilities VIs
e Reset (Template)
e Self-Test (Template)
* Revision Query (Template)
* Error Query (Template)
* Error Message (Template)
Close VI (Template)

Guidelines and Recommendations

Design an instrument driver VI front panel that contains all the
controls required to perform the VI task.

For example, a configure measurement VI would contain only the
necessary controls to configure the instrument to take the
measurement. It would not take the measurement or configure any
other features. Other VIs included in the instrument driver perform
these tasks.

Design a modular instrument driver that contains a set of VIs, each
performing a logical task or function such as configuring the
instrument or taking a measurement.

A modular instrument driver is flexible and easy to use. For
example, consider a digital multimeter driver design that uses a
single VI to both configure the instrument and read a measurement.
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The user cannot read multiple measurements without reconfiguring
the meter each time the VI executes. A better approach is to build
two VIs: one to configure the instrument, and one to read a
measurement. Then the user can configure the meter once and take
multiple measurements.

Concentrate on the correct level of granularity of driver VIs and
how these VIs will be used in a system.

An instrument driver with a few very high-level VIs may not give
the user enough control of the instrument operation. Conversely, an
instrument driver with many low-level VIs is difficult for users
unfamiliar with instrument rules regarding command order and
interaction. For example, when using a measurement device such as
an oscilloscope, the user typically configures the instrument once
and takes many measurements. In this case, you should write
high-level configuration VIs for the device. On the other hand,
when using a stimulus device such as a pulse generator, the user
may want to vary individual parameters of the pulse to test the
boundary conditions of his system, or perform frequency response
tests. In this case, you should write lower-level Vs, so that users
can access individual instrument capabilities instead of
reconfiguring each time they want to change one component of the
output.

Consider the relationship of the driver with other instrument drivers
in the system.

Typically, test designers want to initialize all of the instruments in
a system at once, then configure them, take measurements, and
finally close them at the end of the test. Good driver design includes
logical division of operations.

Create an instrument driver design (both in appearance and
functional structure) that is similar to other instruments of the
same type.

Instrument drivers across a family of similar instruments should be
consistent in appearance, structure, and style. For example, all
oscilloscope drivers should resemble each other, as should all
multimeters, scanners, and sources. If possible, modify a copy of an
existing driver of a similar instrument.

Design an instrument driver that optimizes the programming
capability of the instrument.

You can sometimes exclude documented functions that are not
well-suited for programmatic use.
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* Design each VI to be independent of other VlIs.

If two or more VIs must always be used together, consolidate them
into one VL.

*  Minimize redundant parameters.

For example, the parameters for each channel of a multi-channel
oscilloscope are similar or identical. Rather than duplicate the
programming controls for each channel, you can include a VI
control for selecting which channel to configure. The user can use
this VI to change the settings for an individual channel, rather than
configuring every channel each time the VI is called.

Design Example

Deciding which parameters to include in an instrument driver VI is one
of the greatest challenges facing the instrument driver developer.
Fortunately, organizational information is often available in the
instrument’s manuals. In particular, the programming section of the
manual may group the commands into sections such as configuring a
measurement, triggering, reading measurements, and so on. These
groupings can serve as a model for a driver hierarchy. Begin to develop
a structure for the driver by looking for controls that are used together
to perform a single task or function. A modular driver will contain
individual VIs for each of the control groups.
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The following table shows how the command summary from the
Tektronix VX4790 Arbitrary Waveform Generator Operating Manual
relates to developer specified instrument driver VIs.

Table 32-2. Command Summary from Tektronix VX4790

Instrument Manual Section Instrument Driver VI

Setup Commands TKVX4790 Setup
* External clock input enable
* External trigger source

* Sync pulse control

* Isolation relay control

Pre-Programmed Waveform TKVX4790 Config Std.
Commands Waveform
* Sine wave

* Square wave
* Triangle wave
* Sawtooth wave

Frequency Commands TKVX4790 Config Sample
* Frequency Frequency

* Period

* Divide

» Low-Pass filters

Voltage/Attenuator Commands TKVX4790 Config Volt/Atten.
* Voltage control

* Attenuator enable
* Attenuation level

Arbitrary Waveform Commands TKVX4790 Download Arb.
» Sample voltage Waveform
* Breakpoint/Last commands

Trigger Commands TKVX4790 Run/Stop
» Start location
* Breakpoint/last commands

While the instrument manual can provide a great deal of information
about how to structure the instrument driver, you should not rely on it
exclusively. Your knowledge of the instrument and how it is used
should be the ultimate guide. The preceding table shows manual
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sections that map nicely to VIs found in the instrument driver. There are
instances when it is more appropriate to place commands from several
different command groups in your VI.

Conversely, it is often necessary to take one group of commands and
divide it into two or more VIs. Consider how an instrument manual
groups the trigger configuration commands with the commands that
actually perform the trigger arming and execution. In this case, you
should separate the commands into two VIs; one to configure the
trigger, and one that arms or triggers the instrument.

The following figure shows the LabVIEW instrument driver VIs for the
Tektronix VX4790 Arbitrary Function Generator.

Initialize VI
Application VI
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|worrmeN
. 4190
Action VIs
CAMMELT
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Data VI
Utility VI PELRET | O ET | BT
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Close VI

Figure 32-1. LabVIEW Instrument Driver VIs for the Tektronix VX4790

Modifying the Instrument Driver Templates

LabVIEW Function and VI Reference Manual 32-8

After you design the LabVIEW instrument driver structure, the next
step is to modify the template VIs to represent your instrument. Most of
the modifications involve the instrument prefix. The prefix is a unique
identifier for the instrument driver, and is used as the filename for all
files associated with the driver and as the prefix to all instrument VI
names. Typically, the prefix is the combination of an abbreviation for
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the instrument vendor name and the model number. For example, the
instrument prefix for the Tektronix VX4790 instrument driver is
tkvx4790. As a default, the template instrument drivers use PREFIX as
the instrument prefix.

Use the following procedure for modifying the LabVIEW instrument
driver template:

1. Open the PREFIX Initialize template in the file CoreDrv.11b.

2. Save the VI into a new VI library file by using the prefix for your
instrument as the filename of the.11b file. Save the VI replacing
PREFIX in the VI name with the prefix for your instrument.

3. Follow the instructions in the Modification Instructions
string control on the initialize panel to modify the VI for your
particular instrument.

4. Edit all Show VI Info... and control and indicator descriptions.

Edit the icon. Create an icon for each of the color modes of the icon:
Black and White, 16-Color, and 256-Color.

6. Delete the Modification Instructions string control after you
have completed the modifications.

7. Resize the front panel and save the VI.

Repeat steps 1 through 7 for PREFIX Close VI and the remaining
template VIs that your instrument uses. All LabVIEW instrument
drivers should have initialize, close, reset, revision query, error
message, self test and error query and error message (multiple) VIs.
If the instrument does not support some of the utility functions, the
VI should return a “not supported” warning.

After completing this procedure, you have a base-level driver that
implements all template instrument driver VIs and is a good framework
from which you can create the rest of your driver.

In addition to CoreDrv.11b, there is one more instrument driver
template library, CoreDr_U. 11b. This library can contain support VIs
that the instrument driver uses internally, but which you do not intend
the end user to call. Two examples of support files, PREFIX Utility
Clean Up Initialize and PREFIX Utility Default Instrument Setup, are
included in the CoreDr_U.11b file. If you intend the instrument driver
to use these files, you should rename and modify them like those in
CoreDrv.1llb.
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Adding Instrument Driver Component VI Vis

The final step in developing a LabVIEW instrument driver is to add the
developer defined component VIs that define the functionality of the
instrument driver and access the unique capabilities of your instrument.
The VIs that you create will be added to the source code along with the
template VIs in the file prefix.11b.

You can use the following procedure to add your new VIs:

1.

10.

Open either the PREFIX Message-Based Or PREFIX
Register-Based templates VI in CoreDrv.1l1lb. Use the PREFIX
Message-Based template VI for message-based operations. Use
the PREFIX Register-Based template VI for register-based
operations.

Edit the VI front panel. Create the controls and indicators for

the VL.

Edit all control and indicator Help information. Edit the Show VI
Info... description.

Edit the icon. Create an icon for each of the color modes of the icon:
Black and White, 16-Color, and 256-Color.

Edit the connector pane. Select an appropriate connector pattern
and wire all controls and indicators to the terminals.

Edit the block diagram. Program all operations necessary to carry
out the functionality of the instrument driver VL.

Save the VI.
Test the instrument driver VI.

Repeat these steps for every instrument driver component VI and
application VI that you define for your instrument.

Edit the instrument driver . 11b by selecting File»Edit VI
Library... from the menu. Edit the Functions and Controls names.
Edit the arrangement of icons in the Functions and Controls
palettes.

Editing the block diagram source code is the most difficult step in
adding a component VI to the instrument driver. Defining a block
diagram structure makes it easier to edit the block diagram source code.
You can divide this process into the following steps:

1.
2.

Place the appropriate I/O routines in the block diagram.

Wire the error in cluster terminal to the first I/O VI error input
connector. Then wire the error out connector of that VI to the error

LabVIEW Function and VI Reference Manual 32-10 © MNational Instruments Corporation



Chapter 32 LabVIEW Instrument Driver Development

in connector of the next VI. Continue this process for all of the I/O
VIs. Then wire the error out connector of the last VI to the error
out terminal of the icon.

Wire the VISA session to every I/O VI.

Use the LabVIEW string VIs to assemble a command string based
on the VI inputs.

Wire the command string to the vISAWrite function.

Use the VISA Read function to read the response if an instrument
response is generated.

Use the string VIs to parse the response and wire it to the
appropriate indicator terminals.

Modifying the Menu Files to Create Function Sub-Palettes

After you complete all the required VIs, component VIs, Application
VIs and the Getting Started VI, organize them into subpalettes that the
end user can access. This involves editing the template menu files as
follows:

1.

© National Instruments Corporation

Copy the CoreDrv directory to another directory and rename the
new directory PREFIX. This directory should be a subdirectory of
Instr.lib.

Relaunch LabVIEW so that the new template subpalettes appear in
the function palette under instrument drivers.

Select Edit Controls and Function Palettes. . . from the File menu
in LabVIEW.

Edit the instrument driver’s palette icon and change the name to
PREFIX.

Access the instrument driver’s subpalette window to view the
hierarchy of the driver. For each subpalette, insert the VIs which
correspond to that category. You will need to replace the template
files with the completed version.

Save your changes. Your menu files will now contain the added
component VIs.
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The resulting menu palettes should resemble the following subpalette:

i3 HP34401A Vs

f’ CLERRTIL
AppIKatial D€
Example [[Close

Data B Utility 4

G

Tips for Developing a LabVIEW Instrument Driver

Loop Termination Conditions

When you use looping structures in instrument driver block diagrams,
you must include a way to escape from While Loops if an error occurs.
This escape method is important if you are using a While Loop
containing I/O routines and the loop termination depends on the result
of the I/O.

If there is an error, the I/O routines automatically shut down and
LabVIEW may be stuck in an endless loop. Therefore, always test the
error cluster status in conjunction with your normal loop termination
condition to determine when to terminate the loop. Figure 32-2 below
shows the incorrect mechanisms for terminating a While Loop.

[ ]|dup ¥I5A seszion

o ||error out

Figure 32-2. Incorrect Mechanism for Escaping from While Loop
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Figure 32-3 below shows the correct mechanisms for terminating a
While Loop

YISA session & |dup V154 seszion
ermar in [ho error | |L5e o |jpeeesd] wrjeensonns 3 error oLt

Figure 32-3. Correct Mechanism for Escaping from While Loop

Assembling Command Strings

After you develop your front panel, the next step is to create the block
diagram which performs the function required by the VI. Each type of
front panel control has a corresponding block diagram string VI that
simplifies the task of building command strings.

You can use Pick Line & Append to choose from a selection of strings
and concatenate it to another string in a single step. This procedure is
easier than using a Case structure and Concatenate Strings.

Use this block diagram... rather than this one...
00 AUTO 0D &UTO
MO0 NORM trigger mode Cnarrn P CTE |- -
Arigger mode (rorrm:F) 00 HORP jpned

You can use Format & Append to format and concatenate simple
numeric values. This procedure is easier than using one of the To
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Decimal or To Exponential type conversion VIs in conjunction with
Concatenate Strings.

trigger level (1]

Use this block diagram... rather than this one...

v
trigger level (1]

By using Select & Append you can select a string constant and
concatenate it to another string in a single step. This procedure is easier
than using Select and Concatenate Strings.

t-igger coupling CAC 0]

Use this block diagram... rather than this one...

TRIG:COUR AC;
TRIG:COUP DC;
TRIG :COUF HFR: ;

Data Dependency

LabVIEW Function and VI Refere

Carefully consider the control flow when you build your diagrams.
LabVIEW does not necessarily execute in a left-to-right, top-to-bottom
fashion. Data dependency automatically determines execution order.
Add artificial data dependency wherever appropriate (see the LabVIEW
User Manual for more information). By using the clusters to chain I/O
VIs together, you can define the execution order without using Case or
Sequence structures, as illustrated in Figure 31-3, in Chapter 31,
LabVIEW Instrument Driver Models. Sequence structures, which hide
parts of the diagram, are also effective at controlling execution order.
Whichever method you use, make sure that you clearly define control
flow so that the correct branch of the diagram executes first
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|E{>|{5§I @i |||| Application Font Y”:m TI fu: TI éE
High Yalue Type (lo<=xi=hi:3) Error Out
Hicoo | Elflocxen ]
= Source
| |S1'n'||:-1-e- Trigger "
Low Yalue Control HName
E | |trigger lewel "

o error in

Type (los=x<=hi:Z)

Sao
errar in H
2 Y | T LTy Ny o Y N £ error aut
[132]
Bb]

Saurce

Figure 32-4. Range Test VI (Front Panel and Block Diagram)

Programmatic range checking can easily double the size of your VI and
add some execution speed penalties. Figure 32-5 and Figure 32-6 show
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the changes made to the Simple Trigger VI to programmatically check
the ranges of the numeric inputs.

COUP AC;
COUP DG ;
COUF HFR;

error in|[ Be & [Jed
(=]

Trigger Mode (norm:F)

Y15 Refnum dup V154 Refnum

Figure 32-5. Simple Trigger VI with Programmatic Range Testing

COUP AC;
COUP DC;
COUF HFR;

Trigger Mode (normmF)
i dup VISA session

VIS A session I [ I 'uf.'hs.ﬂ [T
~rabie-,
] e
Errar In Error Out

Figure 32-6. Simple Trigger VI without Programmatic Range Testing
Guidelines

Like the LabVIEW VI, the standard components of an instrument driver
VI are the front panel, block diagram, and icon/connector pane. Special
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guidelines concerning these components, as well as error reporting and
on-line help information, are described in the following sections.

Front Panel

Each VI in your instrument driver should contain a front panel that
groups all the necessary controls together to perform the function of the
VI. When you develop an instrument driver VI, decide which control
styles best represent the instrument commands and options. Typically,
you can categorize instrument commands into three types of control
styles: Boolean, digital numeric, and text or ring numeric.

For example, you can represent any instrument command that has two
options (such as TRIG:MODE:AUTO | NORMAL) on the front panel
with a Boolean switch. In this case, label the switch Trigger Mode and
add a free label showing the options: auto or normal. For commands
that have a discrete number of options (such as TRIG:COUP:AC | DC |
HFRE]J), use a text ring or an enumerated type ring rather than a digital
numeric because the ring control labels each numeric value with the
command it represents. Any command requiring a numeric parameter
whose value varies over a wide range and might be represented with a
digital numeric.

Note: You might prefer to use the enumerated type ring controls because
selections for case structures are self-documenting when wired directly to
a enumerated-type control or constant. Also, by using the “Create
Constant” popup feature in LabVIEW, end users generate an enumerated
type ring constant rather than a numeric constant.

You can use Boolean, numeric, and text ring controls to represent most
instrument commands on the front panels of your VIs. In addition, block
diagram string functions specifically designed for use with these
controls exist. These features can simplify string formatting and append
instrument commands into command messages, as discussed in the
Assembling Command Strings and Block Diagram sections of this
chapter.
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Required Front Panel Controls

In addition to the controls required to operate the instrument, your front
panel must also have the following controls.

YISA session dup ¥YISA session
L5 L#5A
Instr Instr

VISA session (except for the initialize VI) input is a unique identifier
reference to a device I/0 session. It identifies the device with which the
VI communicates and all configuration information necessary to
perform the 1/0.

H

dup VISA session output is a unique identifier reference to a device
I/0 session. It identifies the device with which the VI communicates
and all configuration information necessary to perform the I/O.

error in describes error conditions that occur before this VI executes.
The default input of this cluster is no error.

error out is a cluster containing error information. If error in indicates
an error, the status, code, and source elements of error out have the
same values as the corresponding elements of error in. If error in does
not indicate an error, error out describes the error encountered by the
VI. Refer to the LabVIEW Error Codes manual for a description of the
possible error codes.

To gain consistency with other LabVIEW instrument drivers, place the
VISA session control and dup VISA session indicator in the upper left
and upper right corners of the front panel, and the error out cluster in
the lower right corner. Place the error in cluster outside the panel’s
visible window because it has no interactive use and is only needed for
programmatic use.

Control Guidelines

When placing controls on your front panels, use the following style
guidelines to ensure uniformity with other LabVIEW Instrument Driver
VI front panels:

LabVIEW Function and VI Reference Manual 32-18 © National Instruments Corporation



Chapter 32 LabVIEW Instrument Driver Development

Use the default font (Application) for all LabVIEW instrument
driver front panel control labels.The application font is available on
all LabVIEW platforms.

Use bold text for control name labels that denote important or
primary controls, and reserve plain text for secondary controls.

Note: In most cases, all instrument driver controls are primary and require bold
text. If you are finding yourself placing many secondary or auxiliary
controls on panels, this may indicate the need to subdivide your VI into two
or more VIs.

© National Instruments Corporation

Capitalize initial letters in all words, except abbreviations or
acronyms, which require caps (such as ID or GPIB) and error in,
error out and dup VISA session labels.

Place labels above the associated control or indicator and color the
label background transparent.

Enclose control default information in parentheses in the control
name.

By including default information in the control name, users access
that information through the help window. This feature is helpful
when you are using the VI in higher-level applications.

For example, Function (0:DCV) would be an appropriate label for
a function selector ring control whose default is DC voltage and
item zero in the ring. The abel for a Boolean mode switch that
defaults to true indicating automatic would be Mode (T:Auto).
(Notice that the default information is in plain text).

Align and distribute the controls and indicators for a well balanced
panel.
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The following figures shows the simple trigger VI after modification to
meet the style guidelines.

¥I5A session dup ¥ISA session
Wsa WS4
Irstr Instr

Trigger Coupling [0:AC]

-
error out
Trgger Level [1.00] W
oo
e no emar I D
Trigger Mode [T:Auta) SOUICE

Auta
Marmal

Figure 32-7. Simple Trigger VI Front Panel (See Figure 32-8for Diagram)

COUP AL
COUP DC;
COUP HFR:

TRIG

Trigaer Coupling [(LALC)

Trigger Lewel [1.00]

00 AUTO;
MO0 WORM;

LTE]

Trigger Mode [T:Auta
2 [ ) VIS4 session wt'.m dup Y154 session
abig-,

&rrar in (o errar] IIE: wiEs &rrar out

Figure 32-8. Simple Trigger Block Diagram

Block Diagram

Proper wiring style improves the diagram appearance and eases
understanding. The following are recommendations for developing
your instrument driver block diagrams:

* Add text labels to each frame of Case and Sequence structures.

e Label control and indicator nodes with normal text.
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e Use bold text to make your free label comments stand out.

e Leaveroom for labels and wires. Do not crowd the diagram. Do not
cover wires with loops, cases, labels, or other diagram objects.

¢ Reduce the number of bends in the wires by aligning data terminals
whenever possible. You can use the cursor keys to move objects
one pixel width at a time. Use the Align and Distribute options in
the Edit menu to add symmetry and straight lines to your diagram.

e Label long wires and complex operations to increase
understandability.

lcon

When you use an instrument driver VI programmatically, the icon
graphically represents the function (much like the function name of a C
library call). Use meaningful icons for every VI. Include text in the icon
that identifies the instrument model controlled by the VI. If you are
unable to create an icon to express the function of the VI, you can use
text only.

You can borrow icons from similar VIs in other instrument drivers.
These sample icons are available in the file insticon.11b.

Connector Pane

When you use an instrument driver programmatically, the connector
pane defines how to pass parameters to and from the VI. Use the
following rules when creating your instrument driver connector panes:

e  Place the VISA session input and dup VISA session output in the
upper left and upper right terminals of the LabVIEW instrument
driver connector pane.

e Place the error in and error out clusters in the lower left and lower
right terminals of the LabVIEW instrument driver connector pane
respectively.

e Place inputs on the left and outputs on the right of the connector
pane whenever possible. This promotes a left-to-right data flow
when the VI is used in a block diagram.

Note: It is acceptable to choose a connector pane pattern that has extra terminals
in case you make unforeseen control or indicator additions to your
instrument driver Vs in the future. This procedure prevents you from
having to change the pattern and replace all instances of calls to a modified
VI
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Error Reporting

Refer to the document, LabVIEW Error Codes, for a list of error codes
reserved for LabVIEW instrument drivers.

Online Help Information

LabVIEW has two types of help mechanisms available to users: VI
Descriptions and Control Descriptions. You should implement both VI
Descriptions and Control Descriptions for all LabVIEW instrument
driver VIs and controls that you develop.

VI Descriptions

Users can access VI Description help from the description box of the
information window by selecting Windows»Show VI Info..., as shown
in the following figure.

Marme: Tek V4790 Config Std Wawve.wi [~ Locked
Path:  C:ATek W=4730 Config Std wWave vi

Current Revizion: 4

Dezcrphion;

Thiz ¥l determines the charactenistics of the waveform to be -
output, [f the waveform iz zine, square, zawtoath ar tiangular, the
high and low peak. amplitudes muzt be specified along with the

output frequency. The sample frequency zet in the Configure

will be automatically reproarammed in this caze.

~bdemorny zage:

Resources:  34.3K Frant Panel: 6.5k
Block Diagram: 7.8k
Code: 8.6k
Crata: 1.3k
Total: ~24.2K

k. Cancel

This dialog box should contain the following information:
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e A general description of the instrument driver VI
e Control usage rules
e Vlinteraction with other instrument driver VIs

e Important information concerning the use of the VI

Control and Indicator Descriptions

Control and indicator help is the information most frequently viewed by
the user. You can obtain control or indicator help by selecting Data
Operations»Description... from the control or indicator pop-up menu,
as shown in the following figure.

Trigger Mode [T:Auto] Description

“when autozero iz enabled [default], the multimeter intzrmally .
disconnects the input signal following each measurement, and takes — |
a zero reading. 1t then subtracts the zero reading from the preceding
reading.  Thiz prevents offzet voltages present on the multimeter's

input circuitty from affecting measurement accuracy.

“When autozero iz disabled, the multimeter takes one zero reading
and subtracts it from all subsequent meazurements. |t takes anew |
zero reading each time vou change the function, range, ar integration

time. ;I

(] Cancel

The control and indicator help information should contain the
following:

¢ Name of the parameter

e Brief description of the parameter
e Valid range

e Default value

¢ Interaction with other controls

Be sure to include information showing index numbers and
corresponding settings for all ring and slide controls, and settings
corresponding to True/False positions on Boolean controls.

© National Instruments Corporation 32-23 LabVIEW Function and VI Reference Manual



Chapter 32 LabVIEW Instrument Driver Development

Application Vis

The application VIs demonstrate a common use of the instrument and
show how the component VIs are used programmatically to perform a
task. For example, an oscilloscope application VI would configure the
vertical and horizontal amplifiers, trigger the instrument, acquire a
waveform, and report errors. Consider the following points when
developing application VIs for your instrument driver:

* Concentrate on building simple, quality examples that can serve as
general models for users. It is not necessary to make your
application VIs perform every function found in your instrument
driver.

e Build the instrument driver top-level examples from the instrument
driver component VIs, and perform common test- and
measurement-oriented operations for this particular instrument.

* Do not use the instrument driver application VIs to call the
initialize or close instrument driver VIs, because doing so will
make the application VIs less useful to higher level applications.

LabVIEW Instrument Driver Standards Checklist

All LabVIEW instrument drivers should conform to recommendations
for programming style, error handling, front panels, block diagrams,
and online help described in this section. Use the following checklist to
verify that your instrument driver complies with library standards:

I. Files and Documents you submit:

A. Prefix.zip containing the instrument driver files.

1) Prefix.11lb, your main instrument driver library. (e.g.,
hpl16500b.11b, £145.11b)

2) Palette menu files. (dir.mnu, acstat.mnu,
data.mnu, applic.mnu, util.mnu. config.mnu)

3) (optional/recommended) Prefix_u.1llb. (e.g.,
hpl1650_u.1llb, f145_u.llb).

4) (optional) Prefix.txt.
B. Manufacturer’s instrument manual or manual set.

C. A completed checklist.
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II. General Issues:
A. The instrument driver must use VISA for all instrument I/O:

B. All VIs are designed for programmatic use, so there are no
pop-up VIs or dialog boxes, and no interactive inputs. All controls and
indicators are wired to the connector pane.

C. All VIs are multi-instance, so there are no uninitialized shift
registers, and no global storage VIs unless specifically designed to work
with multiple instruments simultaneously.

D. All VIs are fully documented including Show VI Info and
control descriptions.

E. Driver follows the instrument internal and external driver
model: The driver must include the following VIs: Initialize, Close,
Getting Started, Application and VI Tree. In addition, all other VIs must
be grouped into the following categories: Configure, Action/Status,
Data, Utility, or support.

F. All VIs use the error I/O clusters, error in and error out.

G. The instrument driver contains the following required Utility
functions: Revision Query, Self Test, Reset, Error Query (single and/or
multiple), and Error Message.

H. The required utility VIs return a VISA NSUP warning code if
the instrument does not support the requested operation.

I. The instrument driver uses VISA session, dup VISA session,
error in, and error out to channel data flow, and force data
dependency. Do not use sequences or case structures for this purpose
because they slow execution speed and make it harder to debug the
driver.

IIl. Prefix.1llb:

A.Prefix.1llb contains all the instrument driver VIs that you
want the end user to access directly.

B. All VIs are saved with meaningful names including
instrument prefix and description, and include only alpha-numeric
characters (no special characters). Use Initial Capital Letter form (e.g.,
Fluke 45 Read Measurement). VIs that are of the same type should be
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named so that they start with a common name. For example, all
configuration VIs should start with “Prefix Config.”

C. The VI Tree is contained in prefix.11b and is named
Prefix VI Tree.vi. The front panel of the VI contains a message
instructing the users to “See the diagram for the VI Tree”. The diagram
contains all of the driver's VIs that are designed for the user to access.
These VIs are arranged by functional grouping, such as Getting Started,
Application, Initialize, Configuration, Action/Status, Data, Utility,
and Close.

D. All instrument drivers have at least one Application VI. These
VIs are programmatic examples that demonstrate how to use the
instrument driver component VIs to perform a common task or tasks.

E. All instrument drivers must have a Getting Started VI. This VI
calls the Initialize VI, one or more application VIs, followed by the
Close VI

F. Getting Started, Application and VI Tree VIs are given
top-level status in the VI library.

IV. Prefix U.11b (Recommended/Optional):

A.Prefix_U.11b contains all the support VIs the end user
should not access directly, but are used by the instrument driver.

V. Palette Menu Files:

A. The function menu palettes are well organized and follow the
format of the instrument driver template.

B. Palette Menu files include dir.mnu,
applic.mnu, config.mnu, acstat.mnu, data.mnu, and
util.mnu.

VI. VI Front Panels

A. Contains VISA session, dup VISA session, error in and
error out controls/indicators.

B. Front panel Show VI Info description is complete,
informative, and contains any additional information that helps the end
user successfully operate the instrument driver.
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C. Show VI Info for the Revision Query VI includes the
following:

1) The Instrument Driver Revision Number

2) The Firmware Revision of the Instrument used when
creating the instrument

3) The date the driver will be released on the next Instrument
Driver CD (month/year)

4) The instrument manufacturer's name
5) The instrument model number

6) The instrument type (Digital Multi-Meter, Oscilloscope,
Function Generator, etc.)

7) The instrument driver developer’s name

D. (optional/recommended). The same information that is
included in the revision query VI is included in the Show VI Info
documentation of the VI Tree VI.

E. VI History is updated with comments as needed.

F. Controls and Indicators

1) All control and indicator descriptions are complete. This
includes valid ranges, default values and items within a ring
control.

2) Labels are placed at the upper left of controls and the
background color of labels is transparent. Size to Text feature used.

3) Default Application Font is used and the initial letters of
control names are capitalized. Use bold for primary controls and
plain text for secondary controls. Use plain text to indicate default
values.

4) Proper defaults are set for each control. Default values are
included in the control name.

5) Prope